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HawkEye for Windows Support Information
™

Please refer to the following for customer support regarding this product:

Performance Drilling Technology, Inc.
Address:
12202 Advance Drive
Houston, TX 77065
Phone:
(281) 890-7494 (Office: orders and technical support)
(281) 682-7554 (Direct)
Fax:
(281) 890-7585
Email:
support@hawkeye3d.com
Website:
www.hawkeye3d.com
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I. GETTING STARTED
1. Purpose of HawkEye™
The idea for HawkEye™ started in 2006 as the 3rd-generation of the successful directional
drilling application WinSURV3D™. It is intended to provide directional drilling
information to people involved in the workflow of directional drilling within a rich and
powerful 3D environment. That workgroup includes directional drilling companies,
directional drillers, engineers, geologists and operators.
A DIRECTIONAL DRILLING TOOL
When a workgroup is out drilling a well, HawkEye™ provides a set of powerful tools to
meet a variety of goals related to a project. Proper use of the 3D space will allow them
to clearly present how they are doing and how far away they are from other wells in a
clear and intuitive way. HawkEye’s 3D environment expands a person’s spatial
visualization of a project.
A TOOL FOR EVERYONE: A directional drilling company will often be charged will
TM
planning the geometry of the well and HawkEye provides powerful tools to allow
them to do that very easily.
Drilling engineers use HawkEyeTM to keep up with what is going on, to keep track
passively and rest assured of the drilling operation without having to spend a lot of
time tracking numbers and visualize things off of list.
Geologists can incorporate their seismic and geologic graphic representation as overlays
and visually see where the well is in reference to where their targets are.
Generally there is a gap between what geologists understand about certain drilling
engineering restraints and what a driller understands about certain offset data. The
friction between the two groups is alleviated with HawkEye™ by creating a common
visual workspace in which all data is compiled and easily seen. When a geologist’s data
is compiled alongside the driller’s information, the two groups can forge an optimal
and efficient drilling operation.
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A WELL PLANNING TOOL
HawkEyeTM is a first class well planning tool, allowing for the well planning
development of a single well or an entire platform or pad. Virtually all types of wells
can be planned with HawkEye™, ranging from simple slant wells to complex 3D wells.
The well planning version of HawkEye™ supports the direct generation of wall plots,
invoking InkScape™ as the primary graphics editor for the file that HawkEye™ generates.
InkScape™ is a widely supported vector graphics editor which specializes in support of
the SVG (Scaled Vector Graphics) file standard.
HawkEye™ well planning is template driven. Customized planning templates can be
easily created, as can customized plot templates. Once created, these templates can be
used to greatly increase productivity.
Included with the Well Planning version of HawkEyeTM is a Torque and Drag module.
This module allows one to predict the torque and drag characteristics of a given well
profile as a function of the variables affect torque and drag. It is easy to use.
THE TWO VERSIONS OF HAWKEYE™
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2. Recommended System Specs
The most important first step in utilizing HawkEyeTM is the having the proper
equipment. Even the most robust system with maxed out hardware comes to less than
half the cost of one copy of HawkEyeTM. So it makes a lot of sense to get the right
equipment.
a. 3D Navigation with Mouse
Certain core aspects of the HawkEyeTM interface were designed for optimum 3D
navigation with a certain kind of mouse. Although these devices were once “specialty”
mice, they can now be acquired at a very reasonable price.
Since the predominant workspace in HawkEyeTM is the 3D
space, the users find themselves doing a lot of moving along
a curve in addition to the zooming in the plotting modules. It
turns out that the art of zooming has been perfected in the
computer interface world. High-speed scrolling is best
done
with
Logitech’s
Hyper-Fast
Scrolling
or
TM
HyperScroll . This is basically a scroll wheel that is
weighted and perfectly balanced so that when you flick it,
it will spin continuously for some time. But since its weight
is calibrated just right, you can stop the spinning very
suddenly with just a touch.
The program in the 3D space requires a frequent number of
mouse wheel clicks up and down, and since the standard
mouse wheel will actually click at each interval, it becomes
an arduous task to navigate up and down a curve if the wheel does not move
continuously.
At least with all of the Logitech™ Hyperscroll™ models, the wheel itself can be switched
between smooth motion and click motion, so the user is not forced to always use
continuous motion scrolling. This may prove useful when trying to conduct a fine-tune
zoom or for small iteration movement.
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HARDWARE SPEC at a GLANCE
Minimum requirements:








Windows 7 or later
TM
NOTE: HawkEye runs on both 64-bit and 64-bit Windows, but
WinServe™ only on 32-bit Windows. So if you want to use
WinSERVE™ on the same machine as HawkEye™ then stick to the
32-bit versions of Windows.
4 GB RAM
1366 horizontal resolution
1.8 GHz processor
80 GB hard drive
Logitech™ mouse with Hyperscroll™ wheel

Recommended specs:




Windows 8 or Windows 10 any edition
8+ GB RAM
Any quad-core processor

 1920x1080 resolution


120+ GB hard drive

 Logitech™ mouse with Hyperscroll™ wheel


Dedicated video card

TM

Logitech’s HyperScroll mouse wheel is
recommended for navigating the 3D space in
HawkEye . These models are referred to as
Anywhere , MX or VX models.
TM

TM

TM

TM
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b. Keyboard Hotkeys
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c. Screen Resolution
HawkEyeTM requires a certain amount of space on the screen. Dimensions are simply the
pixel count across and down a screen. The pixel dimensions of computer monitors and
laptops vary widely, from the sparse pixel count of a cheap netbook screen at 1280x768,
to the massive 3840x2160 “4k” display. Although great advances have been made in
available quality and pixel counts for computer displays, companies still sell plenty
of low-res screens because it is a way to keep their costs down.
NOTE: Although 1366x768 is billed as “HD,” it is only barely adequate for
HawkEyeTM.

At a minimum to run HawkEyeTM without interface crowding issues, the monitor should
be at least 1366 pixels across (1366x768).
However, the recommended horizontal count is 1920 (the resolution is

1920x1080).
A 1920x1080 screen will greatly enhance all aspects of your work productivity and
overall happiness.
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Refer to this chart to figure out where you stand on screen res.

Set to Maximum Resolution
Regardless of the physical dimensions of your monitor, it is nice to have at least a
TM

1600 pixel horizontal to run HawkEye .
Checking resolution in Windows XP:
1.
2.
3.
4.

Right –click on the desktop.
Select “Change Settings”
Click on “Display Settings”
Move the slider to the maximum resolution.

Checking your resolution in Windows 7/8:
1. Right-click on the desktop.
2. Select “Screen resolution.”
3. Use the Resolution drop-down menu to get to highest res.
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Set the Display to “Smaller” or 100%
It is vitally important in Windows 7/8 to set the screen magnification to “Smaller.”
To get to that setting, search for “Display” in the Start Menu search bar. (In
Windows 8, search for “Display” under “Settings.”) Open up the panel and select
“100%.” If it is not already at 100%, you will need to log out and back into
Windows.

In late 2014 Microsoft changed the Windows display magnification interface to
look like the following. Set the magnification to “Smallest” in order to get
HawkEye to work properly.
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d.
Windows Version

Operating System
Runs WinServe™

Runs WinSURV2™

Runs HawkEye™

XP
Vista 32-bit
Vista 64-bit
7 32-bit
7 64-bit
8 32-bit
8 64-bit
10 32-bit
10 64-bit
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e. System and Video Memory
PROCESSOR: Recommended is a quad core processor, but dual core processors are
sufficient.
VIDEO CARD: Most important is the dedicated graphics (video) memory. Users don’t
want to just rely on an integrated graphics board (integrated in the motherboard). This
will only be sufficient in higher-end PCs, where the onboard video memory is
substantial. The major manufacturers of quality video cards are ATI and Nvidia.
RAM: 8GB of system RAM is highly recommended.
At a Minimum: HawkEye™ will run on a 1.8GHz dual core machine with 4GB RAM,
which essentially a mediocre modern notebook. It is preferable to have a screen with at
least 1600 horizontal resolution.
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3. Installing and Updating HawkEye™
Installation of HawkEye™ is a mostly automated process. There are two ways to install,
either by DVD on the local machine or through an internet connection.
Using default installation folder (c:/Hawkeye) is immensely helpful when
troubleshooting and keeping track of files upon reinstallation and using HawkEye™ on
multiple machines.
INSTALLATION BY DVD
1.
2.
3.
4.

Make sure the HASP key is plugged into a USB port.
Place the DVD into the DVD drive.
Follow all the directions. Install all components as prompted.
Several small applications will install. Click through and accept the default settings
where applicable:
i. Ssrc SVG - This provides support for the Graphics Designer. (This component
is not necessary in Windows 8).
ii. Inkscape – This is a free Vector graphics program used to edit the Presentation
Plots.
iii. CUTEPDF Writer – This is a free PDF printer. It is installed so that the user has
access to all pages sizes when designing plots.

INSTALLATION VIA INTERNET
1. Make Sure the HASP key is plugged into a USB port.
2. Connect computer to the Internet.
a. NOTE: Don’t disconnect throughout this installation process. If the
connection is severed at any point, you should uninstall the HawkEye™
program completely and start over.
3. With any browser, navigate to hawkeye3d.com and click on “Support.” Then click
on the Download/Update button.
4. Several small applications will install. Click through and accept the default settings
where applicable:
a. Ssrc SVG - This provides support for the Graphics Designer. (This
component is not necessary in Windows 8).
b. Inkscape – This is a free Vector graphics program used to edit the
Presentation Plots.
c. CUTEPDF Writer – This is a free PDF printer. It is installed so that the user
has access to all pages sizes when designing plots.
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COMPLETING THE INSTALLATION (DVD and INTERNET1 INSTALL)
5. Once HawkEye™ is done loading the initial battery of program files, double-click on
the desktop shortcut or go Start>HawkEye™. You can also right-click on the
HawkEye™ shortcut wherever you find it and select “Pin to Start Menu” to place a
shortcut in your Start menu.
6. The program will start up and create a new .hawkeye.mdb file (yes, it’s a double
extension) if you are not opening up an existing one. It is placed in the HawkEye
folder (default: c:\HawkEye).
7. Close the program. Only at this juncture will HawkEye™ complete its installation
process by downloading the remainder of the support files, including
GEOGRAPHICAL DATA essential. THIS TAKES A WHILE WITH THE
INTERNET CONNECTION.
8. Upon completion of the final volley of downloads, HawkEye™ will be ready for use.

1

If transfer errors occur at any point in the installation process, the HawkEye ™ program will
need to be completely uninstalled and the process started from the beginning. This is far less
likely to happen with a local DVD installation.
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4. See Latest Version Changes, Video Tutorials and User’s
Manual

Navigate to the Help tab at the top to do the following:


Manually checks for updates. The program automatically checks for updates
when launched from the .exe or .exe shortcut. It does NOT automatically check
for updates when the program is launched from a .hawkeye.mdb database.



Download U.S. Shape Files and Flags Folder: these are large files and do not
automatically install when installing from the server.



Show Hotkey Map: all the keyboard shortcuts in PDF format.



Quickstart Guide: A short summary of all key functions in the program.



User’s Manual: Download the latest User’s Manual from the HawkEye site.



Tutorial Videos: View tutorial videos posted on YouTube. Internet required



About HawkEye™: Copyright information.
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5. Main Screen Organization
a. Default Windows
HawkEye’s main screen is organized by default into the “Split View,” which is
composed of four distinct information areas. On the left is the Data Tree/Project Control
Panel, which can be swapped with the tabs at the top of the window. In the center left is
the 3D space by default. In the center right is the second main window. These two
center panes have tabs at the top to switch between modes. The fourth window, which
displays surveys, is always situated at the bottom.

HawkEye has four primary data windows:
1.
2.
3.
4.

Data Tree/Project Control Panel
Center Left (VS or 3D View)
Center Right (Proximity, Ladder Plot, Alerts, Top or VS)
Surveys

SWAP TO FULL SCREEN: Double-click on a 3D or 2D view to maximize to full screen.
Double-click again to return to previous view.
COLLAPSE WINDOWS: The small boxes along the inside edge of the 3D window each
collapse an entire panel or expand it. Some of them also serve to collapse and expand
one of the four toolbars in the main screen. This allows for maximum use of space on
low-resolution screens.
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RESIZING WINDOWS: The proportion of the screen that each window takes can be
resized manually, except for the left-hand Data Tree/Project Control Panel window.
Resize by “grabbing” a border, left-clicking and dragging the border to resize.
Just move them around and you will quickly get the feel for them.

The windows borders can be grabbed and dragged around to resize the
windows. They are exaggerated above in yellow.
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b. Main Screen View Modes

In the top left section of the screen you can find the various viewing options which
control the presentation mode for most of the screen. These screens will maximize either
of the 2D views, the 3D view, or the default split view.
The View Mode buttons on the top left of the main screen will change the view mode to
emphasize different data displays: Split, 3D, VS and Top.
1. Split View
The default Split View allows users to have two different views up at the same time,
side by side, as well as the Data Tree/Project Control Panel and the Surveys below.
Within the two main windows in the Split View, the user can choose between VS or 3D
on the left, and Proximity, Ladder Plot, Alerts, Top or VS View on the right.
In the screen below, the 3D view is selected for the lefthand split panel and the
Proximity is selected for the right. This combination is useful in a driller’s environment
where proximity to other wells needs to be visualized and quantified.
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2. 2D View: Vertical Section (VS) View
This is the view that one would have of a well
from the side. The view plane is by default 90
degrees from the proposed bottom hole
location. The direction which is used to set the
Vertical Section Plane (VSP) is the closure
direction between the surface location and the
end of the well.
Exaggeration decreases the Y-axis interval,
which is useful for horizontal wells when
trying to better fit the entire well in the graph.
The exaggeration is by ratio, so if “1” is
100ft/division, then “2” would be 50ft/division,
and “3” would be 33 ft/division.
The icon on the top left
Graphics Properties panel.

will open the

This VS grid can be displayed in either
panel in the Split View, or in full
screen. It shows a “side” view of a
project’s curves.

The Presentation Plot icon next to it
will
open the Presentation Plot module of
HawkEyeTM, with the current Vertical Section view at front and center.

PAN: Holding down the RIGHT mouse button on the 2D window and dragging the
cursor around will move the orientation of the grid, allowing the user to navigate along
a curve or otherwise change a view perspective along the graph’s plane.
ZOOM: Holding down the left mouse button to draw a box onto the graph will zoom
the graph into that area. Hold down the right mouse button and scroll the mouse wheel
up and down to zoom.
MAXIMIZE VIEW: Double-click on this chart to maximize it to full screen. Then
double-click again to return to previous view.
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3. 2D View: Top View
Also referred to as a horizontal view, the Top View is as if looking at the well from
above, with north oriented to the top.
The icon on the top left

will open the Graphics Properties panel.

The Presentation Plot icon next to it
will open the Presentation Plot module of
TM
HawkEye , with the current top view at front and center.

PAN: Holding down the RIGHT mouse
button on the 2D window and dragging
the cursor around will move the
orientation of the grid, allowing the user
to navigate along a curve or otherwise
change a view perspective along the
graph’s plane.
ZOOM: Holding down the left mouse
button to draw a box onto the graph will
zoom the graph into that area. Hold
down the right mouse button and scroll
the mouse wheel up and down to zoom.
MAXIMIZE VIEW: Double-click on this
chart to maximize it to full screen. Then
double-click again to return to previous
view.

The “Top View” tab available on the right
panel in Split View will present a “horizontal
view” or bird’s-eye view of the well, with
north oriented to the top.
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4. Proximity
Please see the major subheading on Proximity for the full breakdown, approximately
five pages down.
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5. Ladder Plot
The Ladder Plot is another way of
visualizing the distances between curves.
This type of plot is also referred to as an
‘MD vs Distance’ plot.
The distance of each curve is plotted in the
vertical scale as a function of the MD
(measured depth).
If the two lines overlap one another that
should be interpreted as a potential
collision problem.
The advantage of this type of plot is that
one can instantly spot problem areas by noting the points at which the curves dip down
near the baseline.
REFERENCED CURVE: Select the curve to be the baseline reference with this dropdown menu. The dropdown menu contains all curves in a project.
MAX DISTANCE: This is the observed radius from the reference curve, the distance at
which HawkEyeTM will stop plotting a curve.
COMPARED CURVES: This drop-down will allow the user to check off each or all the
curves to be compared.
REFRESH: Hit this button to recalculate any changes made to the Ladder Plot
parameters.
DOUBLE-CLICK TO FULL SCREEN: Double-click on this chart to maximize it and get
the color legend that identifies each curve by color.
DOTTED LINES: The dotted lines in a chart represent the outer boundary of
uncertainty for a given curve.
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6. Alerts
The Alerts tab in the bottom right of the main screen provides a criticality number
between 1 and 5, with 5 being the most dangerous, according to certain rulesets that are
defined by different companies, in reference to proximity. Center-to-center distance
between wells, and ellipses of uncertainty (calculated by ISCWSA error model) are used
to calculate proximities.
SAFETY RULESETS are chosen
at the start of making a project
and can be edited at any time by
RIGHT-CLICKING on a project
in the Data Tree on the left, then
selecting “Edit Project” and
choosing from the drop-down
menu labeled “Safety Ruleset.”
Directional Drillers and drilling
engineers should play close
attention to Alerts when drilling
in a crowded area.
Choose a reference curve under the Alerts tab and
get a list of surveys which contain criticalities
signifying dangerous proximity to other wells. The
criticality figure ranges from 1-5, with the high end
representing the most dangerous proximity.
CRITICALITY LEVELS:
Criticality
Comment
1
Nothing to worry about, proceed drilling.
2
Monitor separation factor as drilling proceeds.
3
Caution, continuously monitor Distance both onshore and offshore.
Review the action plan for the possibility that the separation factor falls
below 1.5.
4
Drilling operations should take swift, positive action to change drilling
direction, increase survey accuracy or other actions to increase the
separation factor.
5
Stop drilling. You are in a very high risk situation.
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The safety ruleset is simply a translation of the separation factor into a number of 1
through 5 in order to simply SF and make it easier to analyze at a glance. There are
several different translation tables depending on which company is using the software,
but the default safety ruleset covers many project scenarios.
Default Safety Ruleset:
Separation Factor

Criticality

>4

1

<4 to >2.5

2

<2.5 to >1.5

3

<1.5 to >1

4

<1

5

Separation Factor

Criticality

>2.5

1

>1.5 to <2.5

2

<1.5 to >1.25

3

<1.25 to >1

4

<1

5

Separation Factor

Criticality

>4

1

<4 to >2.5

2

<2.5 or >1.5

3

SDI Safety Ruleset:

ConocoPhillips Safety Ruleset:
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<1.5 and >1

4

<1

5

Separation Factor

Criticality

>1.5 to CC >5

1

>1.5 to CC <5

2

<1.5 to >1.5

3

<1.25 to >1

4

<1

5

Separation Factor

Criticality

>1.5

1

<1.5 to >1

4

<1

5

Separation Factor

Criticality

>1.5

1

<1.5 to >1.25

3

Marathon Safety Ruleset:

Baker Hughes Safety Ruleset:

Sperry-Sun Safety Ruleset:
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<1.25 to >1

4

<1

5

Separation Factor

Criticality

>5

1

<5 to >1.5

3

<1.5 to >1

4

<1

5

Schlumberger Safety Ruleset:
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7. 3D View
This view in HawkEye™ expands the 3D space to occupy most of the lateral real estate
of the screen. This is helpful for getting a better overall view a field. You will notice a
spatial distortion of the background the further you zoom out, but the curves as
represented are not distorted.

Navigation tools in the 3D space are many and powerful, and they are discussed in
detail in the next section. But here are a few key mouse-based tools to remember:
FUNCTION
Zoom in and out
Pan
Move slider
Access context menu

MOUSE CONTROL
Hold right button and scroll wheel up and down
Hold left button and move mouse around
Move scroll wheel up and down
Right-click on the object (curve, target, plane or background)

Also don’t forget the keyboard hotkeys. See page 11 for the list.
RETURN TO SPLIT VIEW: You can always DOUBLE-CLICK on the 3D space in the
Split view to expand the window to full-size.
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8. VS View
Clicking on the “VS” icon at the top of the main screen will pull up the Side or “Vertical
Section” view onto the main screen, replacing the 3D space and two 2D windows on the
right.
This view is normally displayed
in the default Split View. It is the
view that one would have of a
well from the side. The view
plane is by default 90 degrees
from the proposed bottom hole
location. The direction which is
used to set the Vertical Section
Plane (VSP) is the closure
direction between the surface location and the end of the well.
EXAGGERATION decreases the Y-axis interval, which is useful for horizontal wells
when trying to better fit the entire well in the graph. The exaggeration is by ratio, so if
“1” is 100ft/division, then “2” would be 50ft/division, and “3” would be 33 ft/division.
The icon on the top left

will open the Graphics Properties panel.

The Presentation Plot icon next to it
will open the Presentation Plot module of
TM
HawkEye , with the current side view at front and center.
PAN: Holding down the RIGHT mouse button on the 2D window and dragging the
cursor around will move the orientation of the grid, allowing the user to navigate along
a curve or otherwise change a view perspective along the graph’s plane.
ZOOM: Holding down the left mouse button to draw a box onto the graph will zoom
the graph into that area.
MAXIMIZE VIEW: Double-click on this chart to return to the Split View. Then doubleclick again to return to previous view.
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9. Top View
This mode is an expanded view of the 2D “horizontal view” that is normally seen in the
bottom right window when the “Top View” tab is selected. It is a view as if looking
from the top down on the well, with north oriented to the top.

The icon on the top left
will open the Graphics Properties panel.
The Presentation Plot icon next to it (“PLOT”) will open the Presentation Plot module of
HawkEyeTM, with the current top view at front and center.
PAN: Holding down the RIGHT mouse button on the 2D window and dragging the
cursor around will move the orientation of the grid, allowing the user to navigate along
a curve or otherwise change a view perspective along the graph’s plane.
ZOOM: Holding down the left mouse button to draw a box onto the graph will zoom
the graph into that area.
MAXIMIZE VIEW: Double-click on this chart to return to the Split View. Then doubleclick again to return to previous view.
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c. Proximity
This plot shows the distance from the reference well (oriented in the center) to the other
wells.
CALCULATE PROXIMITY BOX: In order to
“turn on” this plot, you have to check the
“Calculate Proximity” box. This will activate
the relatively resource-consuming
calculations. This can also be done by clicking
on the blank circle plot itself.
REFERENCED CURVE: This is a displayonly box that indicates which curve is the
referenced curve that is shown as the center
point of the plot. Change the reference curve
by changing the current curve selected for the
3D space.
SCALE: Set the radius within which distances
between curves is analyzed.

The Proximity panel puts a reference
curve in the center and displays any of
three types of distances for each curve.

THREE TYPES OF DISTANCES:
TRUE: The closest distance (closest approach) from the reference point to any other
well, regardless of what plane it is in. Some references regard this as the “closest
spherical distance.” It is important to have this distance type turned on when you are
approaching a well, as it is the only tool that can pick up a head on collision with
another well.
NORMAL: The plane that the distance is measured on is the plane which is
perpendicular to the direction vector where you are currently aimed (current MD, Inc
and Azm). This distance is often the most useful when directional drilling; knowing
how much to the left or right, or up and down one is determined with this tool. NOTE:
This is the distance type used when adding a UD and RL column to a survey report.
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TVD: The distance measured along the horizontal plane at the TVD of the current
reference well location. In vertical wells this tool is most useful.
LEASE LINE DISTANCE: Turning this on will measure the distance to any active lease
or hard lines. It will display any user-set offset distance to the lease line, as well as the
boundary line distance. The proximity information generated here is displayed in the
3D info field in the upper left corner of the 3D space. This distances displayed will
have an ‘O’ and a ‘B’ appended to the end. The ‘O’ represents the offset boundary from
the lease line and the ‘B’ represents the actual boundary itself. Only the closest
boundary point data is displayed.
You can see a thin line in the 3D space connecting the current point with the boundary
lines. (To turn on 3D Info, just open the Graphics Properties panel and select the “3D
Options” tab, and click the “Show 3d Info” box).
NOTE- North Arrow v. High Side Arrow:
When following along the reference curve,
the Proximity plot will stay oriented to north
(as indicated by red the arrow pointing up
labeled “North”), but when the look-at point
reaches an inclination greater than 1.5
degrees, a black highside arrow will appear to
indicate the orientation of the plot, and the
red north arrow will remain.
NS/EW and UD/LR: If the look-at point along
the curve is somewhere under the inclination
threshold (set in the Sight Editor on the
bottom right of the form), then distances to
the curves will be expressed in terms of North/South or East/West of that curve. When
the look-at point reaches an inclination higher than the threshold, then distances are
displayed as Up/Down and East/West of the curve.
Distance Lines: When “Calculate Proximity” is turned on, distance lines will appear in
the 3D space to illustrate the distances calculated in the plot. They are color coded red
and black for true distance, Blue and Black for normal distance, and Cyan and Black for
TVD distance.
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The distance lines will scale to the thickness of the well diameter, which can be set in
the little control bar just below the 3D space.
TIP: To get to a specific look-at point for particular proximity analysis, just type in the
MD or TVD into the forms then press Tab in the bottom left just below the 3D window.
PROXIMITY INFOCARD: By left-clicking on any of the Distance Lines, an Infocard
appears containing all the relevant information of that particular distance calculation
from that particular point to the other well.

IN-DEPTH ON THE PROXIMITY LINES:
The directional driller has two references for orienting his drilling motor; the one he
uses depends upon the last measured inclination. If the inclination is above a certain
low value, normally 2 - 5 degrees inclination, then he orients his motor to high side.
(The most intuitive way to think of high side is that it is the way you like airplanes to be
flown, right side up – that’s high side in oil field jargon).
Otherwise he orients his motor to the magnetic direction that he wants to move
towards. The MWD tool will control the switchover, so when the DD sees an
inclination above the Magnetic-Gravity Tool face value he knows that all the tool faces
being sent are gravity tool face. The fact is that this is one piece of operational
information that must be monitored carefully when sliding at low angles.
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In the snapshot of the Proximity Infocard shown below there are two types of proximity
described. The following is a description of how to interpret this card. The first
proximity type is the proximity to a well and the second proximity type is Next POI
(short for Point of Interest).

PROXIMITY – Sight set to [Normal Plane\TVD Plane] or [Gravity TF\Magnetic TF]
This can represent the proximity between the reference well and any other well
in the project, depending on which Proximity Line you clicked on.
Type: [True Minimum\Normal Plane\TVD]
This represents the type of proximity values being displayed. The True
Minimum values are illustrated by the yellow and black checkered connection
bars in the 3D space. The Normal Plane is illustrated by the green and black
striped connection bars, and the TVD plane connectors are represented by the
Blue and Black lines. The user selects one or all types of proximity under the
Proximity tab. It is best to use True Minimum, but the other two are useful under
different circumstances.
Reference: Reference well name @ X MD, Inc: X, Azm: X
This is the name of the reference well and the current point.
Comparison: Name of comparison well and MD point of comparison
Distance: Straight line distance for type of distance X
Separation Factor: N\A Sigma: N\A
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If separation factor is being calculated the current value and the current Sigma
will be displayed here.
For Gravity Tool Face the distances are described:
Reference is X Above or Below the comparison curve
Reference is X Left or Right of the comparison curve
Reference is X is in Front of or Behind the comparison curve
For Magnetic Tool Face the distances are described:
Reference is X North or South of the comparison curve
Reference is X East or West of the comparison curve
Reference is X in Front of or Behind the comparison curve
When vertical or near vertical (when magnetic tool face is used), it is easiest to
explain relative positions in terms of normal geographic terms such of NorthSouth and East-West. At higher angles, when gravity tool face is used, the
geographic terms become less useful for orientation and steering, so the plane
perpendicular to the direction being drilled (the normal plane) is used as the
steering guide. The easiest way to describe orientation relative to this plane is by
describing it in local human terms, Above-Below, Left Right, in Front and
Behind. The normal plane proximity will always lie on the normal plane, the
TVD plane proximity will always lie on the TVD plane and the True Minimum
proximity will be off those planes almost always. The local descriptions of the
true minimum are projected to the normal plane.

NEXT POI: Points of Interest are defined by the comments that are included on the
Proposal curve. A POI can be a kick off point or the top of a formation or any other
survey that has a comment. The only time this proximity is displayed is when the
current curve is the work curve and there is a plan curve and the plan curve has
comments. Hawkeye will automatically search for the next point of interest and
display how far away it is from the normal plane defined by the inclination and
azimuth at the point of interest.
The primary purpose of this is to allow for the users to have a heads-up about what is
next in line, be that a formation top, casing point, or a critical point in the plan.
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d. File Menu
TM

At the top left of the main screen in HawkEye is the
File Menu. It allows for a number of core file
management options.
TM

HawkEye has a flexible method of maintaining projects
in database files. It is important to understand the
distinction between a “project” and an entire “database
file.”
 A database file contains a collection of projects.
 Whereas a project is a collection of platforms and
wellpaths that are related to one another on an
operational basis.

NEW DATABASE PROJECT: Select this option
TM
to start a new project. The first thing HawkEye
will ask is for the project file to be named and located.
Choose a file location and name the project- it will have
TM
a “.HawkEye ” extension. A database consists of a
single .MDB (MS Access) file. The file has been assigned
TM
a “.HawkEye ” extension so that it can be automatically
TM
opened by HawkEye when the file is double clicked in
Windows, and also to distinguish what kind of .MDB file
it is.
A database file can consists of many hundreds of
projects. It is not recommended that hundreds of
projects are stored in a database file, however; the reason
being that opening and maintaining a large database file
consumes more machine time and also putting all your
eggs in one basket could lead to some extreme frustration should the “.HawkEye” file
be corrupted by destructive forces such as a power surge, a virus, or just bad luck.
NOTE: The best strategy is to have an assigned folder (i.e. “c:/HawkEye/Data” or your
TM
Desktop) in which all of your HawkEye database files are stored. Make routine
backups of this directory.
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A good plan is to keep a group of related projects for a given customer within a single
database; if your customer wants to have direct access to your data it is an easy matter
to simply send them the file without being concerned over whether or not some other
company’s information is divulged.

OPEN DATABASE:
1. HAWKEYE FILE: This will invoke the open project dialogue but will only
open files with the “.HawkEye” extension.
2. WINSERVE FILE: This launches a special dialogue in which the user may
TM
TM
either create a new HawkEye file, or import WinServe files to an existing
TM
HawkEye project file.
BACK UP DATABASE: This option will save the current database to its current folder
(both of which are displayed at the top of the main screen). The backup file will be
named after the original file, plus a date and time so that they cannot get mixed up with
each other.

SAVE AS NEW HAWKEYETM DB: Any currently displayed and existing project
data can be saved over into a new, separate HawkEyeTM file. This is useful for,
among other things, backing up and preserving projects as they are before venturing
into project deviations. When a project is saved as a new file, the project will still be
open under the old name. Thus future changes will be saved to the old project while the
new one remains untouched.

MERGE DATA: This tool allows for the merging of separate “.HawkEye”
databases. This can be useful in circumstances under which different users are
working together on a general group of projects. To use this tool simply use the
explorer to point the “.HawkEye“ file you want to merge with the current database
TM
already opened within HawkEye .

SAVE AS/EXPORT PROJECT:
1. SAVE CURRENT PROJECT FILE: This will launch the “Save as New
TM
HawkEye file” dialogue.
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TM

2. EXPORT TO WINSERVE FILE: This will allow the user to save certain
TM
project data to a WinServe (.svy) file. Not all project data is saved to a .svy
TM
file from a HawkEye project. Before the .svy file can be saved, it must
TM
already exist, HawkEye does not create the file, it just writes to it. This is
TM
TM
because a WinServe .svy file has all kinds of data in it that HawkEye can’t
TM
TM
possibly know, like how the plots in WinServe should look. All HawkEye
TM
does is fill in the curve and target data. NOTE: If the HawkEye project has
TM
more than 20 curves, then only the first 20 will be exported to the WinServe
TM
file. That is because WinServe .svy files have a 20 curve limit.
EXPORT CURRENT CURVE: Allows the user to export the “Current Curve” (the
one centered in the 3D space) to several different file formats: LAS (Log ASCII
Standard), DIMMS (Drilling Information Management System), MMS (Minerals
Management Services) and .SAY (WinServe™).
EXPORT CURRENT CURVE TO CSV: Allows the user to export the “Current
Curve” (the one centered in the 3D space) to a .CSV (Comma Separated Values)
file.
IMPORT .SAY: Brings in a curve from a .SAY (WinSERVE™) file.

IMPORT CSV, TXT, DAT, TAB: Imports a curve from one of these file formats.

RECENT PROJECTS: This list displays all recently opened project files. This is
convenient for quick navigation between several projects at once without having
TM
to re-launch HawkEye from Windows Explorer.

RECENT FILES: This list displays all recently opened non-project files. This is
convenient for getting to often-used files without having to open them
conventionally.

TM

Save and Exit: This will close HawkEye . The program will always automatically
TM
save current data to the currently open HawkEye project file. In order to
preserve a project prior to changes made before closing out, make sure to save the
TM
project as a new HawkEye project.
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e. Main Screen Navigation Tools
All of the most essential tools for getting between view modes and edit modes are
found in two rows just below the 3D space.
It is important to get acquainted with each of these tools, but often the quickest way is
TM
to experiment with them in HawkEye . Switching between work and proposal curve is
utterly essential, as is the zooming tool, but learning the different grid and ellipsis
modes will also greatly enhance the user’s abilities to visualize the space around the
well.

Look-at Point Depth (MD): In the 3D space, the
Look-at Point (POV) is only ever at one point on a
curve that can be slid up and down with the wheel.

This is where the Look-at Point is located wherever
it is on a curve, defined by current MD. The user
can type in the MD, then hit TAB to update.
Look-at Point Depth (TVD): The depth of the
Look-at Point, displayed by TVD here.
NOTE: These depths are also displayed in the top
left of the 3D space (Graphics Properties>3D
Options> Show 3D Info). AND always in the info
bar just above the survey window at the bottom of
TM
the main HawkEye screen. The user can type in
the TVD they want to be it.
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Curve Menu: Left-clicking this button is the
manual version of RIGHT-CLICKING on a curve
in the 3D space or Data Tree. It will bring up the
contextual menu for whichever is the current
curve. This is useful when the MD or TVD
specified is exactly what is desired.
Step Slider: This is a way to move the sight up
and down the curve aside from the scroll button
on the mouse, or W,S or UP, DOWN keys. This
slider become more sensitive as the curve gets
longer because the ends of the slider are always
the top and bottom of the curve. Click either end
to skip to the very beginning or end of the curve.
Step Interval: This sets the distance of each
mouse wheel “click” when gliding up and down
the curve. Even with the hyperscroll mouse, it
takes a lot of spinning traverse the length of a
curve at 1 ft per iteration. But sometimes that’s
what is needed for precision navigation. Choose
from the step speeds: 1, 2, 5, 10, 20, 30, 50, 100.
Curve diameter control: This slider controls how
thick the curve is displayed in the 3D space. Slide
left for thinner, and right for thicker display. The
range is 0.5 feet to 100 feet. This will also control
the size of the red Crosshairs. Hotkeys: Quickly
change the diameter with: Alt+↑ and Alt+

↓

Opacity: This controls the opacity of all the wells
in the 3D space. When the value is decreased, the
wells become more see-through.
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f. Home Ribbon Menu

The Home ribbon menu contains a series of tools used most often. The following is a
brief explanation of the tools:
1. Display Modes: Choose from four Display Modes: Split, 3D, Vertical Section or Top
View. Also choose a Display mode by double-clicking on the background of the
view window itself.
2. Report: Opens the Report Generator
3. QuickPlot: Opens the QuickPlot module
4. Add Survey: Opens the Survey Editor, where surveys are primarily added.
5. Work Mode/ Proposal Mode Toggle: Left-click this button to switch between Work
Mode or Proposal Mode. NOTE: There can be only one “Current” work curve and
one “Current” proposal curve to follow at a time. To set a new “current” curve, just
right-click on the curve and select “Set as Current Work/Proposal Curve.”
6. Driller’s View: Left-click to reset to “Driller’s View,” which is: 1) in the Current
Work Curve, at the end of the curve (last survey), highside up.
7. Highside Up: To turn on or off the Highside Up view mode independently of the
Driller’s View, RIGHT-CLICK on this button. The red arrow will indicate if the
Highside Up view mode is activated.
8. Work Sight/Proposal Sight: Check or uncheck to display the Sight for either the
Work curve or the Proposal curve.
9. Sight Editor: Left-click to open the Sight Editor, where radius, colors and textures
can be chosen for both Sights. Also where the Directional Compass can be toggled.
10. Target List: Opens the Target list, which is the best place to add and edit multiple
targets all in one form
11. Add Target: Quickly adds a single target, and opens that target’s Adjuster form.
12. Choose Targets For Projection: First Target is used with both Slant and Aligned
projections, and the Second Target is used for Aligned projections.
13. Projections: All projections are located here. See the section on Projections for more
details.
14. Well Plan Mode: (Well Plan version only) Toggles the Well Plan module.
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6. Project Organization
a. Files and Databases
All data for each Field/Project is saved to a single database file with the extension
“.HawkEye.mdb”. The data is organized and presented in a tree structure hierarchy, a
concept much like several other well planning software applications, including
WinSURV3D.

Briefly, file organization is as follows:
DATABASE FILE (.HawkEye.mdb extension) contains:
Collection of FIELDS/COMPANIES…
Which contain a collection of PROJECTS…
Which contain a collection of PLATFORM/PADS…
Which contain a collection of SLOT/WELLHEADS…
Which contain a collection of WELLPATHS that are
either proposed plans or actual surveys.

TARGETS are assigned to either a PLATFORM/PAD or a SLOT/WELLHEADS.
LEASE LINES and HARD LINES are associated with the PLATFORM/PAD.
LITHOLOGY is assigned to each WELLPATH, but can be copied to and from a
PLATFORM/PAD.
CASING is assigned to each WELLPATH.
JOB INFORMATION is assigned to each WELLPATH.
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b. Data Tree
The Data Tree is the basis for navigating through all the immense information that a job
TM
TM
contains in HawkEye . Based on the WinSURV3D hierarchy system, it is intuitively
organized to allow the user the easiest method of random access to project information.
On the top of the left-hand panel of the main screen you will find two tabs.

HEIRARCHY: The data hierarchy here should be
familiar to WinSurv3D users with some minor
TM
changes. From the top down, data in HawkEye
is organized into:
Data is organized first by FIELD/COMPANY.
This is the root of the tree, and could be
conceptualized as either the overall field or as the
name of the operator.
TM

Although HawkEye could have multiple
FIELD/COMPANIES open at a time, it will only
have one of these FIELD/COMPANY sub-trees
expanded and displayed at a time.

DATA TREE ICONS
FIELD/COMPANY
Project
Platform/Pad
Slot/Wellhead
Proposal Wellpath
Survey Wellpath (Workcurve)
First Target
Second Target
Target

The next level is Project, of which also only one
can be open at a time. Underneath each of the projects are the one or more
platform/pad.
Under platform/pads are the various Slot/Wellheads. From there, Proposal Wellpaths,
Workcurves and Targets are all thrown in at the same hierarchical level, grouped by
their Slot/Wellhead.
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A Project ( ) may be composed of any
combination of Platform/Pads ( ) found
in
a
given
FIELD/COMPANY
( ). Although the identical tree may
appear under each Project, the data for a
particular Platform/Pad is only written
to the database once, and any
modifications to it will be in effect
throughout all projects in which that
platform/pad appears. However, if you
choose to edit a Project by deleting a
particular Platform/Pad, only that single
Project
would
be
affected:
the
Platform/Pad data remains in the
database, in the Field and any other
Projects it is a part of.

The highest level of data is the
FIELDS/COMPANY, under which all
other dataforms are organized. Any given
FIELD/COMPANY can contain an
unlimited number of projects,
platform/pads, slot/wellheads, curves,
etc.

A Project is created and exists within an
individual Field. The simplest way to
understand the hierarchy is to visualize
the case of an offshore drilling
program. The Field may be a particular
reservoir; there may be multiple platform/pads drilling in that same field; each
platform/pad has the capacity to drill from a number of slot/wellheads ( ) in the
template; and finally, there can be any number of Wellpaths ( , ) associated with
each slot/wellhead.
USING THE SAME PLATFORM/PAD: One Project may be a single platform/pad; for
another you may want to include the next closest platform/pad for anti-collision
purposes; a third may include several other platform/pad, and so on. In other words,
the same platform/pad, or any combination of platform/pad (within a single Field) can
be part of any number of different Projects.
COLLAPSING AND EXPANDING: Any level of the tree may be expanded by clicking
on the “plus sign” (“+”) to the left of that item. (Conversely, clicking on a “minus sign”
(“-“) collapses the tree back up to that level). If there is no plus sign next to the object,
that means there isn’t any data below that level associated with that object.
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ASSIGNING TARGETS TO SLOT/WELLHEADS: Targets can be assigned to specific
Slot/Wellheads in a Platform/Pad. If they are assigned, you will find them under the
slot/wellhead in which they are associated. If a target is not assigned to a slot/wellhead,
it will be placed at the bottom of the Data Tree under the last displayed datum in the
platform/pad:

An unassigned Target will be at the bottom of a platform/pad branch (left). To
assign it, just right-click, select “Adjust Target Parameters” and select the
assignee slot/wellhead from the “Slot” pulldown menu (right).
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c. Project Control Panel
The tab next to the Data Tree at the top of the lefthand window is the PROJECT CONTROL PANEL
tab. Click on it and you will see an interface
TM
resembling the WinServe Control Panel. However,
this Project Control Panel is significantly different
from the WinServe panel. If you are accustomed to
TM
how the WinServe control panel works, there are
some important differences between how the two
control panels operate.
Each numbered square represents a curve. They are
all associated with a particular Project and can be
created ad infinitum. There are 40 curves are
displayed on the first “page” of the Project Control
Panel because most users will not work with more
than 40 at any given time. To navigate additional
pages of curves in this Panel, simply click the
“<<Prev.” and “Next>>” buttons at the bottom of the
Project’s Curves panel.
CURVE ASSIGNMENT: CURVE 0 is always
designated as the WORK CURVE. CURVE 1 is always
designated as the PROPOSAL CURVE. This means
that when you assign a curve as a WORK CURVE or
a PROPOSED CURVE, the curve is moved to either
TM
curve 0 or curve 1. In WinServe Curve 0 and Curve
TM
1 were the suggested numbers to use, here HawkEye
forces the issue.
Beyond 1 and 0, all of the curves in this Panel are customizable. By clicking on the
numbered square, the associated curve data is displayed on the bottom portion of the
Panel. By RIGHT-CLICKING on the square, the user can access the entire contextual
menu as if right-clicking on the curve in question in the 3D space. To change the color,
for example, just right-click on a numbered box and select “Set Color.”
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The EDIT PROJECT button will pull up the small Project Information dialogue. The
TARGET LIST button brings up the comprehensive Target List manager, which
includes the Target Adjuster dialogue and the tools to add, delete and edit all the
targets of the project. The CURVE MANAGER
button invokes the small Curve List box that
allows for turning on and off curve.
TO ADD A CURVE, just click on a blank
numbered box, then go down to the Curve Data
window and then:
15. Type in a name for that curve
16. Select the type, either proposal or survey
17. Select the slot/wellhead to be associated
18. Enter location, tie in and direction
values
19. Click “ADD.”
The new curve will appear in the first open
available square. Any further tweaking of the
curve can be done by Right-Clicking on the curve’s
numbered box and selecting “Edit Curve” from
the curve contextual menu.

Right-clicking on a curve’s box
in the Project Control Panel is
the same as right-clicking on
one in the 3D space, bringing up
the comprehensive contextual
menu for either the proposal or
work curve.

SET AS WORK CURVE/SET AS PROPOSAL
CURVE: To set a curve as the work curve, or a
Proposal curve as the current plan, simply rightclick on the numbered box and select the first item
on the menu, “Set as Work Curve.” If you make
any curve that is not number 0 the work curve, the
curve will automatically be the Number 0 curve,
otherwise retaining all of its parameters including color.

The former Number 0 curve will be swapped out with the new one such that all other
curves keep their number.
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7. Adjusting Graphics Settings
TM

HawkEye allows the user to customize the appearance of everything in the 3D space
to a very high degree.

a. 2D Charts
These options control the look of the labels and appearance of the 2D charts (VS View
and Top View) on the main screen of the program. They do NOT affect the QuickPlot
settings. These settings appear on the computer only.

A. Labels:
a. Label Manager: The Labels manager is explained in the next section
below. It is the only set of options with its own module.
b. Reset Positions: This will reset all labels and settings in the 2D charts
B. Grid: Choose what kind of background grid lines you want for the background
of the VS and Top View.
C. Major Line Type: This will affect the style of
the major grid lines of the background of the
VS and Top View.

D. Minor Line Type: This will affect the style of
the minor grid lines of the background of the
VS and Top View.

E. Axes Font: This will affect the appearance of
the words on the outside left and bottom of
the VS and Top View.

F. Top/VS View: Change what the axes labels
actually read in the VS and Top View.

The 2D Axis Font and text is
completely customizable.
They can be edited under
“Axis Labels” in the Graphics
Properties.
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G. Background Style: There
are essentially three
background style modes for
the VS and Top Views: one
color, two colors or three
colors.
The Angle and Alpha
determine how multiple
colors will bleed into each
other.

Grids can be given gradients by tweaking the
Background Style settings.
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b. Labels Manager
This panel controls all the characteristics of the alpha numeric labels found in the 2D
windows as well as the 3D space.
Get to this dialogue by clicking on the icon on the far left under the “2D Charts.”

VS and TOP VIEW: Check any of these boxes to toggle the particular label to show
up in the 2D VS view and 2D top view.
AUTO LABEL FREQUENCY: This section relates to how often you want to have a
label generated in the plot. For now the only option is to select every X number of
surveys. However, by MD and by TVD every X number of feet or meters should be
available in future versions.
SCOPE TO APPLY: This controls to which curves the labeling schema is to be
applied, whether it is to all curves or just the proposal curve and or the current work
curve.
TEXT PROPERTIES: This section of the panel controls all of the features of the
lettering as they are found in the 3D space. To change the fonts, select the “Axis
Labels” tab at the top of the panel and click on the “3D Axis Font…” button.
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VS VIEW EXAGGERATION: Exaggeration increases the Y-axis interval, which is
useful for horizontal wells when trying to better fit the entire well in the graph. The
exaggeration is by ratio, so if “1” is 100ft/division, then “2” would be 50ft/division,
and “3” would be 33 ft/division.
BOTH PLOTS: Check any of these boxes to toggle the described features which are
applied to both the VS View and Top View graphs.
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c. 3D Screen

The “3D Screen” tab contains all parameters that affect the appearance of objects and
background in the main 3D window of the program.
A. Curve Comments and Annotations: Select whether you want comments and/or
annotations to be displayed for the current slot’s wells, or only for the currently
selected well.
B. Target & Casing Comments: These options will determine the appearance of
the target and casing labels in the 3D space. Use the checkboxes to turn on and
off the comments for these object types.
C. Micellaneous
1. Create Annotation: This will create an annotation AT THE CURRENT
LOOK-AT POINT in the 3D space.
2. Show Compass: This will show the Directional Compass in the 3D. You
can also turn this on and off with the (,) comma key while your cursor is
hovering over the 3D screen.
3. Show Rig: Toggle the derrick graphic at the top of each currently selected
well.
4. Show Slidings: Slide markers are shown if the curve is associated with a
job from a WinSurv2 database on the same hard drive. Associate
WinSurv2 jobs to a curve by selecting the curve as “Current” work curve,
then going to Job Data under the “Edit” tab and selecting “Get from
WinSurv2.”
5. Survey Markers: This will generate a green marker at every survey
station along the curve.
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D. Information Text: This controls the
appearance of the “3D Info” in the top left
corner of the 3D screen.
It is fairly important to get the settings for
this text easy to read because it is
referenced frequently. It displays the
exact location of your 3D Look-At Point
as you move up and down a curve, and
interpolates information when there is no
official survey at a given MD.

E. AXIS FONT: In the distant 3D background of the 3D space, there are axes, the
font and color of which you can change with these options.
F. WALLS AND 3D MAGNIFICATION: Control the color and shade of the 3D
background walls and floor.
The Magnification slider will affect the “Zoom Factor,” which is different
from the camera zoom done with the right mouse button plus mouse wheel.
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d. General

A. Curve Comments: The Auto Comments feature will create a
descriptive comment at every critical point on a plan. NOTE: If you use this on
an as-drilled well, it will generate a comment for virtually every survey station
because each station creates a geometrically dynamic shape.
Clear Comments will erase all comments for the current curve. NOTE:
There is no “undo” button.
B. Hard/Lease Line: These options determine how a hard line or lease line
appears and behaves in the 3D space.
The “Show 3D Objects” option will toggle whether the Line appears as a
simple line, or a mass in the 3D space. The “Show 3D Lines” will superimpose
simple lines over the mass.
The “Fixed TVD” option will lock the Line at a specific depth. Choose the
locked depth in the Lease/Hard Line editor. Get to that editor by finding your
Lease/Hard Line in the Data Tree, right clicking on the line and selecting “Edit
Lease/Hard Line.” In the Adjuster dialogue that pops up, change the “TVD” of
the line to determine its locked depth.
C. Miscellaneous:
1. Include All Structures Within: This option can be used to
exclude offset wells that are slowing down the computer.
2. Interval Length For Projections: Change the frequency for
surveys in a projection.
3. Autosave Every: Turn this on for the program to save ALL data
to the current database at a given interval. For faster computers with
adequate RAM (8GB+), it is recommended that this option be turned on.
4. Autoshow Curves with Criticality >1: This will force the
program to display curves in the 2D and 3D which have a criticality to the
current curve of greater than 1. Criticality is a number of 1 through 5
based on the chosen safety ruleset and the separation factor for any given
point.
5. Show tips at Startup: Uncheck this to permanently disable the
startup message.

57
HawkEye

TM

User’s Manual

Copyright © 2017 by Performance Drilling Technology, Inc.

6. Create Projection Comments: This will automatically generate
comments for the critical points along an active projection.

D. View Options
1. Display Theme: Choose one of several background color themes for the
main program.
2. Remote View: This mode will allow computers that are connected to
your machine by remote session to navigate the 3D space without extreme
jumpiness in the rendering.
3. Survey Grid: This will launch the Survey Grid Manager, the dialogue
where all settings for the survey list on the bottom of the main screen can be
changed. You can also get to this dialogue by right-clicking on the colored title
header of the Survey List Grid itself, and selecting “Survey Grid Manager.”
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PROJECT QUICK START WIZARD
The very first option in the File Menu is the Wizard. Clicking on
the icon
brings up the Project Quick Start, a project Wizard that enables the user to create project
with a minimum of information in a short amount of time, all in just a few steps.

The Project Wizard can kickstart any project with a certain minimum
amount of information entered over a few steps in order.
STEP 1 Enter the Field Name. If it already exists, it will be in the drop-down menu in
STEP 1.
STEP 2 Enter the Project Name. Also choose the type of North Reference as well as the
units to be used (feet or meters). Choosing the Safety Ruleset for most users
will not be necessary (the rulesets are company-specific separation factors for
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ellipses of uncertainty). Here the user should also enter the project’s elevation
and RKB for the platform/pad if known. If this information is not yet known, it
can be later entered by right-clicking on the slot/wellhead or platform/pad in
the Data Tree and selecting “Edit” in those menus.
STEP 3 Open the Job Information dialogue and enter information. The information in
this dialogue is pulled from any available Winsurv2 job information, providing all
available JOB IDs to select from. Otherwise, the user will create a new Job Name in this
step. Any new Job created here will automatically prompt the user to import the new
data over into WinSurv2.

STEP 3 of the Project Quick Start Wizard allows the user to be as thorough
as they wish when creating a new project. Furthermore, job data is readily
available from any available WinSurv2 data.
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STEP 4 Click on the “Geodetics Information” button and open up the Geodetics
dialogue. Choose the Group to be used.2 If the computer is connected to the Internet,
then Google Maps will automatically come up with the current location. If you are
working in international territory, it is likely that a UTM will be used, either southern or
northern hemisphere. All of these are available in the first pulldown menu at the top of
the dialogue. Then click “Save and Exit.”

STEP 4. The Geodetics dialogue allows for maximum control over map
data being used, and correlates that data with Google Maps (Internet
required) and Google Earth (Internet and free install required). This
screenshot shows a location without Township, Range, Section (TRS)
information, because it doesn’t exist for the state of Texas.

2

If you do not have the geodetics information yet, that is okay. Just select “None” from the
Group pull-down list. This will simplify the Slot Geodetics dialogue and allow you to work
with local coordinates until the geodetics can be entered at a later time.
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After completing the final step of the Wizard, click “Ok.” Now you will have a fresh
project waiting in the Data Tree. The Wizard provides the following by default:






Platform/Pad
Slot/Wellhead
As Drilled Curve
Proposal Curve
(First) Target

You can delete or edit these initial objects by right-clicking on any of them and choosing
an edit action from the contextual menu.
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II.

PROJECT DATA

1. Adding Basic Project Data
Although the Quick Start Wizard is great for getting started, the user will inevitably
have to dive into the Data Tree and add things like slot/wellheads and curves. But
doing so is an intuitive process.

a. Adding Projects and Platform/Pads
ADDING FIELD/COMPANY: Starting from the
top, in order to add a new Field to the currently
open database, right-click on the
FIELDS/COMPANIES label at the very top of the
Data Tree and select “Add New Field.”

This opens up a small dialogue in which you can
enter the Field Name and the Location. Location as
entered in this dialogue is not used anywhere in
the program, but it is a useful reference datum.

ADDING PROJECT: Once a new Field is added, right-click on
that field in the Data Tree and select “Add New Project.” This
will pull up the Project Information dialogue, where name,
units and other basic relevant data can be added. Geodetics can
also be set from this dialogue.

63
HawkEye

TM

User’s Manual

Copyright © 2017 by Performance Drilling Technology, Inc.

NOTE: If you don’t want to set geodetics just
yet, you can do it later, but you still have to go
into the Geodetics dialogue and then Save and
Exit in order to finish the Project Information
dialogue.
ELEVATION (To Mean Sea Level):
The current version allows only one mode of
elevation, which is the platform/pad’s elevation
plus the RKB height.
TM

Once a Project is created here, HawkEye will provide a default Platform/Pad,
Slot/Wellhead, dummy Wellpath and First Target. The dummy surveys are
placeholders waiting for the user to modify them, and will show up in the 3D space as
short vertical curves by default.
Once a Project is created, HawkEyeTM will
provide for it a default Platform/Pad,
Slot/Wellhead, Wellpath and First Target. If
there was no survey then there would not be a
visible component in the 3D space. This is the
equivalent of what you commonly see on a data
tree that has a ‘+’ to the left of a closed tree item.
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ADDING Platform/Pads: To add a Platform/Pad,
simply right-click on the Project
in the Data Tree you
want the Platform/Pad to be associated with, then select
“Create New Platform/Pad For Project.”

In this dialogue, platform/pad data
(name, reference slot/wellhead,
elevation and convergence) and
platform/pad coordinates can be
added. To finish, click the “Create”
button and the platform/pad will
appear in the Data Tree.
Along with the new platform/pad,
there will be a default slot/wellhead
and a default survey and proposal
curve.
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ADDING SLOT/WELLHEADS: To add a new Slot/Wellhead,
right-click on the Platform/Pad
, then select “Add New
Slot/Wellhead”

.

EDIT SLOT/WELLHEAD: This invokes the Slot/Wellhead
Information dialogue, which allows the user to input the
Slot/Wellhead name, and add a variety of different coordinates
defining it.
Coordinate information can be added by way of LatitudeLongitude, GeoDetic Grid, or Local EW NS values.
Click “Launch GeoHAWK” to see the
slot/wellhead’s exact location through
Google Earth.
Click “OK” to save and close out this
dialogue.
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b. Adding Wells and Sidetracks
ADDING A WELL: To add a well or curve, right-click on the
associated Slot/Wellhead
in the Data Tree to pull up the
contextual menu, then select “Add New Well Path”.

In the “Add New Curve” dialogue, you may
enter the Curve name, Job Name (new or pulled
from a WinSurv2 database), Survey Type
(proposal or survey), RKB, tie in point and
referenced slot/wellhead coordinate.
The curve will appear as named under the
slot/wellhead you right-clicked on in the Data
Tree.
NOTE: The “Tie in Point” in this dialogue should not be used to create a new wellhead
at surface. This is for sidetracks.
To create a new slot/wellhead, right-click on the Structure/Pad in the Data Tree
and select “Add New Slot/Wellhead.” From there, define that wellhead with the proper
location info, and create a new wellpath under that new wellhead.

67
HawkEye

TM

User’s Manual

Copyright © 2017 by Performance Drilling Technology, Inc.

ADDING A SIDETRACK:
Add a side track curve by either:
1) Selecting the “Add Side Track” button from the “Edit” tab.

2) Or right-click on the associated curve either in the Work Mode or
Proposal Mode to pull up the contextual curve menu, then select “Add
Side Track” .

In the Create Side Track dialogue,
you define the sidetrack curve as
an entirely new curve which starts
at the defined tie-in point.
Additionally, you can define the
sidetrack as any kind of projection
before creating it, using the
“Projection Type” dropdown
menu.
CURVE NAME: When you click
on the “Create” button, a new
curve will be generated either as a
Proposal Curve, Work Curve or both, and it will be named whatever you name it. The
default is “Side Track Curve.”
CURVE TYPE TO ADD: When you generate this curve, you may create it as either a
proposal curve, work curve or both. Make sure to select the type you want in order to
avoid confusion later on.
PROJECTION TYPE: You can select from four projection types in the Side Track
dialogue: Nudge, Slant, Aligned and Back-On-Track. When you select a projection type,
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its corresponding control panel will appear inside the Side Track dialogue and you can
tweak the side track projection from there.
TIE IN POINT: This set of parameters is arguably the most important aspect of the side
track curve. From here you will define where along the parent curve the side track will
emerge, either by MD or TVD. The inclination, azimuth and coordinates are calculated
automatically.
REFERENCE: This is a passive data display based on the Tie In Point information
provided.
CREATE: Once the parameters of the Side Track have been tweaked to your liking,
click the “Create” button and a new curve will be created, branching off from the parent
curve. This new curve will extend all the way back up to the surface for torque and drag
calculation purposes.
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c. Importing Surveys from Excel, .CSV, or .SAY
Copy and Paste Surveys

1.

Surveys can be imported in HawkEyeTM or they can be added and edited manually
within the program. One simple way to import surveys into HawkEye TM is to copy them
from a spreadsheet and paste them directly into the 3D or survey window.
STEP 1
Grab the data from the spreadsheet by selecting it
and copying (Ctrl+C or right-click and select
“Copy”).
NOTE: HawkEyeTM will accept spreadsheet data
from Microsoft Excel, OpenOffice and all other
common spreadsheet programs.
IMPORTANT: Spreadsheet column order must be
in MD, INC and then AZM from left to right in
order to paste properly in HawkEyeTM.
STEP 2
Right-click in HawkEye in either the 3D space,
Data Tree or on the Survey List Panel, and select
from one of five options. NOTE: These options
highlighted in green will only appear if you’ve
just copied surveys from a CSV or spreadsheet.
o Paste Survey List Over This Curve: If you have right-clicked on a specific curve in
the Data Tree or 3D space, you will overwrite the old surveys with your new copied
surveys.
o Paste Survey List as New Curve: Takes whichever surveys you have copied and
puts them into a new curve under your current slot. You will be prompted to name
that slot and designate any tie-in info if applicable.
o Paste Survey List Under New Slot/Wellhead: This will create a new curve with
your copied surveys, as well as a new slot/wellhead under which it will be located.
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NOTE: Be sure to right-click on the slot/wellhead after pasting and set the proper
slot location, RKB and elevation because that is all zero by default.
o Paste Critical Points As New Proposal Curve: If you copied a list of critical points,
this will paste them in as a new curve, then automatically interpolate (generate
surveys in between) with a default frequency of surveys every 30 feet on a curvature
o Paste Critical Points Over Current Proposal Curve: Replaces your Current Proposal
curve with the surveys you just copied. “Current Proposal” means the active
proposal that you have set as “Current” as indicated by the bold letters in Data Tree.
o and every 100 feet on straight tangents. NOTE: A typical list of critical points is 5-8
surveys. If you try to paste more, HawkEye will prompt you. If it is over 20 surveys,
HawkEye will not let you paste as critical points.
NOTE: The other way to interpolate a list of critical points is to enter the critical points
in as surveys, then go to the Report Generator, for Report Type choose “Interpolate
Survey,” put in your interpolation frequency, then click “Keep Curve.”
NOTE: If you copy surveys and include the header for the columns, you can include tiein information, namely the TVD, N-S and E-W of the first survey. But make sure the
first three columns are still MD, INC and AZM in that order.
Importing WinServe .SAY files

2.

Individual curves can be exported from WinServe as .SAY files. They can be imported
into HawkEye in four ways:
1) Right-click on the .SAY file in Windows without having to open it, and select
“Copy,” then in HawkEye right-click in the Data Tree and select “Paste .SAY
surveys.” It will appear in the current slot you are in. NOTE: This method works
with EDM files as well as WinServe .SVY files.
-OR2) Drag the .SAY file from Windows and drop it into the 3D space in Windows. It will
automatically appear under the current slot you are in.
-OR3) Go to File and select “Import WinServe .SAY File, select the file from the explorer
and it will appear as a curve under the current slot you are in.
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4) Open the .SAY file in Excel (delimited with spaces) and then copy the MD, INC and
AZM columns. Right-click in the 3D space in HawkEye and choose one of the
pasting options highlighted in green.
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Importing and Exporting

3.

Worthy of special mention in the curve right-click contextual menu are the Export and
Import options. (Also found in the File Menu on the top left). Surveys can be exported
to five types of files. NOTE: Any additional standard formats that may be required can
be included per request by the user.
a. .SAY files – A special survey format that works with PDT’s other survey
products, WinServeTM and WinSurv2TM.
b. MMS files – A special survey format that for the Mineral and Mines Service
in the United States.
c. DIMMS files – A special file format to supply survey data to DIMMS, a
Landmark rig reporting system.
d. CompassTM files- The import options on the menu should be fairly obvious.
However, one very important option is not on the menu and that is the
import of a CompassTM transfer file.
e. CSV files – Comma Separated Values files that can be easily imported into
spreadsheets and databases.
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d. Importing Compass or WinSERVE Projects
1) From the File Menu: Open the File menu on the top left and select “Open
Database.” Choose the file format and open the file.

2) Drag and Drop: Importing a project file from a WinSERVE™ or Compass™ file
is also done by dragging and dropping. Simply drag the file (either .svy or
edm.xml format) from the folder into the 3D space in HawkEye and drop it in.
HawkEye will automatically parse out any and all curve, target, casing and other
project information, and create new project data at whatever level the data
contains. (e.g. If an edm.xml file has only curve information, then HawkEye will
only create a new curve with that information, not an entirely new
field/project/platform/slot).
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2. Editing Critical Info
a. Job Data
Job data is used for several reasons:




TM

TM

Job data is where WinSURV2 and HawkEye communicate
Job data is displayed in report headers
Job data is displayed in wall plot headers

EDITING JOB DATA:
When a project is started
through the Project Wizard,
the “Job Information”
button is one of the four steps. However, a user can change job information at any time
by clicking on the “Job” icon at under the “Edit” tab.
Note the very top line of the
Job Information dialogue,
“Curve Name.” This indicates
which curve is being
referenced, and can be changed
in the main interface by
changing the current curve.
If you want to go from a
proposal curve to a work curve,
remember to switch to Proposal
Mode. The Mode toggle is in
the Home.

GET FROM WINSURV2: Once
the right curve is selected, then
TM
a Job ID can be selected. If a job has already been created in WinSURV2 , just select the
“Get From Winsurv2” box and the dropdown list for Job ID will be populated with all
TM
of your WinSurv2 jobs.
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This will not only retrieve any job header information from a WinSurv2 job, but it will
also bring in all BHA lists from that job, as well as slide records. The BHA records can
be used by turning on the “BHA ID” in the Survey List Panel (right-click on the survey
list header and select “Grid Manager” to add the column, and then using the pulldown
menu to associate a particular BHA with a particular survey.
Slide information can be used in HawkEye by grabbing it from WinSurv2 as described
above, and then turning on “Show Sliding” under the 3D Screen tab.

COPY TO WINSURV2: You may fill out this job information form and send it to
TM
TM
WinSURV2 as a new job. It will appear in WinSURV2 as a new job containing all of
TM
the information that you entered in HawkEye .
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b. Surveys
One of the primary regions on the main screen is the survey grid at the bottom. It
displays all the survey information for the currently selected path and has a
customizable data spread that behaves like a spreadsheet application.

TM

The surveys in HawkEye are displayed in the default main screen along the
bottom. The window provides a wide spread of customizable information fields.

CUSTOMIZE COLUMN ORDER AND FREEZE FRAMES: The data columns can be
moved left and right by clicking and dragging the column header and dropping it
wherever desired. In addition, there is a freeze frame stop control that can also be
dropped between any two columns in order to “freeze” all columns to the left such that
when the horizontal scroll bar is used, only the columns to the right are moved.
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The full spread of data in the survey window is extensive, offering 47 different types of
data for each survey entry. Customize the columns by selecting the Survey Grid button:

The following is a list of the data displayed for each survey:
List of Survey Data Columns
No.
BHA ID
MD
Azm Deg
Inc Deg
Closure Dir Deg Closure
NS
EW
TVD
2
2
Comment
NN (ft ) *
EE (ft ) *
VV (ft2) *
NE (ft2) *
NV (ft2) *
EV (ft2) *
HH (ft2) *
LL (ft2) *
AA (ft2) *
HL (ft2) *
HA (ft2) *
LA (ft2) *
Minor
Major
Minor Azm Deg HLA Major
Vertical
HLA Minor
HLA Depth
HLA Azm Deg Survey Type
Subsea
DLS °/100
Build Rate °/100
†
Walk Rate °/100 VS
TFA Deg
Easting
Northing
Latitude Deg
Latitude DMS
Longitude Deg Longitude DMS RKB
CL
BHA ID
* Measurements may be in feet or meters, depending on project settings.
† TFA stands for Tool Face Angle and is the same as TFO.
ADDING SURVEYS ONE BY ONE: Click the blue plus icon on the far left in
the Home tab to open the Survey Editor. In this dialogue all of the surveys for
the currently selected well will appear, and several of their parameters may be
edited.
The primary way to add a survey is, once
inside the Survey Editor, type the
Measured Depth, press ENTER, then type
in the Inclination, press ENTER, and then
type in the Azimuth and press ENTER.
After the third “ENTER,” your new
survey will have been created.

78
HawkEye

TM

User’s Manual

Copyright © 2017 by Performance Drilling Technology, Inc.

c. Slot/Wellheads

The Slot/Wellhead is the most-used data level of a given
project. All curves and targets are associated under a given
slot/wellhead at any given time. The slot/wellhead in
HawkEye is represented with a “rig” icon.
A platform/pad will contain as many slot/wellheads as are
needed, and only lithology information, target planes and
hard/lease lines are associated to a platform/pad.

RIGHT CLICK ON THE SLOT/WELLHEAD: To change
slot/wellhead information, right-click on the rig icon in the Data
Tree and select “Edit Slot/Wellhead Data.” Notice that the rightclick menu for slot/wellheads has virtually everything you will
need which is slot/wellhead-related. Only from this right-click
menu can you do the following:





Edit Slot/Wellhead Data (also from large icon, see below)
Add New Well Path
Set slot/wellhead as the reference slot/wellhead
Delete the slot/wellhead

EDIT SLOT/WELLHEAD INFORMATION:
When “Edit Slot/Wellhead Data” is selected,
it will open the Slot/Wellhead Information
dialogue.
You may also get to the current
slot/wellhead’s information by clicking on
the large rig icon at the top of the screen. The
Slot/Wellhead Information dialogue has all
of the location information associated with
that slot/wellhead.
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SLOT/WELLHEAD NAME: This is the only place where the name of the slot/wellhead
can be changed besides initially in the Project Wizard or the Platform/Pad Manager
(Well Planning Version only).
INPUT COORDINATES: All of the parameters inside of the green background are
used to define the slot/wellhead’s location, either by local coordinates, Northing and
Easting coordinates, or Lat-Long coordinates.
CONVERGENCE: This value is derived from the location data of the slot/wellhead,
and indicates the number of degrees difference between grid north and true north. This
number is also displayed in the Geodetics dialogue when defining surface location.
LAUNCH GEOHAWK: When the “Launch GeoHAWK” button is clicked, it launches a
special version of the Geodetics dialogue. In this special version, the user cannot change
any surface location data (highlighted on the right). Only the specific location data for
the slot/wellhead can be altered.
The point of GeoHAWK is to utilize the power of the Geodetics dialogue, which uses
Google Maps and Google Earth (if installed), for slot/wellheads. In this fashion,
slot/wellhead location can be defined, visualized and mapped out with great precision.
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d. Targets (regular)
1. Creating and Managing Targets
Targets in HawkEyeTM have several important functions: to act as designation points for
the so-called targeted projections (Slant, Aligned, BOT and Horizontal, explained in Ch.
4 Projections), to serve as visual aids in the 2D and 3D space as representations of , and
to act as placeholders or bookmarks in an active work space.
IN 3D SPACE: Targets appear in the 3D space by
way of their own parameters which define
appearance, orientation and location. They do not
follow curves or other platform/pads and their
specific parameters must be re-defined in order to
be moved around or changed in any way.
IN THE 2D VIEWS: The targets appear in the Vertical
Section and Top Views on the right hand windows of the
default screen. Their labels can be customized in the
Graphics Properties panel, which can be accessed by
clicking on the top left icon
in either 2D window.
The target labels can be moved around in the 2D windows
simply by left-clicking and dragging them.
Any target can be right-clicked on in the 2D views to pull up a quick synopsis of critical
target information.
IN THE DATA TREE: Targets
can be found in the Data Tree where they are
associated with a particular slot/wellhead. When the Quick Start Wizard is used to start
a new project, the Wizard will create a single default target under the default
slot/wellhead. Otherwise, a target must be added manually. Any new target can be
found in the Data Tree as well as the Target List. They are associated with the
slot/wellhead under which the current proposal curve is located.
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ADDING TARGETS: There are several ways to add a target to a project:
1.

Add Target: Click this icon, which is located on the Home tab. The target
appears at a default shape and size at 5000 TVD.

2.

In the Target List: Click on the Target List in the Home tab to add multiple
targets. (More on the Target List later in this chapter).

3.

In the Curve Menu: Right-click on any curve and select “Create Target at This
Point” and the target will appear at that exact point (ONLY for Proposal Curve).

4.

In the Crosshairs Menu: Right-click on the red Crosshairs and select “Save as
Permanent Target.” It will appear in that exact spot. (More details under
subsection on Crosshairs in Ch. 3 Projection Tools).

5. In the Survey List Grid: Select a survey in the list grid of surveys at the bottom of
the main screen. Then press Shift+T. This will create the target instantly at that
survey station.
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TARGET RIGHT-CLICK MENU: The target
contextual menu is pulled up by right-clicking on a
target name in the Data Tree or the target in the 3D
space. All of the primary functions of the target can be
found in this right-click menu.


TARGET ADJUSTER:
This option in the
right-click menu will open the TARGET
ADJUSTER panel, which is the primary main
screen platform for editing targets. This control
panel is explained in detail in the next subsection.



TARGET LIST:
This option in the right-click menu invokes the TARGET
LIST, which is a comprehensive, interactive list of all targets in a project and
includes the TARGET ADJUSTER PANEL. This control panel is explained in
detail in one of the following subsections.



ADD NEW HARD LINE:
This will first prompt the user to enter a name for
the new hard line, then that hard line will appear in the Data Tree. To edit the
hard line coordinates, RIGHT-CLICK on the hard line in the Data Tree and select
“Edit Hard Line Coordinates.” For more information on hard lines, see the
section following this one.



ADD NEW LEASE LINE:
This will first prompt the user to enter a name for
the new lease line, then that lease line will appear in the Data Tree. To edit the
lease line coordinates, RIGHT-CLICK on the lease line in the Data Tree and select
“Edit Lease Line Coordinates.” For more information on lease lines, see the
section following this one.



CLONE TARGET:
Select this option in the right-click menu to duplicate the
target and all of its parameters. The depth is automatically made 100 length units
deeper than the target being cloned, so this will probably need to be changed
along with the target coordinates.



GO TO TARGET:
This right-click option is a navigation tool for the 3D
space. It will take the Look-at Point or current point of view and center it on the

83
HawkEye

TM

User’s Manual

Copyright © 2017 by Performance Drilling Technology, Inc.

selected target. This is useful for zooming around and getting spatially adjusted
in the 3D space quickly.


SET AS THE FIRST TARGET:
This right-click option is a critical tool in
using the targeted projections. Under any platform/pad, there is only one
designated First Target at a time. Any target can act as the First Target as long as
it is designated as such. When it is set, the First Target is a designation point for
the projection calculations of Slant, Aligned, BOT and Horizontal projections. If
TM
any of these projections are attempted without a First Target, HawkEye will
prompt the user to set a First Target before continuing.



SET AS THE SECOND TARGET:
This right-click menu option is used only
for Aligned Projections, which may require a second registered target for certain
TM
calculations. When a Second Target is required yet not set, HawkEye will
prompt for the designation of one.



DELETE TARGET:
This option will instantly delete the target from the
database. NOTE: To make a target invisible but retain it, just select “Hide” from
the right-click menu or uncheck its box in the Data Tree.

HORIZONTAL TARGET RIGHT-CLICK MENU: You can create a horizontal
target by clicking on the large Target icon in the main screen and selecting
“Add Target Plane.”
Then right-click on the target plane either in the 3D space or the Data Tree. The
menu is almost identical to the normal target right-click menu, except that here you
can also designate the target plane as the “Horizontal Target Plane,” which is used
with the Horizontal Projection.
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2. Target Adjuster
The panel that appears inside of the 3D space to the
right contains all of the parameters associated with a
target. Its name, assigned slot/wellhead, color, texture,
general shape, orientation and location can all be
changed through this panel.
Pull up the Target Adjuster by right-clicking on a
target in the Data Tree or 3D space and selecting
“Target Adjuster.”
This panel will also always
appear in the TARGET LIST, which is a panel
explained in a following subsection.

The Target Adjuster is the
primary and fastest way to edit
a target. This panel is invoked
from the target’s right-click
menu and appears inside of
the 3D window.

The top four icons in the Target Adjuster are the same
options found in the right-click menu:
Set as First Target, Set as Second Target, Go to Target and Clone Target.
NAME, SHAPE, SLOT: The next three fields
allow the user to edit some critical information.
The “Name” field is an open field and the
target can be called anything. The “Shape”
drop-down menu will instantly shape the
target into one of several default 2D or 3D
shapes: cylinder, cube, polygon, circle, ellipse,
square, circle, ellipsoid, point and other. The
“Slot” drop-down menu contains all
slot/wellheads in a platform/pad to choose for
a target’s assignment.

TVD: A Total Vertical Depth can be entered manually, and must either be defined as a
subsea or an RKB TVD.
COORDINATES: The coordinates for the target are either Local or Grid and the NS
and EW values can be input manually.
MAP: The “Map” button will invoke a separate control panel in which specific,
advanced location data can be entered for the target. The target “Map” panel will allow
the user to control specific coordinate and mapset information.
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The magnetics icon in the top
left will launch the Magnetics
dialogue, which controls the
magnetics adjustment data for
the entire project. This can also
be launched from the main
screen through the same icon
at the top.
Group, System Zone and
Datum are displayed, but not
editable. These can only be
changed at the Project level,
through
the
Geodetics
dialogue.
The Current Slot/Wellhead Reference box allows the retrieval of a project’s coordinates;
this can only be changed at the Slot/Wellhead level by selecting the desired
slot/wellhead, and then right-clicking and selecting the Set as Reference option.
“Launch Google Earth”: This launches an instance of the Google Earth program loaded
with the current coordinates. If the Google Earth program is already running
separately, this button will send the program the current geodetic information.
Coordinates can be entered either by Grid coordinates or Lat/Long coordinates. Select
the option first and enter the values.
At the bottom, several more parameters are displayed which are relevant to the grid
system being utilized. They are not editable. Below, a brief description of what each
parameter is.





Convergence: The angle of difference in degrees between grid north and true
north. This is measured from True North to Grid North.
Scale Factor: The error associated with the map projection as a result of
approximating the surface of the earth as a plane instead of the curved surface it
actually is.
Projection Type: This is the type of mathematical projection system used.
Nearly all systems utilized are either Lambert or Transverse Mercator. Many
86

HawkEye

TM

User’s Manual

Copyright © 2017 by Performance Drilling Technology, Inc.




projections systems are used in cartography, but most legal systems around the
world involve at least a variation of one of the two mentioned systems.
Earth Radius: This is the radius from the earth’s equator to the center of the
earth.
Flattening: This is a mathematical constant representing the amount of flattening
the earth has as a result of its rotation. The earth is not completely spherical
mostly because of the fact that at the equator it is moving 1000 miles an hour and
the centrifugal force causes the earth to bulge at the equator.

The remaining parameters in the Target Adjuster can be changed by the drop-down
menu arrows in increments of 1, or values may be manually entered to any specificity
unless otherwise noted. Length units are either in feet or meters, depending on which
unit is chosen for the project.

CL-DIR: Direction from the surface location to the Target center
CLOSURE: Horizontal distance from the surface location to the target center
DIAMETER: Controls the total
width of the circular ends (of
cylinders only).

ROTATION (THICKNESS): This parameter does not apply to any shapes, but in its
place “Thickness” appears when a hardline or leaseline is selected.
THICKNESS: This controls the
amount of vertical space which the
target occupies. (Not applicable to
2D shapes.)
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SIDE A AND B: These two
parameters control the length of the
default x-axis and y-axis sides of a
non-circular shape. (Side B is not
applicable to 2D shapes.)

DIP/DIRECTION: This controls the
degrees in which the target is turned
from its geometric center (i.e. its
azimuth). Pictured is 0 and 45
degrees, with the target rotating
clockwise.
DIP/INCLINATION: This controls
the degree of tilt that the target
shape assumes. Pictured is 0 and 45
degrees, with the top of the target
tipping to the left.

DIR. OFFSET: This controls the
directional offset of the target, which
is the distance along the hole, up or
down. Pictured is 0 and -200, where
the target appears to drop in
elevation.
X OFFSET: This value, in units of
length, displaces the target off of its
defined location on the X-axis.
Pictured is the Top View and an X
Offset of 300.
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Y OFFSET: This value, in units of
length, displaces the target off of its
defined location on the Y-axis.
Pictured is the Top View and an Y
Offset of 300.

OPACITY: This controls the
translucency factor of the target,
ranging from 5-100.

COLOR: Although the entire palette
of colors is available for targets,
there may be discoloration
depending on the underlying texture
chosen for that target.
TEXTURE: A wide variety of default
textures are available for the targets.
In addition, user textures can be
selected from the file explorer on the
top left of the dialogue.
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3. Target List
The Target List is the comprehensive control center for all targets associated under a
slot/wellhead or platform/pad. It includes the Target Adjuster within it.

OPEN THE TARGET LIST: Access the Target List by right-clicking on
a target in either the Data Tree or the 3D space, then selecting “Target
List.” Or press “T” when the cursor is hovering over the 3D space.
Regardless of the target clicked on, the Target List will display data on
an entire slot/wellhead or entire platform/pad’s target array.

TARGETS ON: Choose either “Current Slot/Wellhead” or “Current Platform/Pad” to
select the range of targets to be displayed in the list below.
SORT BY: Organize all displayed targets by either “TVD” or “Closure Distance.”
SHOW TARGET ARRAY: This toggle will turn on the “Target Array” fields, which
allow the user to select any sequence of targets for multiple-target projection setups.
Such a setup can only be taken advantage of in the HawkEyeTM Command interface. See
the section on HawkEyeTM Command (Ch. IV. Section 4) for more details.
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PARAMETERS: Targets are defined in the List across 11 parameters, each of which can
be changed in this panel. The order of the columns is not changeable.

TARGET ADJUSTER: The Target List contains the Target Adjuster within it. As
described in the previous sub-section, simply click on the name of the target in the list
and its specifics will appear in the Target Adjuster panel above, where they can be
changed.

4. Target Array
The Target Array is used only in a specific projection sequence in which a number of
targets are hit with a series of tie-ins that are created simultaneously in the Proposal
mode. See the section on HawkEyeTM Command (Ch. IV. Section 4) for details.
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e. Target Planes
Although the Horizontal Projection will generate a target plane when you activate the
projection, you can also generate a target plane from scratch.
Do this by clicking on the Target Selector icon (large red and yellow target icon in the
main screen) and selecting “Add Target Plane.” This will bring up a Target Adjuster
dialogue where you can define the size, dip and direction of the target plane. The
default target plane is going to be at 3500 TVD and 0,0 local. To change the parameters,
right-click on the target plane in the Data Tree or 3D space and select “Adjust Target
Plane.”

To use a custom made target plane as the horizontal projection target, right-click on
your target plane either in the 3D space or the Data Tree and select “Set as Horizontal
Target Plane.”
The target plane created here is defined as through the parameters in the Target Plane
Adjuster dialogue. It will take on the texture that is found at that TVD from the
lithology of the platform/pad or slot/wellhead with which it is associated.
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CREATE A TARGET ON THE TARGET PLANE: You can create a target directly
centered on the plane by grabbing the blue “handle” that is located at the center of
every target plane. Simply drag the blue handle to the place on the plane where you
would like the target to be generated, then right-click on the handle and select “Save As
Permanent Target.”

To get the exact location you want before making this target, check your Handle
Coordinates which appear when you drag the handle around. The Handle Coordinates
are located on the top right inside the 3D window.
When a new target is created, the blue handle resets to the middle of the target plane for
future service.
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f. Geodetics (Surface Location)
Accurate mathematical positioning of a well site and the associated targets, lease lines,
hard lines and offset wells is extremely important in any drilling operation. With
directional drilling the need for accurate positioning is enhanced not only by concerns
for the drilling operation with regard to no-drill zones that are defined by hard lines,
but also legal concerns that are defined by lease lines. This is true all around the world,
of course, but in the U.S. where many wells are drilled to the benefit of many mineral
rights owners, this knowledge is even more vital.
Thus, it is important for drilling engineers, geologists and directional drillers to have a
functional understanding of the mapping system being employed for their well. The
following sections will briefly describe the systems most widely used, first in the U.S.
and second in the rest of the world. For anyone interested in expanding their
knowledge about geodetics in general, a few hours poking around on the internet can
lead to a very interesting learning experience. A good place to start is with
www.wikipedia.com.

1. Geodetics Systems Generally
STATE PLANES and the PLSS SYSTEM: If working in the U.S., then you will likely be
TM
working with one of the State Planes or Township-Ranges-Sections or both. HawkEye
does not have support for all states that use the PLSS system, but does fully support the
original western states that adopted the system. In some states like Louisiana,
Oklahoma and Florida, there are modified TRS systems being used, but available digital
TM
information can’t be immediately utilized by HawkEye because it is not in a standard
TM
format. Eventually PDT will convert these non-standard formats for use in HawkEye .
STATE PLANE COORDINATE SYSTEM
“The State Plane Coordinate System (SPS or SPCS) is a set of 124 geographic zones or
coordinate systems designed for specific regions of the United States. Each state
contains one or more state plane zones, the boundaries of which usually follow county
lines. There are 110 zones in the continental US, with 10 more in Alaska, 5 in Hawaii,
and one for Puerto Rico and US Virgin Islands. The system is widely used for
geographic data by state and local governments.
Its popularity is due to at least two factors. First, it uses a simple Cartesian coordinate
system to specify locations rather than a more complex spherical coordinate system (the
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geographic coordinate system of latitude and longitude). By thus ignoring the curvature
of the Earth, "plane surveying" methods can be used, speeding up and simplifying
calculations. Second, the system is highly accurate within each zone (error less than
1:10,000). Outside a specific state plane zone, accuracy rapidly declines, thus the system
is not useful for regional or national mapping.
“Most state plane zones are based on either a transverse Mercator projection or a
Lambert conformal conic projection. The choice between the two map projections is
based on the shape of the state and its zones. States that are long in the east-west
direction are typically divided into zones that are also long east-west. These zones use
the Lambert conformal conic projection, because it is good at maintaining accuracy
along an east-west axis. Zones that are long in the north-south direction use the
Transverse Mercator projection because it is better at maintaining accuracy along a
north-south axis. The panhandle of Alaska, whose maximum dimension is on a
diagonal, uses an Oblique Mercator projection, which minimizes the combined error in
the X and Y directions.”3
The figure to the left illustrates an eight-state
region showing the NAD27 and NAD83 zones for
the SPSC. The dashed lines are county lines. The
dark orange lines within the states are the NAD27
zone lines and the light orange lines are the
NAD83 zone lines. In this example, only New
Mexico has any changes between the two datums.
(NAD27 and NAD83) Within each of these zones
there is assigned a specific projection method,
along with specific references from which grid
coordinates are measured.

One common problem in well planning is knowing which zone a surface location is in.
Of course the operators should already have recorded this, but more often than not it is
not recorded in any immediate records, so it is left up to the well planners or directional
drillers to figure it out for themselves.
TM

HawkEye makes this very easy; all you need know is what county your surface
location is located in, something that is commonly recorded in many records.

3

From Wikipedia.com
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PLSS (Public Land Survey System) SYSTEM
“The [PLSS] system was created by the Land Ordinance of 1785. It has been expanded
and slightly modified by Letters of Instruction and Manuals of Instruction, issued by
the General Land Office and the Bureau of Land Management and continues in use in
most of the states west of Pennsylvania, south to Florida, Alabama, and Mississippi,
west to the Pacific Ocean, and north into the Arctic in Alaska.”4
States with complete BLM (Bureau of
Land Management) coverage
Alaska, Arizona, California, Colorado,
Idaho, Montana, Nevada, New Mexico,
Oregon, Utah, Washington, Wyoming
States with limited BLM coverage
Alabama, Arkansas, Florida, Illinois,
Indiana, Kansas, Michigan, Minnesota,
Mississippi, Missouri, North Dakota
(central and western portions are
covered), Ohio, Oklahoma, South
Dakota (western part is covered).

Map shows the PLSS coverage in the US
(from Wikipedia).

This mapping system was designed to help map out the unchartered territories in a
general mathematical way. Numerous meridians were established that are the origins
from which Townships and Ranges are measured. They are the black cross hairs seen
on the above map. The map is divided up, as a general rule, into 36 one mile square
blocks referred to as Townships (not shown) and each square mile is referred to as a
Section. Sections are commonly divided into quarter sections and quarter-quarter
sections and so on. Now, if you have been involved with surveying for long it
shouldn’t be much of a surprise to find out that there are exceptions to the 36 square
mile rule. There are lots of exceptions, in fact. The boundaries of townships that butt
up to a river or a state border are truncated. Sections, in some rare cases, can actually
have the same number in the numerical reference system, but not be connected. Let’s
not stop with the confusion there. The coordinate that measures North or South of the
meridian reference line is called Township and the east-west coordinate is called Range.
So, a Township’s location nomenclature is defined by a (Township, Range) coordinate
which seems a bit confusing, but only because two different things are being called by
the same name.
4

From Wikipedia.com
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Geodetics in the Rest of the World
Different countries employ different systems and datums depending upon the
particular history of the given country. Each surface location should specify either grid
coordinates, and the associated zone, or the geographic latitudes and longitudes down
TM
to the 5th or 6th decimal place in seconds. HawkEye can accommodate most systems
used in the oil industry.
Generally, by selecting the Group, System Zone and datum, one can set up the grid
mapping system for most places in the world where the oil field operates. The most
common mapping system used in the world is the Universal Trans Mercator, or UTM.
TM
HawkEye divides this system into two groups, the Northern Hemisphere and the
Southern Hemisphere. The diagram below illustrates how the UTM overlays the world.

“The Universal Transverse
Mercator (UTM)
coordinate system is a
grid-based method of
specifying locations on the
surface of the Earth that is
a practical application of a
2-dimensional Cartesian
coordinate system. It is a
horizontal position
representation, i.e. it is used to identify locations on the earth independently of vertical
position, but differs from the traditional method of latitude and longitude in several
respects.
“The UTM system is not a single map projection. The system instead employs a series of
sixty zones, each of which is based on a specifically defined secant transverse Mercator
projection.”
HawkEye’s ability to display a map with Google Earth or Google Maps is a useful tool
for many reasons, but one of the most important reasons is that if an input is incorrect
such as a positive longitude instead of a negative longitude it will be pretty obvious if
the map puts you in the middle of China instead of the US.
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2. Geodetics in HawkEye

GETTING TO THE PROJECT GEODETICS:
TM
Geodetics in HawkEye is handled from two different
perspectives, for projects and for individual
slot/wellheads. The main geodetics dialogue for
projects can be accessed in three places:
1) By setting up the geodetics through the
Project Wizard, or
2) At any time by right-clicking on the project in the Data Tree and selecting “Set
GeoDetics,” or
3) By clicking on the Project Control Panel, then clicking the “Edit Project”
button at the top, or
4) Clicking the “Edit” tab and selecting “Geodetics” on the far right
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SLOT/WELLHEAD GEODETICS
The other perspective of geodetics in HawkEye is by slot/wellhead. To access a
slot/wellhead’s geodetics, be sure to have a well currently selected under that
slot/wellhead, and then click the Slot/Wellhead Editor button at the top of the screen.
This opens up the Slot/Wellhead Information dialogue (which can also be opened by
right-clicking on the desired slot/wellhead
in the Data Tree and selecting “Edit
Slot/Wellhead Data”). The Slot/Wellhead Editor is used to re-name a slot, as well as
specify location data.
LAUNCH GEOHAWK: The purple button at the bottom of the Slot/Wellhead Editor
launches GeoHAWK, which is almost exactly like the Geodetics dialogue except that
the Group, System Zone, Datum and State/County cannot be edited. It is used to allow
slot/wellhead location data to be tied in with the Google Earth interface.

CHOOSING A GROUP, OR NOT: When a
new project is started with the Project Wizard,
the user is prompted to set geodetics. At the
very top left of the Geodetics box, the dropdown menu allows this. However, if the user
does not yet have the geodetics data, the choice
“None” can be selected. This will eliminate the
display of the Easting/Northing and the
Lat/Long fields in the Slot/Wellhead Editor
dialogue, thereby making location interaction
simpler, at least until the geodetics can be
entered for the project later.
DON’T SWITCH IT UP: Since each of these above-mentioned groups has different sets
of valid locations, switching between groups is not recommended. Conflicting
coordinates as paired with invalid groups will likely crash HawkEye and you may lose
all unsaved project data. Best bet is to put the geodetics information in right the first
time.

99
HawkEye

TM

User’s Manual

Copyright © 2017 by Performance Drilling Technology, Inc.

SET STATE AND COUNTY: One
powerful method available to help
accelerate determining what the proper
State Plane to use is the State/County->
Set tool. The control box is located in the
upper central part of the Geodetics dialog.
To use this, select the State and County
where the rig site is located.
Then, be sure to click the “Set” button after selecting the desired county. You will note
that the program has now automatically selected the proper State Plane and System
Zone associated with that county.The coordinates that have been automatically entered
for the Lats and Longs and Northings and Eastings are the default values for that
county, normally the center of the county.
CHOOSE INPUT: You should select the radio button for either the INPUT GRID or
INPUT Lat/Long and enter in the associated site values. The program will determine all
corresponding numbers and if you are connected to the internet Google Maps and
Google Earth will display the location in the Map tab to the right of the screen.
LAUNCH GOOGLE EARTH: Click the “Launch Google Earth” button to start the
Google Earth program. HawkEye will load the current project’s information into
Google Earth so that curves and lease/hard lines can been seen superimposed over
Google’s satellite imagery.
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3. Google Earth Support
HawkEyeTM can superimpose the 3D curves of a project onto a Google Earth. Make sure
to have the Google Earth program installed. Find the link to download the program for
free at http://earth.google.com.
The Google Earth module will do two principle things. First, it will illustrate over a
satellite image of the planet’s surface any geodetically section information defined in a
project. This boundary is illustrated with a green line and offset with a white line:
The second function of the module is to illustrate the scope and location of a project visà-vis its location in a zone. The project information that is displayed on the surface map
appears to sit aboveground, although obviously any well would be underground.

The Google Earth module requires that Google
Earth be installed. It will also require a live
internet connection to run. Download the program
for free at http://earth.google.com

One major setting to keep in mind is the 2D and 3D Curves toggle, found in the bottom
left options tree.
By turning on both 2D and 3D Curves, the image will display not only the image of the
well with the bottom touching the surface and extending to the sky, but also a line of
where the curve travels with respect to the surface.
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3. Editing Non-Critical Info
a. Hard Lines and Lease Lines
Hard lines are boundaries beyond which one does not wish to drill, a no-go zone. Lease
lines are legal boundaries that often have to be visually incorporated into a well plan to
illustrate how far the well is from the lease line or its offset line. For all practical
purposes, HawkEyeTM treats the creation of both lines almost identically for most
practical purposes.
Add a lease or hard line by first clicking on the option in the “Edit” tab…

Or right-click on any Project
or Structure/Pad
Tree and select the option at the bottom.

in the Data

You will need to name the lease/hard line. Then find it in the
Data Tree, right-click and select “Edit Lease/Hard Line
Coordinates.”
TWO WAYS TO DEFINE LEASE/HARD LINES:
1) IMPORT THE SPREADSHEET OR TEXT: Lease line
boundaries can be very complex. The data for building them normally comes
from data a survey company the operator has utilized to specify the surface
location of a well. If you can obtain a spreadsheet with the coordinates of the
points specified in any one of several styles, you can cut and paste the data into
the spreadsheet editor used to input hard/lease line data. This is by far the
easiest and best way to input this kind of data because it is very quick and it
reduces the likelihood of input errors that can be confounding with a long list
of lease line coordinates.
The next best method to utilize is importing a delimited text file that has the data
arranged in lines with the values separated by commas, tabs, or spaces. This
process involves more steps than the first method but has the advantage of
reducing input errors, same as the first method.
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The first step is to copy the data from the spreadsheet or text. The data usually
comes in one of several common formats: Local Coordinates, Grid Coordinates,
Direction-Distance or DMS-Distance.
This will open up the Lease Line or Hard Line editor. Right-click in the table
section on the bottom half of the editor and you will be given a number of
choices on how to paste the data. NOTE: How you paste the data here needs to
match how the data was oriented in the original spreadsheet or text file.
The first seven options when pasting in hard/lease line data
are composed of two columns. The last option, DMSDistance, is a five-column format. Choose the method of
pasting and the data will import and get calculated. Each of
the numbers are editable once entered in this fashion.

ADJUST THE LINE: There are two aspects to any hard/lease
line: its coordinates and its 3D display properties. To edit a
hard/lease line, right-click on the line in the Data Tree and
select “Edit Hard Line” or “Edit Lease Line.”

SEE THE LINE IN 3D: To see the lease/hard line in the 3D space
as more than just 2D lines, right-click on the lease/hard line in the
Data Tree and select “Edit Lease/Hard Line Coordinates.” In the
form that opens, you will find the 3D view options for that line.

2) ENTER COORDS MANUALLY: If you do not have access to a spreadsheet or
text file with the data and you have a lot of points, you can enter each of the
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coordinates manually. If you only have a few points to enter, then using
HawkEye’s editor to input the values is not a problem.
The following screenshot shows the Lease Line Editor open, and the lease line
displayed in the 2D space with a 500 ft internal offset represented by the dotted
line.
Note that there are five different Input Modes, which are also
the coordinate display modes:

Next to the Input Mode box is the Boundary offset box. Internal and external offsets
can be set by entering the distance and then selecting the radio button for what you
want (Inner or Outer). HawkEyeTM will calculate the line and display it. The ‘Close
Line’ option is for when the last point is automatically set to the first point, so that a
closed lease line can be more easily input. The 3D View box has options on how to
display the line in the 3D space.
In the example shown the data was automatically generated by HawkEyeTM from a PLSS
Township, Range, Section definition.
To enter data manually it is usually best to count the number of points you will be
entering and the use the “Add Point” button that many times, creating a blank
spreadsheet in the Editor that has all the space you will need.
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Next, decide what Input Mode you will be using. If it is Local Coordinates, Grid
Coordinates or Longitude, Latitude coordinates all you need do is enter each pair of
coordinates, either line by line or by going down each column and entering all the EW
coordinates, for example, and then proceeding to the next column and filling in all the
NS coordinates.

ANCHOR POINT: If you are inputting coordinates in Direction-Distance, the most
important thing to remember is to FIRST, input the starting Xpoint, Ypoint. This is the
“anchor” point, and is labeled line “0” in the coordinates table. From that point on you
will only need to enter the direction and the distance.
HARDLINE INNER AND OUTER OFFSETS: Mostly everything that is true for Lease
Lines is true for Hard Lines. With Hard Lines you can also have offsets if you so desire.
(The “Outer” offset may appear as an inner offset. This is not rendering incorrectly, it is
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just that the coordinates were put in clockwise. There is no computational error here.
Just pick the offset that matches the one you are looking for).
MULTIPLE HARD LINE PASTING: However, with the spreadsheet cut and paste
option with Hard Lines, there is an option you are presented with when pasting the
data to the grid which allows a list of independent hard lines to be added
simultaneously. In this mode, each successive pair of points constitutes a single line.
HawkEyeTM will automatically generate a Hard Line definition for each pair of points.
You can then edit them independently for color, names and offsets by editing their
target parameters if you so choose. When you paste in the data, HawkEyeTM will prompt
you for this option.
EDITING THE LINE’S
APPEARANCE: Aside from the
coordinates, a hard line or lease line
can be edited for appearance. The
“Target Adjuster” portion of the
Editor form controls this aspect of
the line. The greyed-out fields are
not editable.

Editable parameters include:







Name
Depth (if “Fixed TVD” is selected)
Thickness – This refers to the offset, which is either inside or outside the line,
depending on if you choose “Mode A” or “Mode B” under the Boundary box.
Height- This appears in the 3D space
Directional Offset- a depth offset
Opacity
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b. Lithology
Lithology in HawkEyeTM is a tool that allows the
user to enter known geological data as it relates
to the range of the well. The lithology data,
graphically represented by colored patterns,
appears in the 3D space as well as in the plots
and reports if desired. The lithology datasets can
either be metaphorical graphical representations
or geological snapshots and cross-sections of
actual field seismographs (“picture” lithology) if
such data is available.

Displaying the data in the 3D space
allows for important visualization of
the known material types in
proximity to a well.

OPENING THE LITHOLOGY EDITOR:
1) Click on the Lithology icon at the top of “Edit” tab.

2) RIGHT-CLICK anywhere in the background of the 3D space or on a curve and select
“Lithology.” Also notice that in this menu is the “Show/Hide Lithology” option just
below the Editor.
TURNING LITHOLOGY ON AND OFF:
1) Check or uncheck the “Show” button under the Lithology icon in the “Edit” tab
(pictured above).
2) RIGHT-CLICK anywhere in the background of the 3D space
and select “Show Lithology” or “Hide Lithology,” depending
on if it’s already on or off.
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LITHOLOGY TEXTURES
The function of the Wellpath Lithology editor hinges on lithology layers
chosen by drop-down menus. Each new layer will have a material type to
TM
be assigned to it. HawkEye provides a number of materials to choose
from:

NOTE: Any of these patterns can be replaced with custom pattern files by
clicking on “Edit Patterns” in the top left of the Wellpath Lithology panel.
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LITHOLOGY CONTROLS: At the top of the Wellpath Lithology panel there are a
number of functions:

ADD LAYER and CLEAR LAYER: This may be the first place to go when using
lithology, where each layer can be added manually or cleared entirely. Each new layer
is by default Euclidian and given a depth of 200 ft/m.
EDIT PATTERNS: All of the lithology materials from the layer’s drop-down menu
have particulars pattern associated with them. But they are easily changed out with
user-provided pattern files in the Edit Pattern dialogue. The pattern family is
TM
HawkEye by default but can be switched to the Compass family or customized by
group or individually here.
COPY LITHOLOGY TO PLATFORM/PAD: Any given set of lithology data is
associated with the select curve, so it must be actively attached or associated with a
platform/pad. This button will take the curve’s lithology data as currently displayed
and copy it to the platform/pad under which the curve is associated.
GET LITHOLOGY FROM PLATFORM/PAD: This button will retrieve the lithology
information from the platform/pad and apply it to the current curve. NOTE: There must
be a lithology data set copied to the platform/pad first.
(E.g. If a lithology is set up with a proposal curve, it is not automatically going to
display when the as-drilled work curve is being followed. To share the lithology
between the two, “copy lithology to platform/pad” when it’s being displayed along
with the proposal curve, then follow the work curve and click the “Get Lithology From
Platform/pad” button.)
DEPTH TYPE: It is important to know the method in which the depth for each lithology
layer is defined. Subsea depths start from sea level and go down. TVD depth type
includes the RKB and the elevation.
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DYNAMICALLY POSITION and LITHOLOGY DIRECTION: Either one or the other
of these can be selected at a time. These affect the direction the lithology plane is
pointed. With Dynamic positioning turned on the direction is affected by the direction
at the current focus point. If the formation has a dip, and there is a significant change in
direction such as in a turn zone then the lithology plane will be recalculated after the
scroll wheel as stopped moving. If Dynamic Positioning is turned off then the lithology
points in the direction specified by the Lithology Direction input.
TRANSLUCENCY: Control the translucency of the currently displayed lithology set.
The range is from 0 to 100.
SPLIT LITHOLOGY: This will create two copies of the lithology layer in the 3D space
and they will “sandwich” the current look-at point. Use the slide control to move how
far away the duplicate layers are from the point of interest. This feature is useful for
creating a valley effect in which the well can be referenced against the lithology data
from more angles.

SHOW EUCLIDIAN LITHOLOGY (DEFAULT): This allows the lithology to be
defined by the basic input list be displayed. Sometimes when using a ‘real’ lithology it
is not desirable to show both the Euclidian and real lithologies.
SHOW DESCRIPTIONS: Descriptions are entered
in the layer editing segment under the Euclidian
Lithology tab. When “Show Descriptions” is
selected, a small text box will appear in the 3D
space inside of the lithology’s plane on the bottom
left corner.
BUILD LITHOLOGY UPWARD: The lithology picture is built by default from the top
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down. If all dips are the same for all the lithologies then the algorithm for the order in
which layers are drawn is irrelevant. However, if the dips are non-zero and some are
greater than others then the order can be potentially important. This is not a really
important feature, but it could possibly turn useful.
HORIZONTAL DISPLACEMENT: This slider controls the horizontal span of the entire
lithology display in 3D space. It will crunch or stretch the patterns along the horizontal
plane. The range is from roughly 1,000 to 25,000 feet.

EUCLIDIAN LITHOLOGY (DEFAULT): Once the Wellpath Lithology panel is open,
simply click “Add Layer” on the top left to begin adding lithology data to the project.
Each layer will be blank and have a number of drop-down menu or text field to define
the layer. Click on each box to edit it.

TYPE: Euclidian or Real. Euclidean is the default type that is displayed, and it is
characterized by its straight horizontal borders dividing each layer. “Real” lithology is
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characterized by its irregular border between layers, the undulating thickness which is a
more realistic representation of the geology.
NAME and DESCRIPTION: The Name, as of now, is not really used in reports or
output, but the Description is used. It is used in the presentation plots and also as a
description for interpolated comments
TM

TOP DEPTH and BOTTOM DEPTH: Directly enter the depth of the layer. HawkEye
will not have the layers overlap and will give notice if there is a depth conflict. Each
new layer is given a default depth of 200 (ft/m) from the last layer.

LITHOLOGY: Choose from the drop-down menu what type of material the layer
represents. The list is comprehensive and should encompass most types encountered in
the field.
DIP-ANGLE and DIP DIRECTION: Number fields here define the dip of the particular
lithology plane.
PICTURE LITHOLOGY: The Picture Lithology tab will allow the user to utilize any
available seismographic imagery for use in place of the colored lithology patterns
provided. NOTE: These slices of 3D seismographic data are not always available from
the company in charge of geological survey and assessment.

Click “Browse” to select the bitmap. Be sure to check the “Show Picture Lithology” box
to display the custom picture, and define the picture loaded by TVD, Direction, Width
and Height in the provided fields. Define the lithology here by one of three modes,
selected with each of the respective radio buttons: Lat-Long, Local EWNS, or by
Geodetic Grid.
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DEFINE CASING BY THE LITHOLOGY: See more in the next section on casing on
how to place casing automatically for where a proposal curve crosses a lithology
boundary.
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HOW TO SET A DEFAULT LITHOLOGY
If you make a target plane (e.g. right-click on any curve and select “Create
Target Plane”) for any given reason and you don’t have the lithology set for
that TVD, the program will give you this for a texture:

Since this is not a convincing or appealing texture, you may want to set a
default other than “Not Available.” Here’s how:
1) Open up the Lithology module.
2) Click on “Edit Textures” at the top left.
3) Scroll down to the texture titled “Default.”

4) Double-click on the “N/A” texture.
5) Choose your new default texture.
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b. Casing
TM

Adding casing in HawkEye is a process similar to adding lithology. It is done layer by
layer and each entry can be customized. To get to the Casing Editor, click on the casing
icon in the “Edit” tab.
The Casing Editor will allow the appending of
casing information to the selected curve. The first
step is to click the “Add Casing” button. This will
add a casing entry to the selected curve, wherein
all the vital information can be entered in any
order.

The size is defined from a lookup menu of
different casing sizes. The selected size will
determine the choices for the weight of each
casing. The sizes available are as follows:

Casing is added layer by layer in
the Casing Editor. Each casing
entry is customizable and
commentable.

List of Casing Sizes
11 /
13 ½

10 ¾

11 ¾

14

24 ½

13 3/8
4½

16

20

5½

18 5/8
6

6 5/8

7

7¾

7 5 /8

8 5/8

9¾

9 5/8

Riser

7 8

5

OPEN THE CASING EDITOR:
1) Click the Casing icon under the “Edit” tab.
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2) Right-click on specific curve in the 3D space, Data Tree or on the “Curve Menu”
button and select “Casing.”
CASING IN SI (METRIC): Casing sizes and weights can be entered in metric units.
The units for casing are set at the project level. To get to that setting, right-click on a
Project in the Data Tree and select “Edit Project,” then select “SI” for casing.
SET DEPTH ERROR:
The Casing Editor will give a
“Set Depth Error” if the user tries to add casing with a
set depth greater than the maximum MD.

Aside from casing size and weight, which are selected from drop-down menus, other
parameters are defined manually.
ID/OD: Internal and Outer Diameter in inches.
TOP MD: This number defines the beginning of the casing from the top down along the
wellpath.
SET MD: This is measured depth or TVD to which the casing is run.
COMMENT and COLOR: Click on the Comment field to add any relevant notation to
be associated with the casing. The color field opens to a palette when clicked on.
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DEFINE CASING BY THE
LITHOLOGY: Casing can be defined in
the Lithology editor5. To do this, rightclick on a proposal curve and select
“Lithology.” A lithology dialogue will
open, but it will be specifically
associated with the current proposal
curve. You will see the name of the
proposal curve in the title bar of the
Lithology editor.
Once inside the Lithology editor, you will notice two additional columns on the right
side of the normal spread of parameters. These columns are where you can add casing
that starts and ends with respect to wherever the lithology boundaries are.
The two columns are the Casing Size/Weight, wherein the casing can be defined, and
the Casing Offset, where the casing tops can be defined as not having to start exactly at
the layer borders.

When casing is defined here in the Lithology Editor, the casing will appear in the
normal Casing Editor.

5

For proposal curves only, since a work curve will not usually have casing defined by lithology
boundaries, despite the best plans of mice and men.
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COPYING TO PLATFORM/PAD: When you add casing in the lithology editor, and
then click “Copy Lithology to Platform/Pad,” it will also copy the added casing. To
prevent this, you must delete all casing entries by selecting “none” for the Size/Weight
and “0” for Offset before copying to the platform/pad.
DOES NOT WORK ON SIDETRACKS: Adding casing through the Lithology Editor
will not work on sidetrack proposals since they do not start at 0 TVD.
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c. Comments and Annotations
1. COMMENTS
ADD COMMENTS: Comments are generated in HawkEye at any given survey, either
in the Work Mode or Proposal Mode. They can be entered manually at the survey by
typing in the comment in the List Panel below in the space for comments.

AUTO-GENERATE COMMENTS: Comments may be
generated automatically for proposal curves by right-clicking
on the desired curve for comment in the Data Tree, and
selecting “Auto Comments For This Curve.”6 This will create a
comment at each critical point in the proposal (e.g. KOP, Begin
Build, Begin Turn, PBHL). You cannot generate autocomments for a work curve since each survey would be
considered a critical point due to its irregular, non-geometrical
nature.
You may also Auto-generate comments by clicking on the
option under the “General” tab. Here you can clear all
comments for current curve as well.

When a comment is created,
it will appear in the 3D space
at the point on the curve on
which it was created, marked
by a green sphere.

DELETE A COMMENT: To delete a comment, erase the text from the Survey List Panel
at the bottom of the main screen (the field in black as pictured above). Or to delete ALL
the comments of a curve, go into the curve’s menu and select “Clear Comments.”

6

Auto-generating comments for a curve will erase all previous comments for that curve, including ones
you may have added manually.
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2. ANNOTATIONS
Annotations are slightly different from comments in that they can only be generated
manually. In other words, there is no way to auto-generate annotations. Think of them
as personalized notes outside the bounds of what is to be included in a plot or report.
ADD ANNOTATION: To add an annotation
to a curve, go to that curve’s menu and select
“Add Annotation.”
You can also add an annotation for a specific point by clicking the button “Create
Annotation” under the “General” tab.

The Enter Annotation box has a number of options,
including choosing the exact depth and type of
depth at which the annotation will appear along
the curve, as well as the font and color of the
annotation.

DELETE AN ANNOTATION: The only way to delete an annotation
is to right-click on the blue sphere where it resides on the curve, then
select “Delete.”
NOTE: Sometimes it is tricky to get the right-click menu to come up for the annotation,
and may require adjusting the point of view and zoom in order to nail the sweet spot on
the blue sphere.
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d. Survey Tool Manager (Error Models)

The Survey Tool Manager is an interface for importing or exporting advanced error
modeling files. These files are usually provided by engineers who are familiar with the
schema and are generally not tweaked from within HawkEye, although they may if the
user is knowledgeable and comfortable with the parameters.
OPENING THE MANAGER: The Survey Tool Manager is found in the “Special Tools”
tab at the top of the screen.
NOTE: It is not recommended to change or alter the tool profiles in the Survey Tool
Manager unless you understand the various parameters. Since the error models are
highly mathematical and settings dependent on one another, simple mistakes could
render the error model that you are using unusable or worse.

On the lefthand side of the Survey Tools Manager is a tree-style list of the different
models being implemented. Along the top are the fields displaying:
 Vendor (dropdown list)
 Short Name
 Description
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IMPORT/EXPORT: The Survey Tool Manager works with the industry standard .ipm
files, which may be imported or exported.
DEFAULT SURVEY TYPE: Choose from Magnetic, Gyro, or unknown.
TEMPLATE: Choose from a dropdown list of available .ipm files to load an ISCWSA
template.
LOCK/DEFAULT: Check either of these buttons to lock in the current template
selection and to make the selection your default, respectively.
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e. ISCWSA Error Calculating
RECALCULATE ERROR MODEL: One click of the ISCWSA icon at far left of the
“Special Tools” tab will automatically recalculate the error model for the project. These
corrections are based on a comprehensive compilation of error models authored by a
committee of engineers, scientists and mathematicians from around the world.

The following is excerpted from the Industry Steering Committee on Wellbore Survey Accuracy
website (www.ISCWSA.org):

“
The primary aim of this group is to produce and maintain standards for
the industry relating to wellbore survey accuracy.




To set standards for terminology and accuracy specifications.
Establish a standard framework for modeling and validation of tool
performance.
Raise awareness & understanding of wellbore survey accuracy
issues across the industry.

The Industry Steering Committee on Wellbore Survey Accuracy
(ISCWSA) is seeking to dispel the confusion and secrecy currently
associated with wellbore surveying and to enable the industry to produce
consistent, reliable estimates of survey-tool performance in today's wells.
This will be achieved through the production and maintenance of
standards covering the construction and validation of tool error models.
Work focused initially on MWD systems. They provide a large proportion
of the total directional survey data world-wide and, because of their
similarities between suppliers, are more amenable to specification
standardization than other types of survey tool.

”
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III.

PROJECTIONS in the FIELD MODE

TWO MODES: There are two overall modes in
HawkEye. The Field Mode is default and available
in both versions. It is used for directional drillers
who are not creating much in the way of complex
proposals or well plans. Whereas the Well
Planning Mode, available only in the Well
Planning version of HawkEye™, is used to created
complex well plans.

1. What You Need to Know
HawkEye’s Field Mode offers eight types of projections that can be used by directional
drillers as well as well planners. They are:
 Sensor-to-Bit
 Measured Depth (Straight Line)
 Total Vertical Depth (Straight Line)
 Nudge
 Multi-Nudge
 Horizontal
 Slant
 Aligned
 Back on Track (BOT)
MODES: FIELD v. WELL PLANNING
The principle difference to keep in mind between the Field Mode and Well Planning
Mode is that, although they both have the same arsenal of projections which can be
appended end to end, only in the Well Planning Mode can a projection be edited at
any segment.
In other words, in the Field Mode, only the last appended projection can be edited,
so that in order to edit a part further up the curve, the user must delete all
appended parts of the curve made subsequent to that higher up part before editing
it. In the Well Planning Mode, all parts of the curve are editable at all times.
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Each of these projections can be quickly generated and edited from the main screen by
clicking on the corresponding icon:

These can be broken down into two broad categories of projections. The “Targetless”
projections can be created from any point on a curve without having to select a target.
“Targeted” projections, on the other hand, require a target toward which a projection is
created.
TWO GENERAL FAMILIES OF PROJECTIONS
TARGETLESS PROJECTIONS:
 MD & TVD Projections- Hold a particular inclination and azimuth and go in a
straight path for a certain user-defined distance.


Nudge and Multi-Nudge Projections- Mimics minimum curvature
calculations but allows for the nudging of a variety of different parameters.



Bit or Compound Projections- Allows a projection to be strung to a bit from
where your survey position is. From there you can append other kinds of
projections to the end.

TARGETED PROJECTIONS:
 Slant Projections- a.k.a. DLS projections, Build-and-Hold Projections. Can
solve for a hold angle by providing a dogleg severity or solve for dogleg
severity by providing a hold angle.


Aligned Projections- Set two dogleg severities, as well as desired inclination
and azimuth at target.



Back-on-Track (BOT) Projections- Set two dogleg severities and a minimum
distance in order to intersect your proposal.



Horizontal Projection- Will project to a horizontal plane, which is considered a
2D target. Horizontal plane is defined by an RKBTVD, a max dip angle and a
max dip direction.
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CREATING A NEW CURVE: To create a projection from scratch, RIGHT-CLICK on
the slot/wellhead ( ) in which the new curve is to be created and select “Add New
Well Path.” This will open up the “Add New Curve” dialogue under that slot/wellhead.

When defining a new curve in this dialogue, there are a few major data points to be
filled in:
1. Curve Name
2. Job Name: this is a drop-down menu displaying all existing jobs in the database.
The “Job” button opens the “Job Information” dialogue which both displays
detailed information about existing jobs and allows for the creation of new jobs.
3. Survey Type: Choose either “PROPOSAL” or “SURVEY” from the drop-down
menu. Proposal curves will appear under the current slot/wellhead with this
icon: . Survey curves will appear with this icon: .
4. Unit and Color: Choose between feet or meters, as well as the color of the curve.
The color can be easily changed later when right-clicking on the curve in the
Data Tree, 3D space or Project Control Panel.
5. RKB: This is the Rotary Kelly Bushing Elevation above the datum, either the
ground or mean sea level.
6. Tie In Point- These fields will define a specific tie in point for the new curve.
Otherwise, the curve will begin from the slot/wellhead’s platform/pad at the
surface location.
7. Referenced Slot/Wellhead Coordinate: This field will define (or redefine if it
already has been defined) the exact surface location of the current slot/wellhead
under which this curve is being created.
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a. Work Mode vs. Proposal Mode
The most important thing to understand when in HawkEye’s 3D space is that there are
two modes for building and navigating between your curves: the Work Mode and the
Proposal Mode. You can toggle between the two modes by clicking the W/P icon in the
“Home” tab:

WORK MODE: The primary difference between the two modes is that the
Work Mode will allow you to follow along the currently selected Work Curve.7
Also, when you make a projection, it is automatically starts from the end of the
work curve, but will not stay there unless you append it.
See more on appending projections to your curve in the following section.
PROPOSAL MODE: In the Proposal Mode, you are able to follow the Proposal
Curve.8 When you make projections in the Field Mode, your new one will
replace whichever projection was active previously.
There are exceptions to this, however. You can build up proposal curves projection by
projection with the following two methods: 1) Append to Curve- after a projection has
been generated, click on the “Append” button at the right-hand end of the row of
projections, 2) HawkEye Command- type in a direct alphanumeric command that
instantly generates and appends the projection (see section under Special Tools
chapter).
NO BIT PROJECTION IN PROPOSAL MODE: You will notice that the Bit Projection
(Bit to Sensor Projection) is not available in the Proposal Mode. This is because the Bit
Projection is assumed to only be used only with the Work Curve. It adds a certain
length of measured depth at the end of any projection in order to simulate the course
length to the bit not yet reached by the sensor.
Set any survey curve in your Data Tree as the “Work Curve” by right-clicking on it and
selecting “Set as Work Curve.”
8
Set any proposal curve in your Data Tree as the “Proposal Curve” by right-clicking on it and
selecting “Set as Proposal Curve.”
7
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b. Appending Projections to Curve
The Append function allows the user to append a projection to the end of the current
curve, either in the Work Mode or Proposal Mode. This will be needed frequently for
any user who needs to make a projection with minimal complication. Fortunately, the
process is intuitive and simple.
Step 1- Select your curve: Make sure you are focused on the curve that you want to
append to. Typically this is a proposal curve, since the only way you want to add to a
work curve is by actual surveys. When you find the proposal curve you want to append
to, right-click on it and select “Set as Proposal Curve.”
Step 2- Create a Projection: Select the projection that you want to append and play
around with the parameters to make sure it is what you want. (See next section on
details of each projection).
Step 3- Click “Append”: When you click the Append button (in the “Home” tab), your
currently displayed projection will become a part of the current curve.

GENERATING COMMENTS: Comments can be added to surveys either manually or
automatically. To do so manually, go to the bottom right of the main screen in the
survey window and add comments at all the various critical points like the kick-off
point and the hold angle, etc.
But to generate these comments
automatically, RIGHT-CLICK on the
well and select “Auto Comments For
This Curve.” The critical points
comments will appear in the comments
section on the bottom right.
NOTE: You can only auto-generate
comments for proposal curves.
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2. Creating a Projection in Field Mode
APPEND TO BUILD: It is worth repeating here that you can append each of these
projections permanently to the end of either your Work Curve or Proposal Curve by
using the Append button, described in the preceding section.

a. MD & TVD Projections
Measured Depth and Total Vertical Depth projections are
of the simplest kind of projections available. They simply
add a straight extension for a given distance, holding for
the existing inclination and azimuth.
The only difference between the two projections is the type
of depth measurement used, with either measured depth
or total vertical depth. The mechanics of the projection
calculations are identical.
MAKE THE PROJECTION: To make the projection, just
enter an Added Depth to add how much from the endpoint
you wish to progress in a straight line. OR put in a Total
depth value and HawkEyeTM will figure out how much
added is required.
Clicking “Turn On Projection” will trigger the calculations
and activate the projection in the 3D space. You can also hit
the TAB button after entering a value to get HawkEyeTM to
recalculate a parameter.

MD and TVD
projections simply add a
certain amount of
straight distance from a
point, holding the
existing inclination and
azimuth.
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b. Nudge Projections
The Nudge projection is the best way to nudge a curve and may be the first kind of
projection used when setting about to making a proposal curve. It is also useful for
predicting how the motor and rotary steering system will behave by setting up the
known parameters. Seeing this projection rendered in 3D space helps to visualize a job
with the information already in hand.
Once Driller’s View is set and Sights toggled off, you can
select the Nudge tool from the row of projections and open
up the dialogue. There are three solve modes, each allowing
for the entry of up to three parameters at a time out of six:
 Delta (change) Measured Depth
 DogLeg Severity
 Tool Face Orientation
 Inclination
 Azimuth
 Total Vertical Depth
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c. Multi-Nudge Projections
NOTE: Multi-Nudge projections are only available in the Work Mode. If
you activate the Multi-Nudge while in Proposal Mode, it will start the
projection from the end of your Current Work Curve anyway.
The Multi-Nudge allows users to string
together an unlimited number of nudge
projections end to end. Each segment is
organized from the top down, and new
segments can be added by either
tabbing to a new row below, or clicking
the “Add” button.
Turn on the projection with the
checkbox on the top left of the form.
The segments (each individual nudge
projection) are color coded and the row
in the form matches the 3D projection.
Unlike other projections, these colors
are not customizable. They are Green,
Red, Blue.
After the first three segments, the color
sequence begins again.
Just like in the Nudge Projection, there
are different solve modes. The user can
do one of several things for each
segment:


DMD/DLS/TFO- You can input Delta MD, DogLeg Severity and ToolFace
Orientation, but not the other parameters



INC/AZM/DLS- You can put in Inclination, Azimuth and DogLeg



DMD- This simply adds the length you specify, with no build or turn



HOLDTODMD- this will extend the projection to the Measured Depth that you
specify
131
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d. Bit or Compound Projections
NOTE: BIT projections are only available in the Work Mode. You cannot access the
BIT projection in the Proposal Mode at all. As the name implies, the Bit projection will
make a projection to the bit. It can be created in two ways:
1. Straight line projection
2. Nudge projection (w/ DLS and TFO)

APPENDING/COMPOUNDING PROJECTIONS: The Bit
projection works with most of the other projections by
being able to be appended to. This allows for a projection
past the estimated current bit location. It works by 1)
opening the Bit projection dialogue and creating the initial
Bit projection, 2) opening the dialogue for the secondary
projection (take your pick).

Bit projections can be
made as straight line or
nudge-style projections.

Open the Bit Projection panel to make an initial projection then open another
projection panel to append to the Bit Projection. Make corrections on the fly on
either panel to nudge the compound projection into place.
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e. Slant Projections
Unlike the Back-on-Track projections, the Slant projections (a.k.a. “Build and Hold”
projections, “DLS” projections) do not take the proposal curve into consideration. You
give it either a Hold Angle or a DLS to shoot for and it will create the smoothest
possible curve to the target.
To create the Slant projection, RIGHT-CLICK on a target and
select “Set as First Target,” then open up the Slant projection
dialogue. You can either choose a DLS or a Hold Angle,
allowing HawkEyeTM to solve for the other. Then click “Auto
Calculate.”
Clicking “Turn On Projection” will trigger the calculations and
activate the projection in the 3D space. You can also hit the TAB
button after entering a value to get HawkEyeTM to recalculate a
parameter.
Since the job may not always call for being exactly on the
proposal line, the Slant projection might be a favorable option
for planning a smooth and easy path with minimal dogleg
severity and maximum straightaway distances.

Select a target and set it
as “First Target,” then
use a Slant projection
to get a smooth curve to
that target, ignoring
any proposal curve.

The Slant projection here (in green on the left) took a userdefined hold angle of 41.24 and came up with a 2.44 DLS to
get the easiest ride to the target, outside of the proposal.
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f. Aligned Projections
The most powerful and complicated of the projections, the Aligned projection requires
user input for both dogleg severities and the desired inclination and azimuth at the first
target.
To illustrate the Aligned projection, the 2D view mode is used
here. NOTE: To display 2D in the main space in HawkEyeTM,
just double-click on the 2D window on the top right and it will
swap out with the 3D space in the center:

The Aligned projection
panel is the most
powerful of them all.
Skewer two targets.
HIT CALCULATE: After any change in parameters, the “Calculate” button must be
pushed. This is in order to cut down on unnecessary and unwanted rendering of
calculations:
The following examples illustrate the basic functions of the Aligned projection panel.
However, the full potential of this tool, like all the rest of the projections can only be
discovered by tweaking and experimenting with the parameters to see how they
behave.
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1. At the start, there are
two targets, with a
proposal curve going
through each.

2. Here’s a DLS of 2 for both turns (arrows), and 0 for
inclination and azimuth at target for a vertical
orientation. The projection goes to the first target. Make
sure to set first target in the target’s right-click menu.

3. Putting in an Extension Before of 500 makes a straight line for 500 feet BEFORE
hitting the target, thus the second turn (big arrow) comes earlier. With a 1000 for
Extend After, the projection will go straight for 1000 feet after the target.
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Line up to hit 2nd Target: The Aligned projection tool can line up to hit two targets with
relative ease. To get the aligned projection to line up in anticipation for a second target,
the first step is to go to the DATA TREE, then RIGHT-CLICK on a target and select “Set
as Second Target.”

1. It might take a long time
to manually nudge this
projection directly into the
second target at the bottom.

2. Check “Line up to hit
2nd Target” in order to get
the curve lined up for
Target 2.

3. Then hit CALCULATE
and the projection will do
the work of hitting both
targets.

4. Add an Extend Before
length and the final turn
will come earlier (big arrow,
500 ft before the first target),
while the Extend After will
be a straightaway. >>>>>>>>
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Set DLS1 = DLS2: This option forces both DLS values to be equal to each other, and will
solve for the lowest possible needed build rate. When set, the DLS fields will become
green and uneditable.
The “Tangent” describes the length of the hold between the two build sections of the
projection. The longer the tangent, the higher the Needed Build Rates (two DLSs) have
to be.

137
HawkEye

TM

User’s Manual

Copyright © 2017 by Performance Drilling Technology, Inc.

g. Back-on-Track (BOT) Projections
Back-on-track projections will create a curve that will try to realign itself with the
current Proposal Curve within two turns equal or as close to the DLS provided, within
the minimum distance given.
The program will increase the DLS values as necessary when
calculating the minimum curvature to get back on track.
Clicking “Turn On Projection” will trigger the calculations and
activate the projection in the 3D space. You can also hit the TAB
button after entering a value to recalculate a parameter.

Back On Track to Way Point: Checking the “Back on Track to
Way Point” will turn on a projection that ends at the current
Way Point position, while using the two DLS values and
minimum distance that you have provided.
Set the Way Point position by going into Proposal Mode and
moving the red Crosshairs to the position where you want it,
then right-clicking on the red crosshairs and selecting “Move
Way Point to Here.”

BOT projections require
two dogleg values and a
minimum distance in
order to intersect the
Proposal Curve and thus
get back on track.
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Once the blue Way Point has been set, turn on the BOT projection with the “Back On
Track To Way Point” box selected and the projection will go to the Way Point rather
than back into the Proposal Curve.

Set DLS1 = DLS2: This option forces both DLS values to be equal
to each other, and will solve for the lowest possible needed build
rate. When set, the DLS fields will become green and uneditable,
while the “Tangent” field will become editable.
The “Tangent” describes the length of the hold between the two
build sections of the projection. The longer the tangent, the higher
the Needed Build Rates (two DLSs) have to be.

Dynamic (Constant) Back-on-Track: The BOT projection can be in an “always on”
mode. Go into the Proposal Mode and activate the BOT projection. This will make the
projection go to anywhere you move the Look-at Point along the proposal curve.
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h. Horizontal Projections
NOTE: Horizontal projections are only available in the Work Mode.
You cannot access the horizontal projection in the Proposal Mode at all.
Although Horizontal projections are “targeted projections,” they
require horizontal target planes rather than the normal targets to
be set as the anchored tangential object.
The three parameters describing the horizontal plane itself are:
1) The RKB TVD, which is the depth below the surface location
all the way to the point of intersection with the plane.

2) The Max Dip, which has a positive
value for leaning toward the observer
and a negative value for leaning away
from the observer. NOTE: The quickest
way to understand this value is to
change it a few times and look at the
difference in HawkEye’s 3D space.

3) The Max Dip Direction is defined in
360 degrees counting clockwise.
Visualize looking from the top down on
a well and simply define the direction as
one would an azimuth. The formation
would thus lean into that direction.

Horizontal projections
are a more hands-on
projection requiring
several user-generated
parameters, calculated
by defining a
horizontal plane.
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CREATE A TARGET PLANE: To set a horizontal plane, RIGHT-CLICK on a straight
(tangent) section of a curve, then select “Create Target Plane.” A two-dimensional target
plane will appear in the 3D space along the tangent. Now RIGHT-CLICK on the target
plane itself and select “Set as Horizontal Target Plane.”

NOTE: It always helps to put an extension (tangent) on a horizontal projection (just add
some length in the Extension field in the panel). This elongates the projection and
allows for better visualization of where the projection and the attendant target plane
will be situated. Also note that the texture of the plane itself reflects the data entered in
the LITHOLOGY panel.
NOTE: When creating a target
plane, it will be generated from
zero closure towards the active
direction in which the projection is
made. So if you then take the
projection 180 degrees in the other
way, there won’t be any target
plane in that direction.
To extend the target plane in the
other direction, just repeat the
process of selecting the curve,
RIGHT-CLICKING on it, and
select “Make Target Plane.” This
will extend the target plane in
your new direction and link up
with the first one.
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Horizontal projections will allow the user to enter either the strike azimuth or
the strike inclination.

BORE DOWN JUST UNDER THE FORMATION: The Horizontal projection panel
will only allow for the change of either strike inclination or strike azimuth at any one
time. But they can be modified in succession. To get the projection to get right under the
formation and cruise along underneath, simply determine the proper strike azimuth,
then enter a user-defined Strike Inclination of anything a little over 90 (because a 90
degree strike inclination will put the projection directly on the formation plane).

Entering a Strike Azimuth of 93 can put the projection just under the
formation, yet not deviate too far down away from the plane.

NOTE: Although you cannot define the DLS in this mode, it is the all-important number
to keep an eye on after every parameter change and is thus highlighted in green.
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3. Other Projection Tools
a. The Sight
TM

The Sight is a critical part of the 3D window in HawkEye , a visual aid that follows the
user’s Point of View or “Look-at Point” along a curve. It is highly customizable and can
also quickly be toggled on and off.
TM

TWO SIGHTS: There are two Sights in HawkEye . One is associated with the Work
Curve and the other with the Proposal Curve. Each may be toggled on or off with their
own checkbox in the “Home” tab. Each of the Sights is only visible in their own mode,
and each retains their own customization settings (e.g. diameter, colors). A Sight may
ALSO be toggled off also by right-clicking on it and selecting “Hide This Sight.”

SIGHT EDITOR: Either Sight can be edited by RIGHT-CLICKING on the icon, or
RIGHT-CLICKING on the 3D space and selecting “Sight Editor.” The Sight Editor
allows for the customization of every aspect of the current Sight and changes are
automatically saved.
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The Sight Editor controls all of the appearance options of the Sights for both the Work
and Proposal curves. The parameters are:








Curve Type- Choose either the Work or Proposal Curve Sight to edit.
Style- Choose either contiguous circles or a quartered stagger.
Background- Choose from a combination of either two colors, two textures or
one of each. The colors to choose from run the entire visible spectrum, and there
are about 100 default textures to choose from. But the user may provide a custom
texture by choosing the folder location when prompted.
Text Back Color- Choose the background color of the numbers on the Sight.
Size- This feature defines actual size of the Sight and dictates the distances
defined by the numbers on Sight itself.
Mag->Highside- This drop-down menu ranges from 0.0 to 5.0 in .5 intervals and
defines the inclination the user wants to switch from Magnetic Tool Face to
Gravity Tool Face. When the inclination exceeds this value the sight will be
oriented so that the top is at Tool Face 0. When the inclination is less than or
equal to this value the top of the sight will be pointed due north.

Click “OK” to save all changes to the Sight.
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THE DIRECTIONAL COMPASS: The floating Directional Compass can be turned on
and off through the Sight Maker options dialogue. When turned on, it is a compass that
follows the Look-At Point to constantly show either True North or Grid North,
depending on the current project’s settings.
The Directional Compass will always be the size of the Sight, and will always be
oriented horizontally.
Hit the comma (,) key while the cursor is hovering over the 3D space in order to toggle
the directional compass.
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b. Projection to the Crosshairs
The crosshairs can be used in the projection mode to act as a “First
Target” for certain targeted projections (Slant and Aligned). In order to
TM
have the Crosshairs active on the screen, HawkEye needs to be in
Proposal Curve Mode with the Sight turned on. Toggle the Proposal Sight on by
clicking on the checkbox next to the Proposal Sight under the “Home” tab.
SIZING: The Crosshairs is always red, and is always sized along with
the diameter of the curve. To change the curve display diameter, use the
slide control just below the 3D window.
MOVE THE CROSSHAIRS: The Crosshairs appears by default in the
center of the Sight, hugging the active curve. To place it anywhere on the
Sight, just left-click and drag it to the area, then drop it. Right-click on it
and select “Put in Center” to re-center.
SET AS A TARGET: Pull up the Crosshairs contextual
menu by right-clicking on it.
When The Crosshairs object is set as First Target (or
Second), it becomes a target for projection purposes
only and is not a listed target that can be found in the
Target List or Data Tree.
PROJECT TO CROSSHAIRS TARGET: Once the Crosshairs are set as a target through
the right-click menu (see above), one of two targeted projections (Slant or Aligned) can
be made to the Crosshairs.
The projection will be
redrawn constantly as you
move the Sight up and down
your reference curve.
Right-click on the new curve
and select “Set as new
proposal” to create a new
curve which goes to that
current point.
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c. Target at the Crosshairs
SAVE AS PERMANENT TARGET: Right-click on
the Crosshairs and select “Save as Permanent
Target.” A name prompt will appear and then the
target will have been created at the exact current
location of the Crosshairs. In this fashion, the
Crosshairs can act as a Johnny Appleseed of targets, making it easy to drop simple
targets near a proposal curve without having to input coordinates or offsets.

Select “Save as Permanent Target” from the Crosshairs right-click menu and a
target will be generated in that very spot.

ALSO NOTE ANOTHER WAY TO GENERATE TARGETS QUICKLY

Click on the “Add Target” button in the middle of the Home tab to create target at
the current Look-At Point of the 3D space.
These targets, like any real target, can be found in the Data Tree and Target List. They
are associated with the slot/wellhead under which the current proposal curve is located.
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d. The Waypoint Target
A quick-use target can be set
anywhere on the Sight in order to
quickly drop in an intermediary target
for projection purposes. This target,
called the Waypoint, is set by rightclicking on the red Crosshairs and
selecting “Move Way Point To Here.”
The Waypoint will appear as a blue
object in the 3D space.
It will also appear as a target in the Data Tree under
the name “WP*”. It may be deleted via the Data
Tree right-click menu, or if it is repositioned
through the Crosshair menu, it will simply exist in a
new location.
NOTE: There is only one Waypoint in the 3D space at any given time.
PLACING THE WAYPOINT: As
mentioned above, to place the
Waypoint, just move the red
Crosshairs anywhere on the
Sight,
right-click
on
the
Crosshairs and select “Move Way
Point To Here.” The blue
Waypoint will appear exactly
where the Crosshairs is located.
Even if the Sight is moved away,
the Waypoint will remain in the
original placement location.
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PROJECTING TO THE WAYPOINT: To actually use the Waypoint, first place it, then
simply right-click on it and “Set as First (or Second) Target.” The targeted projections
will treat it like a designated target in this fashion, and it can act as a quick way to make
a sort of anchor between locations.

SET AS NEW
PROPOSAL: Just as with
regular targets, if a
projection is made to a
Waypoint and then that
projection is made into a
“proposal curve,” the
curve will remain there
even if the Waypoint is
deleted or repositioned
somewhere else.
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IV.

REPORTS AND QUICKPLOTS

Reports in HawkEyeTM can be produced for six different dataforms: survey, projection,
critical points, criticality, least distance and interpolated survey reports.

SIX TYPES OF REPORTS IN HAWKEYE
1. Survey Reports- This is the default type of report, which presents all of a curve’s
surveys under critical points headings. May include currently active projection.
2. Interpolated Survey Reports- This report is useful for interpolating across
different types of wells. It has different interval options between a proposal and a
survey well.
3. Projection Only- Displays the surveys of the projection that is active just before
opening the Report Generator.
4. Critical Points Reports- This report displays only the geometrically defined
critical points and user comments for a curve.
5. Criticality Reports- A special kind of least distance report where several
different wells can be compared to determine dangerous proximities.
6. Anti-Collision Reports- A comparison report between two or more curves
which displays a suite of separation factor-related values.

OPENING THE REPORT GENERATOR: There are four ways to get to the Report
Generator in HawkEyeTM.
1. In the top left of the main screen, second from the left, click on the Report
Generator icon. The survey which appears is of the well path that is the current
center of focus in the 3D space
2. RIGHT-CLICK on any curve in the Data Tree and select “Show Survey Report.”
This will bring up the surveys for that particular curve selected.
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NOTE: Right-clicking on a curve brings up a long list of curve-related options,
and in fact, these such contextual menus are the basis for navigating the
various functionalities of HawkEyeTM.
3. RIGHT-CLICK on a curve in the 3D space, then select “Show Survey Report.”
This will bring up the surveys related to that curve.
4. RIGHT-CLICK on the colored bar just
above the Survey List Panel (located
at the bottom portion of the main
screen) and select “Show Survey
Report.” This will bring up the survey
related to the currently focused well.

EXTRA DATA IN SURVEY REPORT:
Most of the optional items that can be added to a Survey Report are self-explanatory.
The “Extra Data” tab can be found at the bottom left of the Report Generator.

Two items bear some explanation:
Mining Mode bears some explanation: It subtracts 90 degrees from every inclination
reading. This convention is used in the mining industry, where their “0” is horizontal.
Easting, Northing and Latitude, Longitude on the bottom pertain to targets. When
“Targets” are checked, their location can be displayed in either one or the other format.
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1. Survey Reports
TEMPLATES: Any of the 41 data types found in the blue columns on the left can be
added to a report template in any order, and any number of templates can be saved and
loaded. This is useful for various customers with different specs for their reports. To
add a data column, LEFT-CLICK on it from the left hand blue column and it will appear
in the display list column. To remove, select it on it in the right hand column by leftclicking on it, then RIGHT-CLICK on it and it will disappear.
To place them in a certain order, they must be removed and “stacked” or re-added to
the righthand column in the desired order.
PRINTING REPORTS: Printing a report is
as simple as clicking the “Print” button at
the top of the Report Generator panel, or by
clicking the printer icon at the top of the
panel. A user may also print from a certain
depth. To do that, they would simply select
the starting survey from which to print from the drop-down menu, then click “Print.”
This is useful for avoiding having to print out an entire battery of surveys when for
example only the last ten are needed on paper.
PRINTING TO PDF: HawkEyeTM installs with CutePDF, a program which allows
anything which can be printed onto paper to be printed into a PDF instead. Using this is
as simple as selecting “CutePDF Writer” as the printer in the print settings and then
selecting a target folder for the file when prompted.
(CutePDF Professional is a step up from the free version and can be purchased at their
website (www.cutepdf.com). It includes a ton of features for around $50, but none of
them are necessary with HawkEye.).
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COVER PAGE: A cover page
can be added, and may contain
any of three major elements: a
logo, a title or comment, and a
snapshot from the 3D space.
To add a cover page, first select
the “Cover Page” checkbox in
the top left. To add a logo, click
“Load Logo” in the top left and
select a graphic that will appear
on the top left and right of the
cover page.
To add comments, simply type in whatever desired text into the “Cover Page
Comment” text field in the bottom left of the Report Panel. It will appear
instantaneously on the cover page.
SNAPSHOT: By turning on the Snapshot option, the cover page will show the last 3D
view seen before opening the Report Generator. So to adjust the snapshot, the user
simply closes the Report Generator and navigates the 3D space to get just the right
angle, then opens the Reports back up again.

CENTERED HEADER: A block of additional header text can be added to the first noncover page of a report simply by adding text to the “Centered Header” text field in the
bottom left of the Reports
panel (under the
“Centered Header” tab).
Any added header text
will appear above the
mandatory header
information that always
appears in the header
zone of a report.
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NORTH ARROW: Toggle on the North Arrow with the
checkbox in the top left and such an arrow will appear in
the first non-cover page of the report. This arrow set
displays True north, grid north and magnetic north. (For
more on this arrow, see the Magnetics Report section at the
end of this chapter).

BOX COMMENTS: Comments for each survey can be added here and are usually a
necessary part of reports. To add box comments, just click the “Box Comments”
checkbox and a column of comment fields will appear in the report.

PAPER SIZE: Choose from Letter or A4.

EXTRA
DATA:
Additional
supplemental data can be
appended to the bottom of a
report by checking them in the
“Extra Data in Report” panel.
When
selected,
the
corresponding data will be
generated,
organized
and
displayed under any displayed surveys.
REPORTS NAVIGATION:
The tools at the top of the
Report
Generator
panel
controls the view modes and zoom. Reports may be viewed one, two, three, four or six
pages at a time. The currently displayed page can be controlled here as well.
NOTE: Pages can also be navigated by scrolling the mouse wheel up and down while
the cursor is over the report page itself. Also, left-clicking on the report itself will zoom
out one step, while right-click once will zoom in one step.
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SELECTING SURVEY OR PROPOSAL: Select the curve on which to base the report
by clicking on it in the bottom left window of the panel. You may either choose a survey
or proposal curve. They are automatically numbered by the sequence in which they are
listed in the project’s database. When a curve is clicked on, the report will be
immediately generated via all the parameters specified in the Report Generator panel.

REPORT TYPE: Choose your report type in the
middle left of the panel. A survey entry can be
generated at different frequencies depending on
whether the path section is straight or curved. That
frequency input is located in the same window
where the report type is selected and can be entered
manually.
The default Survey Report will display each of the
survey readings of a curve. The survey entries are
organized readings under critical point headings
that describe each part of the curve.
ENTERING SURVEYS: Surveys are not entered in the Report Generator, but rather
only displayed in a report. Surveys can be entered manually in the survey window at
the bottom of the main screen or in the Survey Editor, which can be opened by clicking
on the blue plus icon on the far left end of the projection icons.
COPY AND PASTE: Surveys can be quickly copied from a spreadsheet and pasted
directly into the Survey Grid in HawkEyeTM. See more about this process in Ch.3 Project
Data, Section 2 Job Information: Adding and Editing, under the first sub-section
“Surveys.”
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Up/Down and Left/Right: Of the many columns of data that can be added to a survey
report, often favored are the UD/LR columns. When these are added to a report, they
will always compare the referenced curve against the Current Proposal Curve,
whichever that may be.
Furthermore, the values will be expressed as UD/LR only in surveys where the
inclination is above a certain threshold (which can be set in the Sight Editor on the
bottom right corner of the form). If a survey contains an inclination under the threshold,
then the distances are expressed in terms of North/South and East/West of the proposal
curve.
INCLUDE PROJECTION: The default
survey report has a checkbox which allows
the user to include any projections that
were active in the 3D space at the time the
Report Generator was launched. In the
picture to the right, there are two
projections activated, a Bit and a Nudge
projection. By leaving them on and
launching the Report Generator, you have the option to include them in the survey
report, as illustrated below.
Just check the “Include Projection” box in the Report Type area, and the surveys for the
projections will be automatically added and labeled at the end of the as-drilled surveys.

You may also generate a report that contains ONLY projection surveys by clicking on
the “Projection Only” button in the Report Type. Remember, the projection needs to be
active before launching the Report Generator for this to work.
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2. Other Reports
a. Critical Points Reports
There are two kinds of critical points in HawkEyeTM, the geometrically defined critical
points and user-created comments HawkEyeTM treats as critical points. With a Critical
Points report, each of these data are put into a report in the order in which they occur as
a function of depth.
To create a Critical Points report, select “Critical Points” from the Report Type, then
select the reference curve on the bottom left. The report will be immediately generated,
displaying all the geometrically defined points as well as user-generated comments for
that curve.

The Critical Points report will display all relevant data points of a curve. Simply select
“Critical Points” as the report type and select the desired reference curve.

In addition to the standard comments, additional comments for Lithology, casing and
targets can be included in the critical points report. In order to include those, just click
the associated check box for the Interpolation Options. An icon for lithology, casing or
a target will precede the description.
If two critical points are defined by the same point then all the comments are joined and
the icon provides a visual cue as to the nature of the comment.
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b. Criticality Report
The Criticality report will graphically represent any dangerous proximities on a
distance plot. All curves in a project are shown with a key at the bottom of the graph.
Be sure to select the desired reference curve from the drop-down menu at the bottom
left of the panel when “Criticality Report” is selected. A Maximum Distance can be set,
a range to which criticalities will be displayed. When a new reference curve is selected,
click “Create Report” in order to refresh the graph.

SHOW PROJECTION: Check the
“Show Projection” box to show any
curve’s projection in the graph. It is
recommended that the projection
be made a different color than the
preceding curve in order to
enhance visibility in the graph
The text output associated with the criticality report will highlight only Criticality 3, 4
or 5. Criticality 1 and 2 are ignored. This helps to keep the report to a manageable size.
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c. Anti-Collision Report
An Anti-Collision report will generate a list of surveys comparing any of two or more
curves, as well as a ladder plot to help discern any dangerous proximities. Any well
that is close to the base line of the plot indicates a potential problem at that measured
depth.
SELECT COMPARE CURVES: To create a least distance report, just select “AntiCollision” in the Report Type window, then select the one or more reference curves
from the drop-down menu that will appear just below. After selecting the compare
curves, click “Create Report.”

The header at the top of each page of the report will clearly state which two curves are
being compared.
The first non-cover page of the Anti-Collision report is
the ladder plot comparing the curves:
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The subsequent pages contain the survey list. This list will have a number of columns
containing specific distance and separation factor values.

The following is a breakdown of each of these columns:

Distances
Between Centers: The minimum 3D distance between the reference well and the offset
well.
Between Ellipses: The distance between the ellipses.
Minimum Separation: The minimum allowable separation distance. This is generally
calculated according the ruleset being used. The default rule is that the minimum
separation is the sum of the ellipses radii. With a pedal curve calculation, that means
the distance to the pedal curves.

Semi-Major Axes
Reference: Length of the Semi-Major Axis of the projected 2D ellipse onto the TVD
plane of the reference well.
Offset: Length of the Semi-Major Axis of the projected 2D ellipse onto the TVD plane
of the offset well.

Proximity
Highside Toolface : This is the tool face angle on the normal plane of the reference well
that lines up with the offset well.
+/- N-Plane: This is the distance the center of the offset well is behind or in front of the
reference well. This is included so that one can determine whether or not the well is in
front or behind the reference point.
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Separation Factor: The general definition of this number is the ratio of the center to
center distance divided by the sum of the ellipses radii. A SF greater than one means
that the ellipses are completely separated, and there is no overlap. A SF of one means
that the ellipses are touching and a number less than one means that the ellipses are
overlapping one another. When the diameters of the well and casings are taken into
consideration, the formula for calculating the SF changes. Different operator rule sets
impose different approaches to calculating this number, there is no one way. One of the
most common methods for measuring the radii of the ellipses is called the pedal curve
method (PCM). This method creates a pedal curve around the outside of the ellipse and
radii are measured to that curve, not the edge of the ellipse.
A more detailed understanding of the calculation and the different approaches to it can
be found in Angus Jameisons e-book, which can be found at this address:
http://www.uhi.ac.uk/en/research-enterprise/energy/wellbore-positioning-download

Criticality/Warning:
The Levels 1-5 indicate warning levels. Level 1 is the lowest and level 5 is the highest
warning level. Rulesets defined by different oil companies will define different levels of
warning, generally based upon the value of the separation factor. The lowest level
generally means proceed ahead as planned, continuing the quality control (QC)
procedures defined for the well. Level 5, or whatever the highest level the company has
defined, generally means stop dead in your tracks and wake up all the bosses so they
can decide what to do.
SF – Indicates that the survey has the minimum Separation factor for the current offset
well.
ES –Indicates that the survey has the minimum Separation between ellipses for the
current offset well.
CC –Indicates that the survey has the minimum center to center distance for the current
offset well.
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d. Interpolate Survey Report
Additional interpolated surveys can be
generated for either survey or proposal curves.
When a survey curve is selected under the
Interpolate Survey report type, an Increment
field appears within which the user may define
an interpolation interval. When a proposal
curve is selected, the interval fields allow the
user to define both the straight segment and
curve segment frequency of interpolated
surveys.
The reason proposal curves have two
interpolation intervals to define and regular
surveys is because frequently users want to see
a proposal with the curve section interpolate
by one value, say 30 feet and the hold sections interpolated every 100 feet. A proposal
can be represented by simply inputting the critical points as surveys. A proposal’s
critical points will calculate exactly the same closure and coordinates as the same
proposal that is interpolated every foot.
KEEP CURVE: The Interpolated Report can be used to generate an entire curve from
just a few critical points. This process takes the critical points and extrapolates them into
a usable proposal curve. Just follow these steps:
1.
2.
3.
4.

Enter the critical points as surveys into a new or existing curve.
Go to Report Generator and select “Interpolate Survey” as the report type.
Define the increments of interpolation you want for the curve.
Click the KEEP CURVE button.

NOTE: The interpolated surveys will OVERWRIGHT the current list of surveys.
MAX INCLINATION (TVD APPROACH): For use with targets. The threshold
inclination here tells the program at what inclination to stop drawing a TVD plane line
to the curve from the center of target and start drawing a least distance line. For
example, if the max inclination here is set to 85 degrees, then as long as the inclination
of the curve is below 85 degrees all TVD interpolation values from the center of targets
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to the curve will be calculated as a straight line along the TVD plane. Once the curve is
above 85 degrees, the distance from target to curve will be calculated by least distance.

e. Projection Only Report
This report will generate the survey list for the projection(s) activated just before
launching the Report Generator. If there is no projection turned on when the Report
Generator is activated, then this report type will not be available.
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f. Magnetics Report
Magnetics is particularly important when taking magnetically measured surveys, for
example determining applied declination, etc. HawkEyeTM allows for a high amount of
customization in magnetics configuration.
To get to the Magnetics dialogue, click on the
magnet icon at the top center of the main screen.
MAGNETICS MODELS: Once inside, the first
step is to select a magnetic model file.
HawkEyeTM uses the IGRF (International
Geomagnetic Reference Field) and WMM (World
Magnetic Model) magnetic models. (Future
models will include those developed by National
Oceanic and Atmospheric Administration and
the British Geological Survey). The BMMG model
is available for those users who have a paid
license for it, but is currently not available
standard with HawkEyeTM. It is important to
have the right model selected. The IGRF2010
model is good until 2015.
SURFACE
LOCATION:
Magnetics
is
automatically calculated when a surface location
is entered in a project, but that location (LatLongs) can be manually changed in the
Magnetics panel in the fields highlighted in light
green at the top.
PRINTING: Just click the “PRINT” button and a
handy one-page Magnetics/Geodetic Report is
generated, containing not only all pertinent
magnetics information, but several methods of
correction based on which north the user needs
to correct from.
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3. QuickPlot
The QuickPlot module will meet most users’ needs. It includes virtually all
elements for a smaller-sized plot, and the interface is What-You-See-Is-What-You-Get.
The use of the module is encapsulated in the Quickstart guide below:
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a.

Different Types of Charts

The QuickPlot has several options for charts, all of which can be chosen from the top
right corner of the QuickPlot module by clicking on one of the buttons:

1.
2.
3.
4.

Vertical Section Chart – either in portrait or landscape.
Horizontal Section Chart (top view) – either in portrait or landscape
Vertical AND Horizontal Section Chart- portrait or landscape
Traveling Cylinder – Portrait orientation only

b.

Printing, Tweaking and Customizing

Right underneath the mode buttons just described, the
yellow, green and blue buttons contain all printer and color
options for the charts. Below those buttons are two areas,
one for controlling the Vertical Plot, and the other for the
Horizontal Plot.
Here are some comments on each of these controls:
PRINTER: The user must choose a printer and the paper
size here FIRST. If any problems arise when trying to print
to PDF, it is recommended that you choose CutePDF as the
printer.
*NOTE: When you select a printer here, it becomes your
Windows system default printer.
CURVES: This is the same Curves List that can be invoked
in the main screen under the Curve Menu.
LABELS: This is the same lables manager that can be invoked in the main screen under
the Graphics Properties.
PRINT: This will AUTOMATICALLY print to whichever printer has been selected
under the Printer button.
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VERTICAL PLOT tip:
 The V.S.P. can be set here, or in the main screen in the V.S. View. Each
slot/wellhead has a V.S.P. that will be remembered after being entered.
BOTH VERTICAL AND HORIZONTAL PLOT tips:
 Keep Minor Grid turned off in order to maximize smoothness of navigation
when zoomed out.
 When the zoom is out of whack, click the “AUTO” button to return to a home
view. NOTE: this resets the label positions as well.

c.

Plot Options

The checkboxes in the black box will add any of a
number of objects directly onto the plot itself. There are
also custom text and image buttons in blue. Once
activated, the object can be resized from its edges. There
are a couple of special cases:


The “Add Text” and “Add Image” buttons can
be added in unlimited amount. To delete them
the user must right-click on the text box or
graphic itself and select the “Delete” option
there.



Show 3D: This portal into the 3D space is fully
navigable. To move the window around in the
plot, the user must grab the upper left corner of
the window with the left mouse button.

All color options and object placements can be saved to
a template by clicking the “Save Template” button.
Loading a template can be done by clicking the “Get Template” button.
The infobox in black and white at the bottom indicates where the cursor is with respect
to depth and local offset from the current Reference Slot.
If all is lost (e.g. the colors and zoom are irreversibly messed up, the “Reset All” button
will return all settings back to default. From here the user can load a template if one has
been saved.
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d.

Projections and Tools

The “Projections and Tools” tab on the bottom right
simply allows the user to use ALL THE BASIC TOOLS
that are normally found in the main screen.
NOTE: It helps to have the “Show 3D” option activated
so that the 3D space is available in the plot area.
Neither the Reports nor the Proximity/Ladder Plot
windows can be included directly in a plot. These
buttons are merely shortcuts to the other parts of the
program.
All active projections will be shown in the 2D charts and
the 3D space.
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e. Traveling Cylinder
1. What is a Traveling Cylinder?
Traveling Cylinder Plot (TCP) is one of a collection of tools that operators have
traditionally used to plan and drill safely through a maze of wells. Most common usage
is on wells that are drilled from offshore platforms or wells that are drilled from land
pads with multiple adjacent wells.
Their principle usage is in the vertical hole sections near the surface where collision
risks are generally the highest.

2. How to read a Traveling Cylinder Plot
Understanding how to read a traveling
cylinder plot can be a bit of a challenge.
The first issue to comprehend is that
the plot represents a two dimensional
representation of a solidly three
dimensional problem.
The center of the plot represents all the
points along the reference well,
regardless of the geometry of the well.
For a well planner the reference well
would be the plan and for a directional
driller the reference well would be his
as-drilled plus his projection to the bit
and beyond the bit, if the plot is being
maintained by a computer. If a wall
plot is being used by the directional
driller (DD), the wall plot will have the
proposal as the reference curve, and the
DD plots his as-drilled points on the
wall plot. Should his plot points cross a no-go zone on the TCP then that would be
indicative of an operator’s rule-set violation. A DD needs to know how to calculate the
plot points on a calculator or by hand, should the computer program he is using not
provide the plot points for him.
Since the TCP is normally used in vertical portion of wells the natural plane on which to
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measure distances is the normal plane, the plane which is perpendicular to the direction
of the reference point at any given depth. In vertical wells this plane approximates the
TVD plane. For low inclinations, which is what the TCP is used for primarily, the DD
can use the EW,NS coordinates of the survey to calculate his plot point. Although this
is not entirely accurate the discrepancies are minor. With non-vertical wells the normal
plane is the plane the directional driller uses to steer from high side. In vertical wells the
directional driller steers with magnetic tool face so the TCP is normally referenced to
either true north or grid north. Some companies demand that true north always be
used, but there are some very good reasons to use grid north if a grid system was used
to plan the wells. Certainly, if one were to use a traveling cylinder plot in higher angle
holes the use of GTF reference instead of north reference is desirable since the goal of a
TCP is to provide and effective steering guide.
3. Constructing the Traveling Cylinder Plot
Since the reference well is represented by a single central point on the TCP, plotting all
of the uncertainty ellipses for all of the depths around that point would result in a blur
of meaninglessness at the center of the plot, since it is near impossible to associate
which ellipse is associated with a given depth. The comparison wells, on the other
hand, can have meaningful ellipses drawn around their survey points, but they only
represent half the uncertainty. In order to overcome this issue, a TCP summarizes the
uncertainty of the reference well with the uncertainty of the offset well and displays
that uncertainty around the offset well. This is accomplished by summarizing the
covariance matrices9 of the reference well and the offset well, and then displaying the
resulting ellipse/ellipsoid/elliptical cylinder on the offset well. With this method the
reference well in the center stays unmarked and thus uncluttered.
4. Shortcomings of the Traveling Cylinder Plot
Shortcoming 1: One rather critical issue with TCPs in vertical wells is how to handle
“flipped” survey stations. If all the crossings of a well are not inserted into a survey list,
and the only the surveys are used to calculate least distance then there are instances, as
the one shown below indicates (fig2), where it appears on the TCP that there is a head
on collision with the reference well. One can easily see from the plot that these two
wells did not collide, so what is the problem? The problem is that no crossing was
calculated between the two successive surveys, as it should have been. What the
crossing represents is the point of closest approach between the offset segment bound
by the two surveys and the reference well. If the crossing is determined and then
9

The covariance matrices are the mathematical tool that is used to determine the uncertainty of
multidimensional uncertainty.
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plotted it clearly shows how the offset well misses the reference well. There have been
other ways of dealing with this issue, but this is the best way.
Shortcoming 2: Another issue with TCPs is that in tight spiraling adjacent wells,
plotting the entire depth of the reference well can lead to some confusing imagery, so it
is best to plot the TCP out in sections so that several TCP plots are used for the entire
well.
Shortcoming 3: The TCP requires the user to abstract numerous concepts and for a
casual user, such as a company representative, it can be difficult to understand at first
glance.
Shortcoming 4: TCPs also suffer from the limitations of normal plane distance
calculation, a method that will only pick a point on a well that intersects with the
normal plane of the reference well, and completely miss a well that is directly in front of
the bit. (Of course, a good complete anti-collision policy should pick up that type of
collision easily).
Shortcoming 5: Another weakness is that for highside calculations on the normal plane,
manually calculating the point of intersection and determining the appropriate plot
point without a computer or a rather complex calculator program is highly impractical.
Computer programs such as Hawkeye™ which maintain a dynamic TCP while drilling
are the best way to use a TCP, as they help to reduce the amount of human error that
can occur by mis-plotting TCP data manually. A computer program can also use the asdrilled instead of the proposal as the reference well since the errors attributed to the
reference well are actual as opposed to “planned.”
5. In Conclusion
The judicious use of a TCP in conjunction with ladder plots and proximity reports
makes for an effective anti-collision package. The advantage to the method is that it can
be maintained on a wall plot and does not necessarily have to be maintained by a
directional computer program. Once a DD understands how to use the plot he has a
very effective steering tool to aid him in avoiding other wells. However, it is likely that
the use of TCPs will diminish as robust 3D interfaces become more widely available.
This is because the visualization of such systems is immediately comprehensible and
much less likely to foster misunderstandings.
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6. Controlling the Traveling Cylinder in HawkEye
When TC is selected from the very top right corner of the
QuickPlot window, the TC control panel will appear on the
right. There are a number of controls to consider:











Dir Ref (Directional Reference): Choose from True
North, Grid North or High Side.
Center-: This will make the centerpoint of the TC plot
either based on the Current Proposal Curve (“Plan”) or
the Current Work Curve (“As-Drilled”)
From MD/To MD: Use the Plus and Minus buttons to
advanced or retreat the location of the area along the
curve to be reviewed
Depth Step: This will affect the distance by which the
plus and minus signs move you up and down the curve
TC Scale: This will change the overall scope of the TC
plot itself
Show Ellipses: This will turn on ellipses of uncertainty,
based on ISCWSA models and the survey tools chosen for
the surveys
Show Cylinders: NOTE: This display option is for the 3D
window only. It will turn on cylindrical ellipses of
uncertainty for all wells in the 3D space. See more about
the 3D space below.

7. The 3D Window
The 3D window on the bottom right of the TC panel can be navigated just like in the
main screen. The six radio buttons will place the 3D window either on the TC Plot or
“Here,” meaning inside the small panel.
 With the cursor hovering over the 3D window, hit “I” on the keyboard to toggle
the 3D Info.
 The 3D window, even if placed on the TC plot itself, will not show up in the
printed form. It is for visualization on-screen only.
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V. Special Tools
1. Interpolation
Interpolation is a method of constructing new data points within the range of a discrete
TM
set of known data points. In HawkEye , the Interpolation tool allows the user to either
merely CALL FOR A SURVEY ENTRY into a list one at a time, or to go ahead and use
an interpolation point as a TIE-IN POINT for a sidetrack curve.

Open the panel from the “Special Tools” tab. Once inside the panel, there are two major
choices: 1) to invoke either an MD or a TVD interpolation, and 2) whether to merely
have that interpolation point or to use the point as a tie-in for a sidetrack curve.
The first step is to enter either the MD or
TVD depth in the top left. Then hit TAB and
TM
HawkEye will calculate the interpolation,
filling in all the data down the middle
“Interpolate” column. The columns to the left
and right are survey stations displayed for
reference.
The second step is to decide whether to
INSERT that interpolation into the survey
list, which only requires clicking on the
“Insert” button; or making that interpolated
point a tie-in point for a sidetrack curve.

The Interpolation panel breaks down
into two choices at the top: 1) MD or
TVD as the mode of measurement,
and 2) either insert the interpolation
or make it tie-in for a sidetrack curve.
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By clicking on the “Make Tie In” button, a
dialogue will appear for creating a new curve
and you can enter the parameters for a
sidetrack proposal. Once created, it will appear
in the Data Tree just like any other proposal
curve, with all the attendant options associated
with it.

1.

Interpolating from Lists

The interpolation tool includes two options for interpolating surveys directly from
simple text files that could be set up with NotePad or WordPad. Simply input MD or
TVD, (comma) comment or formation top, whatever. Input as many lines as you need,
then save the file. You can use that file on other curves and save yourself the hassle of
interpolating tops for each iteration of a what-if scenario being played out with
geologists and drilling engineers that keep changing specifications.
2.

Interpolating Lithology, Casing and Targets via Survey
Report

The survey report is covered in detail elsewhere in this documentation, but it is worth
mentioning here that interpolation of Lithology, Casing and Target points can be
implemented ‘on-the-fly’ in the survey reports. A small icon is placed next to each
comment, indicating the type of comment. The snapshot below shows a section of the
report screen. The box labeled Interpolation Options shows the choices available for
interpolation. The survey report itself shows the icons and how they are displayed in
the report:
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3.

Interpolating an Entire Curve from Critical Points

The Interpolate Report can be used to generate an entire curve from just a few critical
points. Just follow these steps:
i.
ii.
iii.
iv.

Enter the critical points as surveys into a new or existing curve.
Go to Report Generator and select “Interpolate Survey” as the report type.
Define the increments of interpolation you want for the curve.
Click the “KEEP CURVE” button.
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2. Cut-and-Paste with ScratchPad

Well Planning Version ONLY
Well Planning can be a tortuous process no matter how powerful a well planning tool
one has available. More often than not, just getting the base data one needs to execute a
plan can take days. The following is a list of common information that is necessary to
do a directional well plan:













Project Information – Information about datums, geodetics, job data and units of
measurement
Well Site Location - Often needed: State, County, Geodetic Zone or TownshipSection Range Data, Map Offsets, 1927 or 1983 Datum, Grid Coordinates or
Latitude and Longitude.
Name of Structure or platform/pad area
Name of Company or Field
Lithology List of tops and bottoms, dips and directions
Casing List of Size, Wt and Set Depth and Run to Depth
Offset Well Data which includes the surveys and the surface location data for
each well
Lease Line List information and necessary legal offsets
Hard Line List Data
Targets List – Location of targets, Shapes, Sizes
Well Plan Information – This is the specialty of HawkEye, but often operators
will already have a plan they want to execute. They will either have a set of
surveys or a set of critical points.

As one can see from the above data, there are lots of lists involved. As it turns out, in
the preplanning stages much of this data is already available on a spreadsheet being
maintained by whomever is responsible for qualifying the data, be it a geologist or a
drilling engineer. So, wouldn’t be nice to just be able to drag and drop that data
directly into a program and have it all processed so that it does not have to be re-input?
Hawkeye’s answer to this question is ScratchPad.
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First off, Hawkeye manages a database. When Hawkeye is open, it is by default,
opened to the last project that was open when Hawkeye was last closed. You can, of
course, select another project in the database, or create a new project with the Wizard,
or open up another existing database or create a new database.
When you have an existing project open, the focus of that project is the current work
curve and current proposal curve; and thus all the parameters above the well site level
are selected, those of Slot/Site, Platform/Pad, Project Data, Field/Company.
1. Primary Keywords
Get started with some special vocabulary. They are words you already know so
remembering them shouldn’t be a problem. We will call these the Primary Keywords.
If you have ever done any computer programming, the concept of a keyword is nothing
more than a command like ‘PRINT or IF THEN or END’. Conceptually what we are
going to be doing here is similar, but friendlier than most programming.
We don’t have to create a complex process, just remember things like a [DATABASE]
has a Name, or a [SLOT] has a Latitude and a Longitude or a [WELLPATH] can be a
Survey , Plan or Proposed Survey.
These are called the properties of each Primary Keyword. The following shows the
keywords and the properties and options to different properties for each:
[DATABASE]
Name
[COMPANY/FIELD]
Name
[PROJECT]
Name, UOM either feet or meters, Direction Reference, Latitude and Longitude
(preferably of current slot) or State, County
[STRUCTURE/PAD]
Name, Elevation or…
[SLOT/SITE]
Name, RKB, Latitude and Longitude, REFERENCE (or Not)
[WELLPATH]
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Name, Type Wellpath (PLAN, PROPOSAL, SURVEY)
List of MD, INC, AZM
[JOB]
Job Number, Company Name, Rig Name, Location Description
[CASING]
List of Size, Wt, Top Depth, Set Depth
[LITHOLOGY], BY TVD or BY MD
List of Name, Description, Top Depth, Bottom Depth, Pattern
[TARGETS]
By TVD or SUBSEA Depth, Shape, Size, Color
[HARDLINES]
Name, ALL or NONE
Input Mode: List all possibilities
List according to Mode
[LEASELINES]
Input Mode: List all possibilities
List according to Mode
2. How the Cut and Paste Works
The following presents a normal operational scenario in which dragging and dropping
data can be implemented. First, we will manually build up a spreadsheet and then we
will show how easy it is to use existing spreadsheets to prepare a customized project or
sub project.
SCENARIO ONE: You want to create a new Project in a new Database.
In this case you have opened HawkEye already and it is displaying the contents of a
project in the current database. To create a new database with drag-and-drop, type the
following on two lines of the spreadsheet:
[DATABASE]
Name: MYNEWNAME
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You can now copy the two lines by selecting them with the mouse, and then move to
above the 3D space in Hawkeye, right-click and then select “Paste.” HawkEye will
close out the current database and start a new one with the name you specified. The
database itself will be stored in the default Hawkeye directory.
Easy enough, you say, but why bother when all I need to do in Hawkeye is: File> New
Database Project? Because with ScratchPad, creating a new database or project is just the
beginning.

Included in the Hawkeye/ScratchPad subdirectory is a spreadsheet,
HawkeyeScratchpad.xlsx. The following page shows an example of this spreadsheet.
There are four columns on this spreadsheet and numerous row groups that are
separated by colored headers. The Header groups straight down are:













DATABASE
COMPANY/FIELD
PROJECT
STRUCTURE (PLATFORM/PAD)
SLOT (WELLHEAD)
WELLPATH
JOB DATA
CASING
LITHOLOGY
TARGET
HARDLINE
LEASELINE

What You Ought to Know About Spreadsheets
It is assumed that the user has familiarity with manipulating a spreadsheet. If not, it
would be well worth one’s time to learn a few spreadsheet tricks by studying the
tutorials and documentation associated with the spreadsheet. In virtually every office
there is someone who knows more than a little on how to manage a spreadsheet. So if
nothing else, you can get them to teach you. There are two ‘tricks’ you will have to
master to make effective use of the ScratchPad spreadsheet: 1) how to copy rows and
then insert those copies in the right place. And 2) know how to take a few columns of
numbers and convert them into a comma delimited format using Notepad (another
Windows program), then paste them into the spreadsheet.
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This column contains the names of
the Primary KeyWords and
the Properties associated with
each one of them.

FILL IN THE DATA VALUES

IN THIS COLUMN

KEYWORD and PROPERTIES

SET ANY DEFAULTS
IN THIS COLUMN.
HAWKEYE WILL USE THE DEFAULT
IF VALUE IS LEFT BLANK.

This columns explains what each column is. It can be changed
to reflect the spoken language of the user.

DEFAULTS

NOTES

VALUE

[DATABASE]
Name:

MyDB

Hawkeye_DB_+Date+Time

Name:

OIL COMPANY

OIL COMPANY

Name:

MyProject

UOM:

Feet

Feet

Units of Measurement used in this project

GRID NORTH

GRID NORTH

The Reference direction is either True North or Grid North

Latitude,Longitude

Method Used to Describe the location
The location as described by Location Options

MyStructure

First Slot Name

Name of Structure/PAD

0
REFERENCE SLOT
SLOT1

0
First Slot is REF unless specified
SLOT1

Elevation above Sea Level
Make as many copies of this [SLOT/SITE] / [WELLPATH]
Name of Slot, Defaults to SLOT +Slotcount

Latitude,Longitude

Latitude,Longitude

34.564433,-91.34322333

Project Location

Name:

Proposed Plan

Proposal

Name of Well Path

Type:

PLAN

PROPOSAL

Type of Survey

0

0

Name of Database to Create

[FIELD/COMPANY]
[PROJECT]

DIRECTION REF:
Location Options:

Latitude,Longitude
Comma Separated Location: 34.564433,-91.34322333

Name of Project

[STRUCTURE]
Name:
Elevation:
[SLOT/SITE]
Name:
Location Options:
Comma Separated Location:
[WELLPATH]

RKB:
PBHL Target:

YES

YES

Use Default Casing?:

YES

YES

Use Default Lithology?:

YES

YES

MD,INC,AZM

MD,INC,AZM

Data Options:

Automatically Generate a Default Target for end of well

Order of the data to be inserted below this point for this PLAN or SURVEY

0,0,0
2000,0,0
2500,90,34.33
6000,90,34.33
< Insert Surveys here…
[TARGET]
SHAPE:

CYLINDER
TVD
Location Options Latitude,Longitude
Comma Separated Location: 34.564433,-91.34322333
Depth Type:

Comma Separated Parameters:

5,BLUE,100

Cylinder
TVD
EW,NS
End of Proposed Path
Thickness,Color,if CUBE then SIDEA,SIDEB,If CYLINDER then Diameter if
POLYGON then EW,NS, Pairs)

5,Blue, 100

[JOB DATA]

Default Job for ALL wells: YES
Job Number: New Job
Lease Well: Lease

If more than one Job is selected this will be ignored
Internal Reference number used by company
Lease / Well Description

Location:
API JOB#:

Whatever

Legal Description of Wellsite location

3234323

Official Reference Number used by local government

Rig Name:
Country:

Big Rig

Name of Rig

USA

Country where Well Site is located

State/Provence: TEXAS
County/Parish/Bourough Harris
Comment:

County or Provence

This job is an example job being
used to illustrate how the use
the Hawkeye ScratchPad

Comment about Job

[CASING]
Default Casing?
Depth Type:

YES
TVD

Casing Size, Wt
20,94
CASING2: 13 3/8,80.7
CASING3: 7 5/8,55.3
CASING1:

Determines if this casing profile is to be applied to all wellpaths

YES
TVD
Top Depth, Bottom Depth
,0,300
,300,4000
,0,5000

ADD ",TOP,BOTTOM" TO THE SELECTED WT AND SIZE OR LEAVE BLANK
REMEMBER TO START THE SECOND COLUMN WITH A ',' (comma)

CASING4:
CASING5:
CASING6:
CASING7:
CASING8:
<<<<<< Insert Additonal Casing Here

INSERT MORE CASING ROWS IF NECESSARY
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Three Steps to Grabbing Data from ScratchPad

STEP ONE: In the spreadsheet, when selecting a body of data, select the
entire category. Then right-click and hit “copy.”
STEP TWO: In HawkEye, be sure to select the wellpath that you want your
copied data to be associated with, if applicable.

STEP THREE: In HawkEye, right-click anywhere in the 3D space in, and
select “Paste ScratchPad.”
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Each one of the data groups in the spreadsheet can be copied and pasted into Hawkeye
independent of one another. Hawkeye will figure out the “context” of the data but only
for the selected wellpath.
For example, if you cut and pasted a Casing Group, Hawkeye would apply it to the
current focused wellpath, replacing the one that was there if it already existed. If a
Database group is included in the pasted data, Hawkeye will check to see if that name
already exists and open it if it does, otherwise Hawkeye will create a new database with
the specified name. The same goes for any named group. If it exists already, Hawkeye
will set its focus there.
If it does not exist, it will create a new object as long as the information provided is
properly formatted. The included spreadsheet found in Hawkeye/ScratchPad,
HawkeyeScratchpad.xlsx, is a good starting point to see how the data is formatted.
If you copy and paste all the data from the default spreadsheet described above, you
would have created two slot/wellheads and two well paths along with a platform/pad,
casing for a well, lithology, hard lines and lease lines. In some cases special flags have
been set indicating to Hawkeye how to handle the data. In other cases defaults are
indicated if no value is given.
If Hawkeye absolutely has to have some data, it will stop and inform you. This
spreadsheet has in effect been our “scratch pad” for laying out the project; now all we
have to do is cut and paste into HawkEye. HawkEye will parse each section and create
all the objects. It will figure out where we are in the world from the latitude and
longitude provided and what is the most probable Geodetics for that area.
Where Township, Section and Range are used the program will automatically
determine the TSR and the map offsets AND it will create a lease line for display!
Note that the first slot/wellhead’s location was specified with Lat and Long and the
second slot/wellhead was specified with EW and NS. The first slot/wellhead was
specified as the Reference which indicates that it is the zero, zero from which other
slot/wellheads can be measured. The second slot/wellhead could have been specified
with Lat and Long instead of EW and NS.
The advantage to this mode of data preparation is that it divorces the user from the
Hawkeye interface until needed. This means that other people can work on the data
preparation, doing their part; when all is ready, it can be collected on to a single
spreadsheet, then copied and pasted into HawkEye.
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3. Platform/Pad Manager

Well Planning Version ONLY
The Platform/Pad Manager, which is only available in the Well Planning Version of
HawkEye, is used to start a multiple-slot/wellhead project quickly. It organizes any
number of initial slot/wellhead points and numbers them in a user-defined pattern.
Their positions can be defined by any of the possible patterns found in the field, and can
save a lot of time in getting the slot/wellheads made in the project database.
OPEN THE PLATFORM/PAD MANAGER: Right-click on the
Platform/Pad icon
found in the Data Tree on the lefthand side of
the main screen. This will open up the Platform/Pad submenu.
Select the Platform/Pad Manager
from this list. The slot/wellheads
made from here will be associated with that platform/pad that was
right-clicked on.
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The panel on the right-hand side of the Platform/Pad Manager is dedicated to the
placement and labeling of the slot/wellheads:
GROUP STYLE: The general orientation of
the slot/wellhead group can be rectangular,
circular or custom. (NOTE: Custom option
is not available in current version).

LABEL STYLE, ORDER & DIRECTION:
These options create the way the
slot/wellheads are numbered, and cover all
iterations of sequential labeling for
rectangular and circular slot/wellhead
groups. The START CORNER radio
buttons determine where the sequential
labeling begins. Additionally, the slider in
the bottom left corner of the picture window toggles label orientation.
SIZING: Bearing and distance between each slot/wellhead can be defined here.
ASSOCIATE WITH: Any of the slot/wellheads can be designated as the Reference
Slot/Wellhead, and that Reference Slot/Wellhead can be associated with either another
slot/wellhead or the current Platform/Pad. The Reference Slot/Wellhead can also be
given a coordinate offset.
EXCEL: Once a slot/wellhead group has
been set up, click the “EXCEL” button and
the slot/wellhead coordinates will be
exported into an Excel spreadsheet,
complete with a floating picture of the
slot/wellheads that can be placed anywhere
on the spreadsheet.
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ADD GROUP: Any set of slot/wellhead parameters can be saved as a custom group by
clicking on the “Add Group” button at the top of the Manager.

CLICK “SAVE” FIRST: Once a Platform/Pad’s
slot/wellheads are labeled and oriented, click the SAVE
button. Then click “APPLY TO SLOT/WELLHEADS.”
This will close out the Platform/Pad Manager and begin
building each slot/wellhead under the current
platform/pad. Those slot/wellheads will appear in the 3D
space as well as in the Data Tree.
Each newly made slot/wellhead will have a survey and
proposal curve named after its slot/wellhead label.

NOTE: After a slot/wellhead group has been made and curves built from the respective
slot/wellheads, going back to change the orientation and labeling of the slot/wellheads
in the Platform/Pad Manager is not recommended. Thus it is best to get the details of
the slot/wellheads correct before beginning to build curves from any of the
slot/wellheads created.
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4. HawkEye™ Command

Well Planning Version ONLY
HawkEye™ Command is one of the most powerful tools in the user's arsenal. The
interface allows users to input direct text commands, which appear immediately in the
3D space as well as the database. They can bypass the graphical user interface (GUI)
and create new project data more directly. Once users know what strings of commands
they need on a regular basis, they can cut-and-paste long strings of commands (macros)
into the Command interface; their routine will be rendered every time.

a.

How to Access Command Line

At the top left of the “Special Tools” tab, click on the
“CMD” icon. This will toggle on and off the
Command bar at the very bottom of the screen.
When the Command window is open at the very
bottom, direct DOS-style commands can be given in
order to instantly generate various objects that will
appear in the 3D space or manage the data of the
current project. These commands can be referred to
by different names. The following section contains a
comprehensive list of each of these commands.
Type “?” at bottom for the list of all commands.

b.

How Command Works

THREE LINES: At the very bottom left, Command is composed of three lines. The top
line is the hint line. It informs the user of what is expected. The middle line has a
“Multi-Command” toggle button (This should be checked when one wants to type in
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more than one command before executing). The black field is for entering the actual
commands. The bottom line is a message line describing whatever has been entered.
When a command is typed into the black field, the lines above and below change to
accommodate that command. For example, when the command for defining a kickoff
point is typed, “KOP,” the remaining parameters are prompted above and a description
of the command is displayed below:

Here, the user typed “KOP” and Command automatically added the colon in the black
field. Above in red is the next and only parameter needed for this command, the
Measured Depth. Simply enter a number for the MD and hit ENTER. This will
automatically create a path with a KOP of whatever specified.
Some commands require more than one parameter after you type it in:

In the example above, the command “A1” invokes the Aligned Well command, which
requires a string of parameters. Enter those by typing in the data and hitting ENTER
AFTER EACH ITEM. For example:

In the example above, what was typed was:
“A123[ENTER]220[ENTER]3[ENTER]4[ENTER]”
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A breakdown of that command is: an aligned well, with an Inclination of 23 degrees,
Azimuth of 220 degrees, first DLS of 3 degrees per hundred, a second DLS of 4 degrees
per hundred, with the intent to strike the target named “TARGET1.”
As seen in the picture above, when it comes to entering a target (or curve) name,
Command automatically prompts the user with all available targets (or curves) in a
pulldown list. As can be seen above, two targets are available from the prompt. (Only
targets under the current platform/pad are available). Use the mouse or arrow keys to
choose one, then hit ENTER. This will finish the command and create what was defined
in the command string.

Mind the Backspace
HawkEye Command is a powerful tool which can be sensitive to a particular key, the
Backspace. When entering a command string, hitting Backspace to correct a typo is a
very instinctual thing to do. Avoid this tendency. When Backspace is pressed in the
middle of a command, unseen code that has been stacked and readied for execution
gets jumbled up, and the entire command is compromised.
So instead, hit the DELETE key to clear the line and start over. For longer multicommand strings in which re-typing would be a pain, it is a good idea to type it out
just right on a Notepad file and then copy-and-paste into Command.

MULTI-COMMAND STRINGS: First thing to remember: when the Multi-Command
mode is enabled, the ENTER key will not execute the string. It will merely prompt for
the next parameter or command. In order to submit a multi-command string, the user
must hit SHIFT.
Multi-command allows the user to daisy-chain a number of commands and execute
them all at once. This is where HawkEye Command really shines and can be an
enormous time-saver for well planners.
One example of a multi-command string would be the following:
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When “Multi-Command” is checked, the ENTER key will only end the command and
add a divider (NOTE: The divider ”|” is not the letter “I.” It is the character above your
ENTER key. You won’t need to type it10 but hold SHIFT to get to it.)
In the above example, there are three different commands, each divided by “|”:
Command #1:
NW:PROPOSAL1, PROPOSAL,0,BLUE
This means: new well with a name of “Proposal1,” being a proposal type (and not a
survey type well), with an RKB of 0 and the color blue.
Command #2:
HOLD:2000
Starting from the end of the previous command’s build (which was at RKB 0), hold in
the current direction for a straight 2000 feet.
Command #3:
SLANTDLS:3,TARGET1
Starting from the end of the previous straightaway, with a DLS of 3, build to Target1.
Remember to hit “SHIFT” at the end of a multi-command to finish it:

10

Actually, the “|” is needed if you type up long multi-command strings in a notepad file and
save them for use as custom profiles, then cut-and-paste them into HawkEye when needed.
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In one simple Multi-Command like this, the user can create a proposal well, drill down
2000 feet, then break off with a DLS of 3 to hit a previous made target at 8000 feet.
More examples of multi-commands are provided in one of the following subsections.
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c.

The List of Commands

NOTE: To pull up the following list of commands in HawkEye, just enter “?” into the
Command line at the bottom.
In the list below, the primary name of the command is shown; that is the standard
name. (e.g. 'SLANTDLS' can be referenced with 'SD', and 'SLANTHOLD' can also be
referenced with 'SH').
The list of parameters for each command are shown. In order for the command to be
successfully implemented, the user should select a value for each parameter. A few
commands don't have any parameters; the '?', for example, immediately displays this
help screen. The commands below are displayed in there general groupings.

a. Data Types

In the list, a letter is assigned to each of the listed commands to indicate its data type.
A - Alpha-Numeric
N - Number : [Min Value, Max Value]
O - Options: [Options are in brackets]
L - Lookup: Usually points to data lists that need to be populated but also is used
to open special Hawkeye Forms for easier input.

b. Special Function Keys

Erases the last command in the Command Line. Applying repeatedly will erase
the entire line.
Jump to the end of the Command Line.

Navigate the command line without automatically invoking popup screens
when a popup parameter is encountered. To force the popup, click on the
item.
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b.

The Command List

Command Name: New Well - aka > NW, NEW WELL, NEWWELL
Purpose: Creates a New wellpath
Parameters:
• Name - A
• Type - O[Survey|Proposal]
• RKB - N[0|1000]
• Color - L[Color]
Command Name: Sidetrack - aka > SIDETRACK, ST
Purpose: Creates a named Sidetrack from specified curve and makes it the focus point
Parameters:
• From Wellpath Name - L[Wellpath]
• Type SideTrack - O[Survey|Proposal]
• Sidetrack Name - A
• Measured Depth - N
• Color - L[Color]
Command Name: ADD Survey - aka > ADD SURVEY, AS
Purpose: Add as survey to the current Work Curve
Parameters:
• MD - N[0|50000]
• INC - N[0|180]
• AZM - N[0|360]
• Comment - A
Command Name: ADD Course Length Survey - aka > ADD CL SURVEY, ACL
Purpose: Add current course length to last MD for New MD as survey to the current
Work Curve
Parameters:
• CL - N[0|50000]
• INC - N[0|180]
• AZM - N[0|360]
• Comment - A
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Command Name: Auto Comments - aka > MKCOM
Purpose: Create comments automatically for current proposal curve
Command Name: Make target plane - aka > MKPLANE
Purpose: Make target plane from the last station of current proposal curve
Command Name: Add Surveys - aka > SURVEYLIST
Purpose: Invokes the survey editor so user can add more than one survey
Parameters:
• Curve Name - L[Wellpath]
Command Name: Rotate Plan - aka > ROTATEPLAN, RP
Purpose: Rotate the current plan with an input angle.
Parameters:
• Angle - N[-360|360]

PROJECTION TOOLS
Command Name: SLANTDLS - aka > J, SLANTDLS, SLANT, SLANTWELL
Purpose: Creates a Slant projection to named target using DLS specified
Parameters:
• DLS - N[0|120]
• Target Name - L[Target]
Command Name: Aligned Well - aka > ALIGN1, A1
Purpose: Creates an aligned path to Target Name at INC and AZM using DLS1 to
Build and DLS2 to turn
Parameters:
• Inc - N[-180|180]
• Azm - N[0|360]
• DLS1 - N[0|120]
• DLS2 - N[0|120]
• Target Name - L[Target]
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Command Name: Aligned Well - aka > ALIGN2, A2
Purpose: Create an aligned projection with DLS1 and DLS2 so that Target1 is lined up
with Target2
Parameters:
• DLS1 - N[0|120]
• DLS2 - N[0|120]
• Hold - N[0|50000]
• Target Name1 - L[Target]
• Target Name2 - L[Target]
Command Name: Vectored Curve - aka > VECTORED CURVE, VC
Purpose: Creates a wellpath that aligns Target1 and Target2 with the specified DLS's.
KOP is solved.
Parameters:
• DLS1 - N[0|120]
• DLS2 - N[0|120]
• Target Name1 - L[Target]
• Target Name2 - L[Target]
Command Name: SlantHold - aka > SLANTHOLD, SH
Purpose: Creates Slant Projection with specified Hold Angle to Target
Parameters:
• Hold Angle - N[0|180]
• Target - L[Target]
Command Name: Back On Track - aka > BACKONTRACK, BOT
Purpose: Creates a projection from the Work Curve to the Proposed Curve with
specified parameters
Parameters:
• DLS1 - N[0|120]
• DLS2 - N[0|120]
• Distance - N[0|50000]
• HoldDLS1 - O[Yes|No]
• HoldDLS2 - O[Yes|No]
• HoldDistance - O[Yes|No]
Command Name: SLANTKOP - aka > SLANTKOP, SK
Purpose: Finds the KOP for a Slant well with given Hold Angle and DLS to specified
Target
Parameters:
• Hold Ang - N[0|180]
• DLS - [N[0|120]
• Target - L[Target]
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Command Name: SWELLKOP - aka > SWELLKOP, SWK
Purpose: Finds the KOP for a SWELL with given parameters
Parameters:
• DLS1 - N[0|120]
• HoldAngle - N[0|180]
• DLS2 - N[0|120]
• EntryAngle - N[0|180]
• Extension - N[0|10000]
• Target - L[Target]
Command Name: NUDGEDLS - aka > NUDGEDLS, ND
Purpose: Creates a Nudge Projection using DeltaMD and DLS at TFO
Parameters:
• DeltaMD - N[-20000|20000]
• DLS - N[0|120]
• TFO - N[-180|360]
Command Name: NudgeINCAZM - aka > NUDGEINCAZM, NI
Purpose: Creates a Nudge Projection to given Inc and Azm at specifed DLS
Parameters:
• Inc - N[0|180]
• Azm - N[0|360]
• DLS - N[0|120]
Command Name: NudgeTVD - aka > NUDGETVD, NT
Purpose: Creates a Nudge Projection to a TVD with Inc and Azm specified
Parameters:
• Inc - N[0|180]
• Azm - N[0|360]
• TVD - N[0|50000]
Command Name: HoldMD - aka > HOLDMD, STRAIGHT, HOLD, HD, KOP
Purpose: Creates a straight line projection by Delta MD
Parameters:
• DeltaMD - N[0|50000]
Command Name: HoldTVD - aka > HOLDTVD, HT
Purpose: Creates a straight line projection by Delta TVD
Parameters:
• DeltaTVD - N[0|50000]
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CURVE NAVIGATION
Command Name: Focus - aka > FOCUS
Purpose: Sets the viewer's focus to either the work curve or the proposal curve at the
beginning or end
Parameters:
• Focus Curve - O[WORKCURVE|PROPOSAL CURVE]
• Location - O[BEGINNING|END]
Command Name: Switchto - aka > SWITCHTO
Purpose: Switches to different project or wellpath and sets focus
Parameters:
• Object - O[Wellpath|Slot/Site|Project]
• Name - L[Object]
Command Name: Turn On/Off - aka > ONOFF
Purpose: Turn on/off the selected flag.
Parameters:
• Flag - O[Target Names|Target Bounding Box|3D Information|Walls|Curve
Bounding Box|Curve Vertical Line|TFO Arrow|Projection Comments|2D Ellipses|Use
Texture For Cylinder]
• On/Off - O[On|Off]
Command Name: MoveToMD - aka > MOVETO MD
Purpose: Moves focus to MD on designated wellpath
Parameters:
• Wellpath - L[Wellpath]
• MD - N[0|50000]
Command Name: Moveto TVD - aka > MOVETO TVD
Purpose: Moveto TVD of given wellpath
Parameters:
• Name - L[Wellpath]
• TVD - N[0|50000]
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Command Name: Advance MD - aka > +
Purpose: Advances the focus pt on current wellpath relative to the beginning
Parameters:
• DeltaMD - N[-50000|50000]
• Relative - O[Relative|Absolute]
Command Name: Go Back MD - aka > Purpose: Backs up focus from THE END of the current wellpath
Parameters:
• DeltaMD - N[-50000|50000]

TARGET DEFINERS
Command Name: TargetDef1 - aka > TARGETDEF1, T1, TNSEW
Purpose: Creates a New Target using NS and EW Local coordinates
Parameters:
• Name - A
• TVD - N[0|50000]
• NS - N[-50000|50000]
• EW - N[-50000|50000]
Command Name: TargetDef2 - aka > TARGETDEF2, T2, TCLDIR
Purpose: Creates a New Target using Closure and Closure Direction to define Local
coordinates
Parameters:
• Name - A
• TVD - N[0|50000]
• Closure - N[0|50000]
• ClosureDir - N[0|360]
Command Name: TargetDef3 - aka > TARGETDEF3, T3, TLATLONG
Purpose: Creates a New Target using Latitude and Longitude Geographic coordinates
Parameters:
• Name - A
• TVD - N[0|50000]
• Latitude - N[-89.99999|89.99999]
• Longitude - N[-180|180]
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Command Name: TargetDef4 - aka > TARGETDEF4, T4, TGRIDYX
Purpose: Creates a New Target using GridY(Northing) and GridX(Easting) Geodetic
coordinates
Parameters:
• Name - A
• TVD - N[0|50000]
• GridY - N
• GridX - N
Command Name: HorzPlaneDef1 - aka > HORZPLANEDEF1, H1, HNSEW
Purpose: Creates a New Target on a plane using NS and EW Local coordinates
Parameters:
• Name - A
• Plane - L[TARGETPLANE]
• NS - N[-50000|50000]
• EW - N[-50000|50000]
Command Name: HorzPlaneDef2 - aka > HORZPLANEDEF2, H2, HCLDIR
Purpose: Creates a New Target on a plane using Closure and Closure Direction to
define Local coordinates
Parameters:
• Name - A
• Plane - L[TARGETPLANE]
• Closure - N[0|50000]
• ClosureDir - N[0|360]
Command Name: HorzPlaneDef3 - aka > HORZPLANEDEF3, H3, HLATLONG
Purpose: Creates a New Target on a plane using Latitude and Longitude Geographic
coordinates
Parameters:
• Name - A
• Plane - L[TARGETPLANE]
• Latitude - N[-89.99999|89.99999]
• Longitude - N[-180|180]
Command Name: HorzPlaneDef4 - aka > HORZPLANEDEF4, H4, HGRIDYX
Purpose: Creates a New Target on a plane using GridY(Northing) and GridX(Easting)
Geodetic coordinates
Parameters:
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•
•
•
•

Name - A
Plane - L[TARGETPLANE]
GridY - N
GridX - N

Command Name: Make Target to Right or Left - aka > DEFTARGR-L, MTRL
Purpose: Create a Target NAME left or right of MD on WELLPATH, DISTANCE from
point. (Multilateral uses)
Parameters:
• Target Name - A
• Wellpath - L[Wellpath]
• FromMD - N[0|50000]
• Distance(Left is negative) - N[-10000|10000]

EDITING TOOLS
Command Name: Edit Target - aka > EDIT TARGET
Purpose: Edit an existing Target
Parameters:
• Scope - O[Slot|Structure]
• Target - L[Target]
Command Name: Edit Structure - aka > EDIT STRUCTURE
Purpose: Edit Existing Structure definition
Parameters:
• Name - L[Structure]
• Elevation - N[0|30000]
Command Name: Edit Slot - aka > EDIT SLOT, EDIT SITE
Purpose: Edit an selected slot definition
Parameters:
• Name - L[Slot]
Command Name: Edit Wellpath - aka > EDIT WELLPATH, EDIT PATH
Purpose: Edit an existing wellpath
Parameters:
• Name - L[Wellpath]
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Command Name: Fix To End - aka > FIXTOEND
Purpose: (Proposal curve only) Shifts the entire curve such that the end of the
current curve ends at the input TVD, and extends the beginning of the curve vertically
all the way back up to the surface. Use this to build your curve first, then drop it down
to the desired TVD. (Use a negative value to reduce final TVD).
Parameters:
• Delta TVD – N[-10000|20000]
Command Name: Fix To TVD - aka > FIXTOTVD
Purpose: (Proposal curve only) Shifts the entire curve up or down the specified depth
in TVD. Any additional distance from the surface is automatically extended vertically.
Use this to shift an entire curve a specified depth. (Use a negative value for a reduction
in TVD).
Parameters:
• To TVD – N[-10000|20000]
Command Name: Rotate To - aka > ROTATETO
Purpose: Rotates the current curve to a specified final angle. Useful in adjusting an
entire plan.
Parameters:
• Input Angle – N[0|360]
Command Name: Surface From - aka > SURFACEFROM
Purpose: Solves for a surface location by attaching the end of the current curve to a
specified target (retaining final INC and AZM), then extending the beginning of that
curve all the way up to the surface. (NOTE: Every time you execute this command, it
creates a new slot with a new curve that hits your target).
Parameters:
• Target - L[Target]
Command Name: Edit Project - aka > EDIT PROJECT
Purpose: Edit an existing project definition
Parameters:
• Name - L[Project]
Command Name: Edit Job - aka > EDIT JOB
Purpose: Pops up a Data Entry form for the job data
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Parameters:
• JobID - L[JOB]
Command Name: Make Project - aka > MAKE PROJECT, CREATE PROJECT
Purpose: Make New Project definition
Parameters:
• Name - A
Command Name: Make New Slot - aka > MAKE SLOT, MAKE SITE, CREATE

SLOT, CREATE SITE

Purpose: Create a new Slot definition with option that sets new slot as the referenced
slot
Parameters:
• Name - A
• Set As Referenced Slot - O[Yes|No]
Command Name: MAKE Structure - aka > MAKE STRUCTURE, CREATE

STRUCTURE

Purpose: Add New Structure definition
Parameters:
• Name - A
• Elevation - N[0|30000]
Command Name: Delete - aka > DELETE, DEL, ERASE
Purpose: Deletes one of the objects from the database.
Parameters:
• Object - O[Project|Structure/Pad|Slot/Site|Wellpath|Target\line
• Name - L[Object]

SPECIAL EDITING
Command Name: MagSwing - aka > MAGSWING, MS
Purpose: Adjust the direction of the Wellpath fromMD toMD for Magnetic Ranging
Parameters:
• Wellpath - L[Wellpath]
• FromMD - N[0|50000]
• ToMD - N[0|50000]
• Right - Left (Left is negative) - N[-10000|10000]
• Confidence - N[-10000|10000]
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FILE MANAGEMENT
Command Name: Save - aka > SAVE
Purpose: Saves Current Log file to text file
Parameters:
• Filename - A"

Command Name: Load - aka > LOAD
Purpose: Loads and attempts to execute a Saved Log File
Parameters:
• Filename - A
Command Name: LogOn - aka > LOGON
Purpose: Starts a log file of the command lines that are input
Parameters:
• Filename - A
Command Name: LogOff - aka > LOGOFF
Purpose: Turns Off the command line logging
Command Name: REPEAT Command Line - aka > REPEAT
Purpose: Repeat command line operations(Only can be used with Relative Navigation)
Parameters:
• Number of Times - N[0|100]
Command Name: Help - aka > ?
Purpose: Directs user to different types of help
Parameters:
• TypeHelp - O[Quick Screen]
Command Name: Show Curves - aka > SHOW CURVES, SC
Purpose: Turn on or off different curves
Parameters:
• On or Off - O[On|Off]
• Scope - O[Project|Current Slot|All]
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REPORTING
Command Name: Survey Report - aka > SURVEY REPORT, SR
Purpose: Invokes survey report for named wellpath
Parameters:
• Curve Name - L[Wellpath]
Command Name: Critical Points Report - aka > CRITICAL POINTS REPORT,

CR

Purpose: Invokes Critical Points Report for named wellpath
Parameters:
• Curve Name - L[Wellpath]
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d.

Multi-Command

The Command interface can receive multiple commands simultaneously. This is where
the power of the interface lies: in being able to create long custom strings of commands
and simply cut-and-paste them into Command.
To enable multiple commands, check the “Multi-Command box” on the left.

Some examples of multi-commands are illustrated below:

Example 1: Create an Aligned Well to Hit Two Targets
Take a look at the multi-command string entered here:

There are four commands contained in this line:
Command #1:
NW:PROPOSAL2,PROPOSAL,0,BLUE
NW stands for New Well, here named “Proposal2” and designated a proposal-type
curve (as opposed to a survey curve), with a TVD or starting point of 0 feet, and the
color blue.
Command #2:
HOLD:1000
Hold for a straight measured depth of 1000 feet.
Command #3:
NUDGEINCAZM:15,100,3
From the end of the straight tangent, build a nudge section with an inclination of 15
degrees, an azimuth of 100 degrees, and a dogleg of 3 degrees per 100. (Remember that
you can use the shortened version of the longer worded commands. In this case,
“NUDGEINCAZM” can also be entered as “NI.”)
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Command #4:
ALIGN2:2,4,200,TARGET1,TARGET2
At the end of the nudge section, build an aligned projection with an initial DLS of 2, a
second DLS of 4, a 200 degree hold angle, and designation to hit the targets “Target1”
and “Target2” in that order.
Remember to press the SHIFT key to finish a multi-command. This is the result:

Notice in this example that you must already have your targets made, but everything
else has been generated from the command itself.
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Example 2: Create a spiraled or pattern well
The “ACL” command stands for Add Course Length. It is useful for adding a short
segment to the end of a curve with its own inclination and azimuth. In HawkEye,
Added Course Length only applies to the work curve .
REALISTIC LOOKING WELL: The effect of the same Added Course Length repeated
over and over with a uniform relative inclination and azimuth can create a realistic
spiraling well. This can be useful when a realistic-looking survey curve is needed
quickly, without having to use real data or build the curve piece by piece. It’s simply
done by defining one bit of course length with inclination and azimuth, then repeating
it a number of times with a relative added value:
Start with a work curve that ends at 100
feet. Actually, for this illustration, it does
not matter where the work curve ends. But
remember that the Add Course Length
(ACL) command starts at the end of the
selected work curve.

Then enter the multi-command:

The command here breaks down as two separate commands:
Command #1
REPEAT:60
Note: when the user types “repeat” into the Command line, the “Multi-Command” box
will automatically be checked on. This is because “Repeat” cannot be used without at
least one other command. Here, the command is to execute whatever follows 60 times.
The REPEAT command requires that any objects it replicates contain at least one
dynamic parameter (a number preceded by either “R” or “P”).

206
HawkEye

TM

User’s Manual

Copyright © 2015 by Performance Drilling Technology

Command #2:
ACL:10,R.5,R-3.2,SPIRAL
Add course length of 10 feet, with an inclination of a RELATIVE 0.5. The “R” added
before the inclination value means that the segment will be 0.5 degrees more than the
previous segment’s inclination. As for the following “R-3.2,” which defines the azimuth,
it means that the segment is to take an azimuth of 3.2 degrees going counter-clockwise
from the previous segment’s azimuth. (A positive azimuth value would be clockwise).
These relative (“R”) values are how organic and realistic curves are built, since each
little added segment is going to build relative to the previous one in a set pattern.
The final word in the command, “SPIRAL,” is merely a comment to be inserted
at every course length. To skip adding a comment, just hit SPACE, then ENTER.
Press “SHIFT” to end the multi-command and submit it for calculation:

Notice at the top of the string of added course lengths how it seems straight, but then it
begins a parabolic arc that is not symmetrical. This sort of build mimics the geometry of
actual as-drilled wells. If the command had been repeated a 1000 times instead of 60, a
spiral would take shape in some unique fashion.

“REPEAT” Needs at Least One Dynamic Parameter
When “R” is entered before a parameter, it is signaling that value to be either more than
the previous iteration of that value. Thus, when using the REPEAT command, the “R”
modifier is absolutely necessary for at least one parameter (or the “P” randomizer, see
more below). Why? Because with just absolute hard parameters and no dynamic
parameters, REPEAT will generate the same object in the same place over and over.
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Example 3: Create a realistic random wandering well
Using the same tools as in the previous example, REPEAT and ACL, users can generate
a wandering curve with random (within a given range) parameters. This would have
the same use as the spiraling curve from the previous example: to display a real-looking
as-drilled well quickly and without having to use actual surveys or build it piece by
piece.

Here there are two commands:
Command #1:
REPEAT:50
Note: when the user types “repeat” into the Command line, the “Multi-Command” box
will automatically be checked on. This is because “Repeat” cannot be used without at
least one other command. Here, the command is to execute whatever follows 50 times.
Command #2
ACL:30,P1.5,P-5 [space]
Added course length of 30 feet, with an inclination of “P 1.5.” The “P” before this
parameter indicates a range of Probabilities. When “P1.5” is entered, HawkEye will
generate a new value for each repeat ranging from -1.5 to 1.5 degrees. The second
parameter for azimuth is entered “P-5.” This means the value will be randomized
between -5 and 0. Hit SPACE to skip entering a comment, then ENTER.
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Press “SHIFT” to end the multi-command and submit it for calculation:

What is generated here is not a provocative spiral or pattern. When the “P”
(randomized) parameters are entered conservatively, like in this example, a very subtly
imperfect wellpath. In the picture above, you have to squint to notice the accumulated
curvature created by the randomization ranges of the inclination and azimuth over 1500
feet (30ft course length addons X 50 repeats).
But this is an exquisitely fast and easy way to create realistic looking and feeling curves
in HawkEye without having to enter or port in actual survey data.

“P” Stands for Probability
When “P” is entered before a parameter in Command, it designates the following single
number to establish a range. How can a single number define a range? Here’s how:




When the number has no symbol, it goes both ways: (P10 makes -10 to 10).
When the number has a + symbol, it goes from zero up: (P+10 makes 0 to 10).
When the number has a – symbol, it goes from zero down: (P-10 makes -10 to 0).
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c.

Advanced Multi-Commands and the Target Array

The Target Array tool allows the user to select any sequence of targets for
multiple-target projections. Such setups can only be taken advantage of in the
HawkEyeTM Command interface. It acts as a list of targets in sequential order
which satisfy targeted projections as they (the projections) are
generated in a repeating pattern command. A target array, or
user-defined sequence of targets, can be associated with a specific
curve, or one may be set up generically.
OPEN THE TARGET ARRAY: To find the Target Array button,
right-click on either the work curve
or the proposal curve
in the Data Tree. You may also right-click on any curve in the 3D
space. Once the right-click menu pops up, select “Target Array” towards the top of the
list.Or open up the Target List and toggle the “Show TARGET ARRAY” box on the left.
Once the Target Array dialogue is open, you will notice that it contains the Target List
and the Adjuster dialogues within it.
These internal instances of the List and Adjuster have all of the functionality that they
would normally have, so the user can edit all target parameters here while also
assigning targets to a specific array, or sequence.
The Target Array works simply by selecting from the
lefthand list of available targets and ordering them in
the righthand column. Use the transfer (<< and >>) and
“Up” and “Down” buttons to transfer and order the
targets.
The column of “available targets” on the left can only be
edited through the Target List.
Watch how the Target Array is used in the following example.
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Advanced Example 1: Create Four Targets and reach them with Sidetracks
The following example involves four steps: 1) Creating an initial target and proposal, 2)
Create four more targets, 3) Add those four to a target array, and 4) Generate a series of
sidetrack proposals that hit every target in the array.
The example is provided to illustrate several key functions of Command. Namely that
the user can generate a series of targets placed at precise perpendicular vectors away
from a curve, and that the user can use the target array to hit those vectors with
sidetrack proposals. All in two commands.
STEP ONE: CREATE AN INITIAL TARGET AND PROPOSAL:

Once a user creates a target with Command, they may find it faster and easier than with
the GUI.
After making the target, the next step is to create a proposal and build it as a slant:
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Command #1
NW:PROPOSAL5,PROPOSAL,0,GREEN
This creates a New Well named “Proposal5,” and is designated as a proposal curve (as
opposed to a survey/work curve), with a TVD of 0 feet, and the color greent
Command #2
SLANTKOP:90,3,TARGET5
The “SLANTKOP” command can also be typed in as “SK.” This command finds the
kickoff point for a slant well when given a specific hold angle and DLS to a specified
target. Here, the slant proposal is given a hold angle of 90 degrees, with a DLS of 3
degrees per hundred, and told to hit “Target5.”

Notice the vertical section graph, how the command creates a hold angle of 90 degrees
and a DLS of 3.
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STEP TWO: CREATE FOUR TARGETS WITH POSITIONS RELATIVE TO THE CURVE:
The next command will create two targets to the left of the curve, and two to the right.

Command #1
MOVETO MD:PROPOSAL5,8000
The “Move To” command is handy, but make sure to add a SPACE after “MOVETO.”
Here, we move our focus point to a particular measured depth on the curve named
“Proposal5,” at an MD of 8000 feet.
Command #2
REPEAT:2
This will execute whatever comes next 2 times.
Command #3
MTRL:RIGHT,PROPOSAL5,R1000,880
The “MTRL” command stands for Make Target Right Left, and will create targets
respective of the current focal point on the current curve, to the right and/or left. Here,
the name of the target is “Right,” and location is based off of “Proposal5,” with an MD
of “R1000.” The “R1000” means that it is built another 1000 feet MD beyond the current
MD (so 8000+1000). The final parameter is 880 feet from the new focal point of 9000 MD,
due right from an exact perpendicular angle from that point on the curve. It is at that
point that a target is created.
Command #4
MTRL:LEFT,PROPOSAL5,R0,-880
The MTRL is invoked again, this time creating a target called “Left,” based on the curve
called “Proposal5.” This target is located off of MD “R0,” which means it’s a Relative 0
feet from the last focal point. The last focal point remained at 9000 feet (see command
above). From that point, the distance is -880 feet (negative value means left of the
curve). So a target is made at the same MD as the last target, but at the exact distance
the other way.
Since these two commands are repeated once, an interesting thing happens. Those
Relative MDs are repeated relative to their previous iterations. They build on each
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other. So in the first target, the MD was R1000 to the right, then R0 to the left, then
R1000 to the right, and R0 to the left. This translates in actual MD to 9000, 9000, 10000,
10000. The result is a uniform placement of targets to the left and the right.

With the MTRL command, targets are created in a perpendicular line away from the
target at a specified MD, either to the left or to the right. Using Relative (R) MD values
and the REPEAT command, ladder-like or staggered target patterns can be created
along the curve.

STEP THREE: ASSIGN THE TARGETS TO A TARGET ARRAY:
Finally we get to see how the target array works. As mentioned at the beginning of this
section, the user can access the Target Array setup by getting to the Target List in any
number of ways. NOTE: Here it is important to right-click on the proposal curve and
access the Target List there, in order to build a Target Array that is associated with
the curve.
Check the “Show TARGET ARRAY” box on the left inside the List, and the dialogue
will appear. Order the targets into an array in the following order: Right1, Left1, Right2,
Left2.
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Putting them in the wrong order will render the next command in this example rather
useless.

STEP FOUR: GENERATE A SERIES OF SIDETRACK PROPOSALS TO HIT THE ENTIRE ARRAY
The principle here is to use the initial proposal curve as a launch point for each
sidetrack. Each of the sidetracks is defined by a nudge section and a slant projection.
The command looks like this:

This is seven commands: a repeat, create sidetrack right, make it a slant, give it a nudge,
then create sidetrack left, make it a slant, give it a nudge. Here are the commands in
detail. Note, we are already starting at an MD of 5000.
User can put in “MOVETO[space]MD:PROPOSAL5,5000” (or type it into the focal point
box just under the bottom left corner of the 3D space and hit “TAB”):
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COMMAND #1
REPEAT 2
Execute the following commands twice.
COMMAND #2:
ST:PROPOSAL5,PROPOSAL,SD_R,R1000,BLUE
Create a SideTrack with “ST.” Here, it is based off of Proposal5, designated a proposaltype (as opposed to a survey/work curve), named “SD_R” and given a kick off MD of
“R1000.” The R1000 means that it will kick off relatively 1000 feet further than the
current focal point. Since the current focal point was set at MD 6000ft, this sidetrack will
kick off at MD 7000ft.
COMMAND #3:
ND:300,7,90
The NudgeDLS tool requires a DeltaMD, here 300 feet, a DLS which here would be 7
degrees per hundred, and a TFO, here 90 degrees.
COMMAND #4:
J:5,TARGET ARRAY
The “J” command creates a slant or J-well curve, which here is defined by a DLS of 5
and a target of… Target Array. This is where the Target Array comes into play. Instead
of designating a single target, we have a sequence of them that will be hit in succession
as this command string is repeated and targeted projections are generated several times.
COMMAND #5:
ST:PROPOSAL5,PROPOSAL,SD_L,R0,ORANGE
This creates another set of SideTracks, based again off the Proposal5 curve, designated
as proposal-type curves themselves, named “SD_L” and given a kick off MD of “R0.”
The “R0” means that it will kick off 0 feet past the last known focal point, so just
opposite its rightside counterpart defined above. Color orange.
COMMAND #6:
ND:300,7,270
The NudgeDLS tool requires a DeltaMD, here 300 feet, a DLS which here would be 7
degrees per hundred, and a TFO, here 270 degrees. The TFO is 180 degrees more than
the rightside sidetracks because we want to go in the opposite direction.
COMMAND #7
J:5, TARGET ARRAY
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Just as with the righthand side, the slant portion of the sidetracks are created with a
DLS of 5 and the target array as targets.

The reason that the Target Array (composed of four targets) works in this multicommand is because the command string itself calls for four targets.
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5. Uncertainty Options

RECALCULATE MODEL (F9): This button will refresh all uncertainty calculations,
something that happens automatically when changing parameters, but should be done
if any aberrations are observed in the 3D display of uncertainty.
DISPLAY MODE: The “Display Mode” dropdown list contains a number of
checkboxes that allow for display of various aspects of the uncertainty:
 No display (F3)
 Ellipsoid (F4)
 Ellipsoid with Wire Cylinder (F5)
 Wire Cylinder (F6)
 Ellipsoid with Solid Cylinder (F7)
 All Solid Cylinders (F8)
Each of these options shows either the true shape of the zone of uncertainty at any
given MD (typically a sphere near the surface and an ellipsoid near the bottom). Or it
will show the outer edge of all the zones of uncertainty combined, creating cylinderlike shape along the wellpath.
ISCWSA SIGMA: Adjusting this value controls the confidence level to be calculated by
the ISCWSA model. For example, let’s say the confidence level is 95%, or 2 sigma in
statistics jargon. What this means is an ellipsoid displayed along the well will illustrate
the volume for which we have 95% certainty that the true survey point is in that
volume. The larger the confidence level, the bigger the ellipsoid. Most operators use
two sigma or three sigma confidence levels, two sigma being the most common.

ADVANCED UNCERTAINTY OPTIONS: These options apply only to the 3D space.
Most of them require that the Proximity Calculation be turned on. Turn on Proximity by
opening the “Proximity” tab on the right panel of the main screen and checking
“Calculate Proximity.”
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Some of these options are greyed out, unless others of these options are activated.
OPTION

DESCRIPTION

Show Ellipsoid
(Alt+M)

This turns on the 3D ellipsoid at the
current focus point. Right clicking
on this ellipsoid will show the
dimensions.

With 3D Vectors
(Alt+X)

(requires “Show Ellipsoid” turned
on) This turns on the axes of the
ellipsoid, also referred to as
Eigenvectors. The purpose of
showing these is to lend confidence
that the ellipsoid is properly
constructed.

Show LD Ellipses
(Alt+E)

(requires Proximity to be turned on,
along with at least one offset curve)

SCREENSHOT

(Least Distance)The ellipses from
which the SF (Separation Factor) is
calculated. These ellipses are
constructed by projection onto the
plane created by the minimum
distance vector and the offset’s
direction vector.
Show Compared
Curve’s Ellipsoid
(Alt+O)

(requires Proximity and “Show LD
Ellipse” to be turned on) This is the
offsets’s LD ellipse. It is on the same
plane as the other LD ellipse on the
reference well.
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Pedal Curves* (Alt+P)

(requires Proximity and “Show LD
Ellipse” to be turned on) This turns
on the pedal curve graphic around
each of the LD ellipses. The use of
pedal curve is explained in the
footnote at the end of this chart.

Show LD Plane (Alt+V) (requires Proximity to be turned on)
The LD plane is the plane that the
LD ellipses on which the LD ellipses
for the reference and offset wells are
generated. This can be turned on for
greater clarity of what the plane is.
NE Referenced Ellipse
(Alt+N)

(North-East) This is the 2D ellipse
that is created by projecting the
ellipsoid onto the TVD plane. It is
the ellipse that is drawn on 2D plots.

HL Referenced Ellipse
(Alt+H)

(Highside-Lateral) This is the ellipse
that is created by projecting the
ellipsoid onto the normal plane. The
elliptical cylinders are constructed
by connecting successive HL ellipses
to one another.

*Pedal Curve- Without 3D representation of ellipsoids and elliptical cylinders the
accepted way of visualizing the ellipsoids is to generate the various 2D ellipses that are
detailed here.
It is understood, however, that these 2D ellipses can often lead to an
underestimation of the collision condition of the actual ellipsoids.
So, in order to avoid those situations a pedal curve is mathematically generated from
the mathematical definition of the ellipse.
This pedal curve provides a much more conservative estimation of the radii of
the ellipses and helps to ameliorate the possibility of underestimating collision
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conditions. (A collision in this case is defined when two ellipsoids intersect with one
another)
Unfortunately, using the pedal curve can often lead to way too conservative
estimations of the separation factor, especially in non-vertical drilling. With 3D
representation it becomes quite obvious when the pedal curve is too conservative.
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6. Formation Line Editor
The Formation Line Editor in Hawkeye™ is designed to make it easy for the DD to
adjust the plan without demanding an entire new well plan from the well planner's in
the office. The plan becomes a target line as opposed to a list of proposed surveys.
Once the new target line is established the DD can make projections to the line and
determine the feasibility of drilling the proposed change. Once accepted, he then has a
defined target from which he can calculate how far right/left or up/down he is from it.
How it works...
To begin with, this planner is for straight lines only. It is a useful tool for creating a
target line disguised as a survey course length. The DD then will be responsible for
executing the projections to this line, or around the line, and determining if it is
drillable.
The DD can alter the plan to which he wants to drill by easily creating a new plan from
the point on the current plan where he wants to change it, normally the point where he
is currently at. Let's say the geologist decides that they should be drilling to a target
line that is ten feet higher than where the bottom hole is currently.
1. The original plan (O-plan) will be copied so that it can be preserved.
2. The copy of this plan will be called the ~F0 plan.
3. All additional modifications will have curve names as of ~F1,~F2,~F3, etc.
The DD would simply create a new plan from the current MD point and define how
much above or below he wants the new plan to be. The program then would create a
curve tied into the EW, NS, TVD of the selection point and adjust that tie in point up or
down. In this case, the new curve will automatically be named ~F1. The new plan will
automatically be extended to the MD at the end of the proposed plan and truncate the
last plan so as not to have a bunch of confused lines. (Why look at an extended line
from a previous F plan when it is not being used?)
Now let's say that the geologist decides after drilling an additional 100 feet that the dip
should be something different. All the DD need do is create a new plan with the new
dip from the ~F1 curve he created 100 feet earlier.
The new plan will automatically be called ~F2. The ~F1 plan will be truncated from the
beginning of ~F2, and ~F2 will be automatically extended to the end of the original plan,
or O-plan. This process of modifying the plan dynamically as it is being drilled can be
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extended indefinitely. In addition to helping the DD modify his target for the ever
changing plan, a record of the decisions of the geologist is maintained.
Below is a simple tutorial of where to find the Formation Line Editor and how it works:
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F.

PRESENTATION PLOTS

1. Presentation Plot Designer
a. How the Presentation Plot Designer Works
The Presentation Plot Designer in HawkEyeTM is one of the most powerful and complex
aspects of the program, and can be used to create wallplot-sized plots. It utilizes
scalable vector graphics (SVG) when generating wall plots, making for very clean and
precise visual representations of the native data retrieved from the project database.
But SVG also allows a high degree of flexibility as far as zooming and resizing. The SVG
is in fact handled by a dedicated program called InkScapeTM, which installs with
HawkEyeTM. InkScapeTM itself a tremendously powerful SVG editor that, when even
only minimally understood, will produce very professional and sharp presentationcaliber plots.
SCALABLE VECTOR GRAPHICS (SVG)
SVG has been in development since 1999 by a group of companies within the W3C
after the competing standards Precision Graphics Markup Language (PGML) were
submitted to W3C in 1998. SVG drew on experience from the designs of both those
formats. SVG drawings can be dynamic and interactive. SVG allows three types of
graphic objects: vector graphics, raster graphics and text.
Graphical objects, including PNG and JPEG raster images, can be grouped, styled,
transformed, and composited into previously rendered objects. Text can be in any
XML namespace suitable to the application, which enhances search ability and
accessibility of the SVG graphics. The feature set includes nested transformations,
clipping paths, alpha masks, filter effects, template objects and extensibility.
The SVG Specification contains provisions for rich graphics, and is unlike XHTML,
whose primary purpose is communication of content, not presentation, and
therefore specifies objects to be displayed but not where to place such objects.
Conversely SVG is an ideal PDL for print-oriented uses, as it contains all the
functionality required to place each glyph and image in a chosen location on the
final page.
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WORKFLOW FOR A PLOT
The Plot Designer in HawkEye works in conjunction with other software in order to
make complex plots. There is a division of labor here amongst the programs. Here is
the sequence generally:




STEP ONE: In HawkEye™
Insert all the graphs, charts, lists, graphics and components that you want.
Tweak the data aspects of graph grids, lists, as well as and colors.

[Click]




STEP TWO: Inkscape
Position the various items to where you want them.
Tweak non-data elements like label placements and indentations, etc.
[Print to PDF]




STEP THREE: Adobe Reader
Choose your paper size once your PDF is open.
Print to paper.
NOTE: Do Not Print to large formats directly from Inkscape.

OPENING THE PLOT DESIGNER: Click on the Presentation Plot icon under the
“Special Tools” tab.
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FILE MENU: In the top left of the screen is the “File” menu. It contains
all the essential plot file management options:


Save Template: This will save whatever frames are currently
displayed in the plot designer as a template file (.plt). User can
define the name and location of the template file. The default
location where all default HawkEyeTM templates are stored is
c:/HawkEyeTM/plottemplates.



Get Template: This simply opens a file launch dialogue to load
any template (.plt) file into the Plot Designer.

MAIN CONTROL PANEL: Although the Plot
Designer has individual panels for each element
of a plot which can be opened and closed, there
is a Main Panel that always stays at the top left.
It is broken into two tabs, the Graph Objects
and Edit Frame tabs at the top.
Under the Graph Objects (default open) tab, the
user may select printer, paper size and
orientation, as well as templates, adding frames
and adding other elements to a plot.
Click “Save PDF File” to get an instant PDF of
whatever is currently displayed without using
Inkscape. This is useful for quick plots containing relatively few elements (e.g. VS v.
Horizontal view)

PRINTING: The Print button, located just next to the paper selection drop-down menu,
allows for a wide variety of print sizes. When the CutePDF Writer is selected as the
printer, this selection contains virtually all print sizes. However, only in the Well
Planning version of HawkEyeTM will the larger wall plot sizes be available for printing.
In other words, the Field version of HawkEyeTM only has the conventional non-plotter
sized options for a paper sizes up to A3. Also note, a paper size is simply not available if
the selected printer will not support it.
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PRINTING PLOTS: FIELD v. WELL PLANNING VERSIONS
The difference between the Field version and Well Planning version of HawkEye TM
with plotting is that only in the Well Planning version will the larger wall plot sizes
be available for printing and exporting. Only the smaller paper sizes are available in
the Field version since it is assumed that users of the Field version will not need a
plot printout larger than A3.
Exclusive Well Planning version print sizes include: A4, A2, 11x17, ISO A0-2, ISO B1,
B1-B4(JIS), ARCH A-E1, Folio [8.5x13in], 22x36in, 24x48in, 24x60in, 24x72in, 24x84in,
24x96in, 24x108in, 36x42in, 36x60in, 36x72in, 36x84in, 36x96in, 36x108in and
PostScript Custom.

PLOT TEMPLATES: Each project is given
up to four customizable templates. Select 1-4
from the Project Plots drop-down menu in
order to open a template, and to save to it,
just have it selected and click the “Save”
button next to the drop-down menu. The
template names can be changed to whatever
descriptive name the user wants.

ADD COMPONENTS: There are dedicated buttons in the plot designer’s main control
panel for adding certain components:
 Add Vertical- add a Vertical Section view graph to the plot
 Add Horizontal- add a Horizontal view graph to the plot
 Add MD or TVD vs ??- Add a graph which charts MD or TVD against any given
parameter you chose.
 Add Graphic- Drop any sort of image file into the plot. NOTE: Any graphic
located within a folder path that contains special characters such as “&” will
not load into the SVG environment!
 Add Frame- This button encompasses a long list of additional types of frames
which can be selected from the drop-down menu in the sub-panel created. Those
frames include:
 Header
 Critical Points
 Footer
 Hard Lines
 General Data
 Lease Lines
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 Lithology
 Last 3D View
 Casing
 3D Perspectives
 Job Data
 Geomagnetics
 Slot/Wellhead Data
 Geodetics
 Text
 North Arrows
See more in the last two sections of this chapter titled “Add Frame.”
SHOW LITHOLOGY: This checkbox will display any entered lithology data as the
background of a graph.
LEFT SIDE: When the user does not want to display the lithology across the entire
width of a VERTICAL SECTION graph, the “Left Side” toggle will limit the display to
only the left side of the displayed curve. This is useful for when the lithology data only
includes tops, which do not actually define dips across an extended horizontal plane.
TRANS: This is a translucency control that will determine opacity of the lithology
background, ranging from 1-100.
SHOW REAL LITHOLOGY: This toggle will overmap any data entered into the
lithology which reflects thicknesses, vertical section departure etc, from the surface
location.
PRINT PDF FILE: This button will pull up the print dialogue and automatically select
the CutePDF Writer as the printer for PDF export of the plot as it appears.
EDIT W/ INKSCAPETM: This button launches the all-important InkScapeTM application,
which utilizes scalable vector graphics (SVG) in order to move, place and resize all the
existing elements of the plot. It cannot be used to edit the plot’s actual data, however.
TEMPLATE FILE: The “Save” button under “Template File” will save the current plot
configuration to a template file (.PLT). Clicking “Get” will open the folder where
template files are stored. HawkEyeTM installs with about a dozen default templates to
choose from.
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b. Vertical Section Plots
The vertical section frame is normally included in the default plot templates since it is
staple information for plots. But for a user wanting to start from scratch on building a
plot, the VS frame is easily added.
Add a graph depicting a vertical section
view of a project to the plot by clicking the
“Add Vertical” button in the main control
panel. Depending on the nature of the
wells, either Landscape or Portrait may be
more appropriate. However, if the plot is
very large this preference will not hinge on
the shape of the vertical section frame
alone.
GRID FEATURES: The checkboxes in the blue field of
the sub-panel will control whether any of the grids or
the outer frame is displayed. Click on the circle to the
left of any of the grid boxes to open a color dialogue
and select a color for the element from the palette.
RESIZING: Height and width can be changed with the
drop-down menus. The boxes in between these menus
toggle whole-page vertical and horizontal expansion of
the graph. The “Outer Scale” slide control will resize
the frame as a whole. Further fine-tune resizing can be
done in InkScapeTM. (Launch InkScapeTM by clicking the
“Edit w/ InkScapeTM” button in the main control panel
on the top left quadrant of the Plot Designer).
PLACEMENT: The 9-circle grid on the top right will control the general placement of
the graph. However, for fine-tune placement (as well as resizing), InkScapeTM is used.
This grid is only for rough draft placing.
AUTO CALC: When this is toggled on, the Plot Designer will calculate the best way to
fit the relevant portion of the VS view into the graph space displayed. When turned off,
several manual fields are activated, including the vertical exaggeration factor and the
“Div/Tick” drop-down menu, which allows the user to define the number of graph ticks
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per division. By increasing the ticks per division, there is a zoom effect on the graph. By
default, graph treats each tick as one inch, but to “zoom out” and increase the distance
per division, just slide down the “Inner Scale” slide control in the sub-panel.
VIEW CHANGES: VSP will change the angle at which the vertical section are being
seen, by degrees. The Start VS and TVD fields control the depth at which the curves
begin on the graph. Adjusting these two parameters when AutoCalc is turned off
allows the user to position the graphics within the grid.
GO TO CHART: The “Go to Chart” button allows the user to leave the Plot Designer
for a moment and re-adjust the positioning of the graph in the main HawkEye TM
environment. The “chart” launched is merely the VS View, where zooming and
panning can be done in order to get a better view. To get back out of the VS View and
back to the plot, just click the “View Plot” button at the top of the window. The next
step is to click the “PLOT FROM CHART” button. This button will take whatever
immediately preceding adjustments made in the VS View and implement them in the
current VS plot frame.
LABEL MANAGER: Click the “Label
Manager” button at the far left of the
“2D Charts” tab in the main screen.
This general panel controls both VS
and Top view label and grid
characteristics. In order to get VS and
Top view graphs to look exactly as
desired, it is important to experiment
with and understand this control
panel.
At the bottom, all settings can be
applied to this plot, all plots or all
charts.
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VERTICAL SECTION WITH LITHOLOGY
Lithology information of a project can be graphically displayed as the background of a
vertical section plot within the Plot Designer. The first step is to make sure there is
lithology data entered the way the user wants it into the project’s database. (See section
on Lithology, Ch.3).
Once a vertical section plot frame has been created
(Click “Add Vertical” in the main control panel of the
Plot Designer), the option to “Show Lithology” will
appear as a checkbox. Toggle on the “Show Lithology”
and the rest of the controls will appear.

TRANS: This is a translucency control that will
determine opacity of the lithology background, ranging
from 1-100.
SHOW REAL LITH.: This toggle will overmap any data
entered into the lithology which reflects thicknesses,
vertical section departure etc, from the surface location.

The “Show Lithology”
checkbox in the Plot
Designer main control
panel
will
project
lithology data as the
background of a graph.

LEFT SIDE: When the user does not want to display the lithology
across the entire width of the vertical section plot, the “Left Side”
toggle will limit the display to only the left side of the displayed
curve. This is useful for when the lithology data only includes
tops, which do not actually define dips across an extended
horizontal plane.
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c. Horizontal Plots
A horizontal plot is simply the “Top View” found in the
main HawkEyeTM module. A horizontal plot can be added to
a plot by clicking “Add Horizontal” in the main control
panel. Be sure to select the desired Paper Size and
orientation above.
Once the frame has been created, its sub-panel will appear
below under the header “Horizontal Plot.”
GRID FEATURES: The checkboxes in the blue
field of the sub-panel will control whether any of
the grids or the outer frame is displayed. Click on
the circle to the left of any of the grid boxes to
open a color dialogue and select a color for the
element from the palette. The “ADD” button will
add an entirely new generic frame.
RESIZING: Unlike many other frames in the Plot
Designer, the Horizontal Plot frame (as well as
Vertical Section View frame) is resized and edited
to a great degree without InkScapeTM. The controls
in the Horizontal Plot sub-panel contain most of
the tools needed. Click the boxes between the
Height and Width fields to maximize the Horizontal plot vertically or horizontally. Both
boxes checked means that the graph will occupy the entire plot.
AUTO CALC: When this is toggled on, the Plot Designer will calculate the best way to
fit the relevant portion of the Horizontal plot into the graph space displayed. When
turned off, several manual fields are activated, including the Origin grid. X and Y Offset
fields, and the “Div/Tick” drop-down menu.
DIV/TICK: By increasing the ticks per division, there is a zoom effect on the graph. By
default, the graph treats each tick as one inch, but to “zoom out” and increase the
distance per division, just slide down the “Inner Scale” slide control in the sub-panel.
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ORIGIN: When “Auto Calc” is
turned off, this grid controls
where the heart of the graph’s
information is positioned. This
is useful for spider plots of any
symmetry.
PLACEMENT: The 9-circle
grid on the top right will
control the general placement
of the graph. However, for
fine-tune placement (as well as
resizing), InkScapeTM is used.
This grid is only for rough
draft placing.

The Origin control (superimposed) will position
the platform of a Horizontal plot to one of nine
positions, allowing for balanced spider plots.

GO TO CHART: The “Go to
Chart” button allows the user
to leave the Plot Designer for a moment and re-adjust the positioning of the graph in the
main HawkEyeTM environment. The “chart” launched is merely the Top View, where
zooming and panning can be done in order to get a better view. To get back out of the
Top View and back to the plot, just click the “View Plot” button at the top of the
window. The next step is to click the “PLOT FROM CHART” button. This button will
take whatever immediately preceding adjustments made in the Top View and
implement them in the current Horizontal plot frame.
LABELS MANAGER: Click the “Labels
Manager” button at the bottom of the
sub-panel to launch the standard
Graphics Properties Labels controller.
This general panel controls both VS and
Top view label and grid characteristics.
In order to get VS and Top view graphs
to look exactly as desired, it is important
to experiment with and understand this
control panel. At the bottom, all settings
can be applied to this plot, all plots or all
charts.
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d. MD and TVD Function Plots
The Plot Designer can create graphs which plot the
measured or total vertical depth of a curve as a function
of another parameter. To add this kind of frame to a
plot, just click “Add MD vs ??” or “Add TVD vs ??” and
the frame’s sub-panel will appear below.

From the “vs” drop-down menu in the respective
sub-panel, the user can choose which
measurement to add the depth as a function to.
By making the selection here, the graph is
generated automatically in the plot and can be
resized or moved around.
GRID FEATURES: The checkboxes in the blue
field of the sub-panel will control whether any of
the grids or the outer frame is displayed. Click
on the circle to the left of any of the grid boxes to
open a color dialogue and select a color for the
element from the palette. The “ADD” button will
add an entirely new generic frame.
PLACEMENT: The 9-circle grid on the top right will control the general placement of
the graph. However, for fine-tune placement (as well as resizing), InkScapeTM is used.
This grid is only for rough draft placing.
DIV/TICK: By increasing the ticks per division, there is a zoom effect on the graph. By
default, the graph treats each tick as one inch, but to “zoom out” and increase the
distance per division, just slide down the “Inner Scale” slide control in the sub-panel.
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e. Add a Graphic
ADD A GRAPHIC: To add pictures and graphics to a plot,
first click the “Add Graphic” button in the main control
panel. This will create a sub-panel labeled “Picture” with a
sequential number. Then click the “Get File” button at the
bottom of the sub-panel to open the file selection dialogue
through which any graphic file format can be selected.
HawkEyeTM installs with a number of logos to choose from
(default folder: c:/HawkEyeTM/oilfield.logos) but any image
file may be added to the plot.
To add a second graphic, simply click the “Add Graphic”
button again and another “Picture” subpanel will appear.
RESIZING: Resizing the graphic is done in two ways: either
manually adjusting height and width in the sub-panel, or by
sliding the “Outer Scale” slide control on the right. (Fine-tune
resizing is done in InkScapeTM. Click “Edit w/InkScapeTM” in
the main control panel to launch).
ADJUSTING TRANSLUCENCY: By sliding down the “Inner Scale” slide control, a
graphic’s opacity is reduced. This is useful for creating watermarks on a plot.
PLACEMENT OF GRAPHIC: The 9-circle grid in the sub-panel will give the graphic a
rough placement on the plot, but any fine-tune placement and resizing of the graphic
and of any frame is done in InkScapeTM, the scalable vector graphics program attached
to the Plot Designer. Click the “Edit w/ InkScapeTM” button in the main control panel to
launch the program. (More on InkScapeTM below).
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f. Add Frames: Most Commonly Used
Most of what can be added to a presentation plot falls under the “Frame” category. The
list of frames that can be added are the following:
 Header
 Job Data
 Footer
 Slot/Wellhead Data
 General Data
 Text
 Critical Points
 Last 3D View*
 Hard Lines
 3D Perspectives*
 Lease Lines
 Geomagnetics
 Lithology
 Geodetics
 Casing
 North Arrows
* Explained in the following section “Add Frame: Screenshots”

The following sections detail the most commonly used frames:

1.
2.
3.
4.
5.
6.

Add/Edit/Delete Frames
Header
Lithology, Casing and Target Lists
Targets List
Critical Points List
Geodetics, Magnetics and a North Arrow
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1. Add/Edit/Delete Frames
ADD FRAME: After clicking the “Add Frame” button from
the main control panel, a component bar appears below the
main panel labeled “Frame.” In this sub-panel, the frame
type can be selected from the “Frame” drop-down menu.
There are 17 types of frames to choose from.
Most of the frames, once chosen and placed, will have the
same set of controls for editing. That control set will be
located in this very same sub-panel, but there will be slight
variations on the controls depending on which frame is
selected.

SELECT FRAME: Only one frame can be selected at a time
for editing. To select a frame, click on the circle to the left of
the component header. When not selected, this circle is pink.
When a frame is selected, its circle is green and its sub-panel
is expanded.

DELETE FRAME: To delete a frame, just click on the red box
on the right end of the sub-panel header. This will instantly
remove the frame and all of its settings from the current plot,
so make sure to have any templates saved before killing a
frame.

EDITING FRAMES: Once a frame has been created,
you can use the “Frame” submenu to edit its CORE
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properties. (For more fine-tuning, you will click the “Edit Frame” tab on the top left).
Use the radio buttons to pull up their corresponding options dialogues: background
color, font color and frame color. You may toggle whether a colored frame outlines the
frame itself by toggling the “Show Frame” box. You may also toggle “Section Lines,”
which will show if there is more than one column in the frame itself. Frame size and
width is also controlled in this sub-panel, as is the font properties found in the header.
Click “Font” to pull up the font properties. The Outer Scale meter will automatically
resize the frame, font and all. Click “Save” to save all the current settings to default for
future frames of that type.
EDIT FRAME TAB: The other tab in the main control
panel of the Plot Designer is the Edit Frame panel. It
is used for more fine-tuning of any given frame. The
first step is to select the object to be edited from the
Frame Objects drop-down menu. This will dictate the
kinds of options that will be available in the rest of the
panel.

Thus there are two levels in which to edit plot frames in HawkEyeTM and they are each
found in their own tab of the main control panel of the plot designer. The colors, fonts
and outer scale is edited under the “Graph Objects” tab, where such frames can also be
added. Under the “Edit Frame” tab, specific spacing parameters can be entered, as well
as section divides and section styles.
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2.

Header

The first step in creating a presentation plot from a blank
slate is to add a header. To do that, click the “Add
Frame” button from the main panel, then in the “Frame”
drop-down menu select “Header.” A standard header
will appear at the top of the plot with graphical logo on
the left and seven lines of header text to the right of the
logo. You may edit the basic characteristics of the header
frame as described above, but you may also click the “Job
Information” button to edit the actual information found
in the header.
To edit a header more closely, select the “Edit
Frame” tab on the top left. Then select
“Header” from the “Frame Objects” dropdown menu. You will now see the breakdown
of how the header is built in this panel. By
default the header is composed of three
sections, which can be changed. To change the
relative widths of each section, you will
manually enter the ratio in the “%” field.
Each of these numbers represents the
percentage of the total width of the header at
each section divider.
So in the following example, the ratio of “0, 12, 88, 100” divides a header that looks like
so:

The three sections are 1) the graphic section, 2) the “text flow” section and 3) another
graphics section. The dividers come at 0% width, 12% width, 88% width and at the end
at 100% total width. The next picture shows a ratio of 1,9,91,100:
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To edit any of these sections, use the “SECTION SELECTOR” to move the number up
and down. Sections are numbered from left to right, so the first graphic section above
would be “1.” It is characterized under the “Section Style” drop-down menu as a
“Graphic.” To change this particular graphic, make sure the Section Selector is on “1,”
then click “Browse” to select a different graphic for that section.
NOTE: Any graphic located within a folder path that contains special characters such
as “&” will not load into the SVG environment!
Hit “Apply” after selecting any new graphic or making any changes.
To edit a “Text Flow” section, use the Section
Selector to select it. In this case it would be “2.”
Once selected, the entire panel will change to
display all the text flow options. The most salient
options are the number of rows and columns. Just
like with section width ratios, the spacing of these
columns are controlled by manually entering
ratios. However, notice that the ratios are
specified by default as decimals up to the
hundredth power, so mind the punctuation in this
field.

ADDING DATA COLUMNS: Further below in
text flow editing panel are the data type selection
columns. There you can choose which kinds of
data will appear in the text flow section. On the
left are all the available data types that can be
added.
To add one, left-click on it, and it will appear at
the bottom of the right-hand column. The righthand column, likewise, displays in order from top
down which data types are displayed from left to
right on the plot (restarting from top left on
subsequent rows and columns).
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To remove a data type, left-click and then right-click on the word. To re-order the data,
you must remove each of them and re-stack them in the desired order.
In the following example, there are 14 data types, 7 rows and 2 columns. The columns
are given width ratios of 0,50,100. Remember that the width ratios within a text flow
area only apply to that section, not the entire frame.

Here is another example. The text flow
section is given three columns, with 8
rows per column. But the width
breakdown is a little different:
0,20,80,100.
This creates columns within the text
flow section that are not symmetrical,
which is what the user may want:

MAKE DEFAULT: Once all changes have been made to spec, be sure to click “Make
Default” at the top of the Edit Frame panel.
SAVE AS TEMPLATE: To save any
component or frame settings in one of the four
template slot/wellheads, just click the Graph
Objects tab at the top, then use the pulldown
menu to select which slot/wellhead you want
to save under, then click the “Save” button to
the right. Remember, saving in a slot/wellhead
will erase the old template in that
slot/wellhead, so keep track of your templates.
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3. Lithology, Casing and Targets Lists
The lithology, casing and targets frames are the kinds found
under the general frames list, so to add them to a plot, just
click “Add Frame” in the main control panel on the left side
of the Plot Designer. A “Frame” sub-panel will appear, and
from the “Frame” drop-down menu, select Lithology. It will
automatically appear. Don’t click the “Add” button unless
you want a second frame of that type.
SAME PROCESS: This creation process is the same for
casing and targets, and all of the controls described below are
also identical.
PROXY CONTROL: Once the lithology frame has been
created, it will appear on the plot. Below the plot will also
appear a proxy control. This proxy control emulates the
selected frame (select any frame by clicking on its sub-panel on the left) and allows the
user to resize columns by clicking and dragging borders. So when a column width is
resized in the proxy control, its respective frame is resized.

Certain frames like lithology, casing and targets have a proxy control that
appears below the plot, where by adjusting the proxy chart column widths, the
frame’s column widths are adjusted.

244
HawkEye

TM

User’s Manual

Copyright © 2015 by Performance Drilling Technology

All the characteristics besides column width are controlled in the frame’s sub-panel.
Click on the radio button to pull up each respective dialogue.
NOTE: To trigger changes made to the frame here, sometimes another change must be
made. The easiest way to do this without making unwanted changes is to check the
“Show Frames” box twice.
ANCHOR CONTROL: The 9-circle grid on the top right
of the panel is an anchor control which delineates which
quadrant of the plot the frame will be placed. Sometimes
the frame will not be place in the absolute corner of a
plot when told to do so because of the spacing priority
logic of previously placed frames or objects. But this
anchoring control is only for rough placement anyway.
All final placements on a plot are done in InkScapeTM.
(To get to InkScapeTM, just click “Edit w/ InkScapeTM” at
the top of the main control panel).

Frames are placed via the 9-circle grid of their respective subpanels. However,
they will be stacked on top of other frames if the spot is already taken. This is
because the anchor is only for approximate placement. All final placements of
frames and objects are done in Inkscape where they can also be warped, resized,
drawn and commented on.

4. Targets List
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Further editing of a grid-style section can be done under the “Edit Frame” tab, selected
from the top of the main control panel in the Plot Designer. Changing a frame without
making it a default will have the changes only apply to the current plot. Once Make
Default is selected then the changes will be reflected in all newly generated plots. One
of the most common grid style sections in plots is the Target List. To fine-tune edit such
a list once it has been created in the plot, just click the “Edit Frame” tab, then select
“Targets” from the “Frame Object drop-down menu. Then be sure to select “Grid” from
the “Section Style” drop-down list.
OTHER GRID-STYLE FRAMES: Lithology and
Casing lists are also grid-style lists, so they can be
fine-tune edited under this tab by selecting them
under Frame Objects drop-down menu and
selecting “Grid” for the section style.
The font, number of columns and overall width of
the frame is controlled in this panel. Check the
“Show Grid Lines” box to display the lines along
each of the columns.
COLUMN WIDTHS: The column width field
allows the user to define widths by percentage from the left. The number of percentage
values given depends on the number of columns in the frame. Each value defines where
a column division is placed, with the first and last values (0 and 100) representing the
outer edges of the frame. The following target list has 6 columns with a column width
percentage of 0, 16.67, 33.33, 50, 66.67, 83.33, 100:

The column width percentages will automatically generate to equal spacing when a
new number of columns is selected for the frame.
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ADDING DATA COLUMNS: Further below
in text flow editing panel are the data type
selection columns. There you can choose which
kinds of data will appear in the text flow
section. On the left are all the available data
types that can be added. To add one, left-click
on it, and it will appear at the bottom of the
right-hand column. The right-hand column,
likewise, displays in order from top down
which data types are displayed from left to
right on the plot (restarting from top left on
subsequent rows and columns). To remove a
data type, left-click and then right-click on the
word. To re-order the data, you must remove
each of them and re-stack them in the desired
order.
APPLY/MAKE DEFAULT: Be sure to click the “Apply” button after making each
change to the frame so that it will appear in the plot. Once all the parameters of a given
frame type have been set up to personal spec, then click the “Make Default” button to
save them as such.
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5. Critical Points List
Critical points frames are the kind found under the
generic “Add Frame” button in the main control
panel.
To add a critical points list to the plot, click the “Add
Frame” button, which will create a new sub-panel
below labeled “Frame.” From its “Frame” drop-down
menu, select “Critical Points.” This creates the frame
in the plot.

RESIZING: Resizing the critical points list is done in
two ways: either selecting a width in the sub-panel
width drop-down menu (height is determined by the
content of the list itself), or by sliding the “Outer
Scale” slide control on the right. In addition, a frame’s
column widths may be altered with the proxy grid just below the plot window.
RESOLVING TEXT OVERLAP: The critical points list, like many of the other
informational list-based frames in the Plot Designer, may display overlapping text and
numbers when initially placed. This is resolved in three ways:
a. Resize and/or change the font by clicking the “Font” button.
b. Enlarge the frame by increasing width in the sub-panel.
c. Resize the frame and/or its components in InkScapeTM:
InkScapeTM allows each of the elements in
a frame to be resized and manipulated, so
resolving individual instances of text
overlap is as easy as clicking on the
trouble line and resizing it.
NOTE: InkScapeTM will not alter the actual
information itself. Such changes must be
made in the project itself in HawkEye’s
main interface or in the Plot Designer
editing field below the preview window.
6. Geodetics, Magnetics and a North Arrow
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The Geodetics, Magnetics and North Arrow frames all have
identical sub-panel controls, and they are among the
simplest of all the frames that can be added to a plot.
ADD THE FRAME: To add any of these frames, click the
“Add Frame” button in the main control panel of the Plot
Designer, then select any of the bottom three selections from
the “Frame” drop-down menu in the sub-panel.
FRAME FEATURES: The user may control background,
font and frame color, as well as height and width of the
frame. If a font size or type becomes larger than the
background of the frame itself, there may be clipping. This
is resolved by increasing the dimensions of the frame size.
The Inner Scale slider is inert, but the Outer Scale slide
controls the overall size of the frame. Click “SAVE” to save
the current settings to the default for that particular kind of
frame.
RESIZING AND PLACING: Although resizing is mostly done in the Plot Designer,
fine-tune resizing and placement is done in InkScapeTM. (“Edit w/InkScapeTM” button).

The Geodetics, Magnetics and North Arrow frames all have an identical subpanel control set. These feature controls are the simplest of all the frames.
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g. Add Frames: Screenshots
There are two special frames that can be added to the plot which take images from the
3D space. The Multishot will take four screenshots of a single point, and the Last 3D
View will take the very last 3D view that you see before the Plot Designer is opened.
1.

3D Perspectives (Multishot)

HawkEyeTM can take four snapshots of the same
3D space from the four cardinal directions and
place them in a plot. To do this, the user must align
the 3D window view to the desired portion of the
curve to be captured. Once the Look-at Point is
positioned to the desired place, select the snapshot
mode in the “Mode” drop-down menu just under the 3D window. The choices are
Vertical M.S., Custom M.S. or Snapshot.
VERTICAL M.S.: This mode takes four
screenshots of the current Look-at Point from
a flat angle, looking straight across. It is
essentially a 3D vertical section view of the
Look-at Point from 0, 90, 180 and 270 degrees
azimuth.

CUSTOM M.S.: This mode will take four
screenshots of the current Look-at Point, but
from any inclination up or down that the POV
is currently positioned at. The shots are still
taken with the north, south, east and west
direction .
SNAPSHOT: This mode allows the user to
take a single screenshot of the currently
displayed view in the 3D window to later load as a graphic in the Plot Designer. When
taken, it requires the user to enter a file name for the snapshot.
TAKE THE SHOTS: Once the multishot mode is selected,
click the Snapshot icon to the right of the drop-down menu.
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This will take the four shots in the case of the Vertical and Custom M.S. and the
single shot if the Snapshot mode is selected.
SELECT THE SET: For Vertical M.S. and Custom M.S. modes, up to ten different sets of
shots can be saved. After taking the shot, the Graphics Set prompt will appear. Choose
the slot/wellhead to save the current set to, from 1 to 10. This set of screenshots is later
chosen in the 3D Perspectives sub-panel before loading into the plot.
Vertical Lines (droplines) can also be added here to each of the curves with the
checkbox at the bottom. They would be generated here and saved permanently in the
screenshots.
3D PERSPECTIVES FRAME: Launch the Plot Designer
from the top left of the main screen.
The Multishot frame is treated as a generic frame, so to add
it, just click “Add Frame” in the main control panel. Then
select “3D Perspectives” from the “Frame” drop-down
menu. This will immediately generate the multishot frame
in the plot window on the right.
The frame is called “3D Perspectives” because the sub-panel
allows for the multishots as well as a snapshot to be loaded
into the plot.

Once the frame is created, the multishot sub-panel will allow for certain setting
adjustments. The colors can be adjusted by clicking the circle to the left of the color
labels.
PLACEMENT: The 9-circle grid on the top right will control the general placement of
the graph. However, for fine-tune placement (as well as resizing), InkScapeTM is used.
This grid is only for rough draft placing.
RESIZING: The Width drop-down menu is the primary way to resize the multishot
frame, whereas height does not control the size nearly as much. The Outer Scale slider
control will shrink the frame while keeping aspect ratio. To further resize this
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screenshot frame, launch InkScapeTM by clicking the “Edit w/ InkScapeTM” button in the
main control panel above.
LAYOUT: Select “Horizontal” to line the four
screen shots in a row on the plot. “Vertical”
will stack them in a column. “Rectangle” is the
default and will arrange them in a 2x2
orientation.
TYPE: Select either Ver. MS, Cus. MS or
Snapshot in order to instantly change the set
of screenshots displayed in the frame.
HawkEyeTM will pull the set from the type as
they were captured in the 3D space. There will
be no changes to the frame if a screenshot set
for that type has not be taken yet.
SET: This drop-down menu allows the user to
select the graphic index 1 through 10, loading
the respective index into the frame itself. These indexes are available for Vertical M.S.
and Custom M.S. and the prompt to choose the index always appears after taking the
shot in the 3D space.
IND AND CAPTION: This drop-down menu selects the “index” from 1 to 4, selecting
the caption field to be edited. The captions under each screenshot can be edited by
selecting a number from this menu and then editing the text in the “Caption” field. (The
default is: 1 -“North View,” 2- “East View,” 3- “South View,” and 4- “West View.”)
Click on the “FONT” button to edit the font characteristics of the captions.
AUTO SCALE: Checking this box will attempt to resize the SNAPSHOT, if there is one
loaded in the plot, into a size comparable to surrounding
loaded screenshots.
FILE: This field becomes active when the “Snapshot”
Type is selected. Click the “Browse” button to load either
the snapshot taken from the 3D space or ANY graphic file
to load. NOTE: To load custom graphic files, the “Add
Graphic” button in the Plot Designer main control panel will launch a dedicated picture
frame sub-panel.
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SAVE: Click the “Save” button to lock in the current settings as default for every time a
new 3D Perspectives (“multishot views”) frame is created in the Plot Designer.

2. Last 3D View
Any time the Presentation Plot Designer is launched
from the main screen, it grabs the last 3D view that is
being displayed in the 3D window. To customize the
screenshot itself before launching the Plot Designer, the
user simply resizes the window and calibrates the 3D
view itself to reflect whatever view is desired. Once set
up, just click the Presentation Plot icon at the top.
The next step, once inside the Plot Designer, is to click
“Add Frame” and select “Last 3D View” from the
“Frame” drop-down menu of the new sub-panel. This
will automatically drop the 3D screenshot into the plot.
TEMPLATE: In order to always have the Last 3D View
dropped into a plot, just add this frame to a plot and
save as a template. The Plot Designer will treat that
space as any other template-designed frame and fill it in
with the actual last 3D view displayed.
RESIZING: Height and width can be changed with the
drop-down menus. The “Outer Scale” slide control will
resize the graphic as a whole. Further fine-tune resizing
can be done in InkScapeTM. (Launch InkScapeTM by
clicking the “Edit w/ InkScapeTM” button in the main
control panel on the top left quadrant of the Plot Designer).
PLACEMENT: The 9-circle grid on the top right will control the general placement of
the graph. However, for fine-tune placement (as well as resizing), InkScapeTM is used.
The grid is only for rough draft placing.
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2. Finishing With InkScape™
The InkScapeTM program is installed with HawkEyeTM as a companion program which
acts as an empowered module for extremely professional plot layouts. The program
installs with HawkEyeTM, and it is advised that this version of Inkscape is used rather
than the latest versions which can be downloaded at the Inkscape website.
WHAT IS INKSCAPE?
Inkscape is an open source vector graphics editor, with capabilities similar to Illustrator,
CorelDraw, or Xara X, using the W3C standard Scalable Vector Graphics (SVG) file
format.
Inkscape supports many advanced SVG features (markers, clones, alpha blending,
etc.) and great care is taken in designing a streamlined interface. It is very easy to
edit nodes, perform complex path operations, trace bitmaps and much more. Its
creators also aim to maintain a thriving user and developer community by using
open, community-oriented development. As such, it has become an extremely
polished SVG editor that is the product of tens of thousands of dedicated
manhours over the course of ten years.

a. Primary Functions
InkScapeTM is used in HawkEyeTM primarily to RESIZE plot frames and the
alphanumeric elements within, as well as PLACE those frames in exact positions for a
fine-tuned plot layout.
OPENING INKSCAPETM: You can open InkScapeTM at any
time from the Plot Designer by clicking on the “Edit w/
InkScapeTM” button. This will launch InkScapeTM, but make
sure to have all frames of the plot already placed. Such
elements can only be added in the Plot Designer. InkScapeTM
allows for the adding of additional graphics and comments,
as well as editing text and numbers, but is not integrated
with the database information of a project in HawkEyeTM.
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When InkScapeTM opens, all of the elements
that have been placed in the Plot Designer
will appear in the same paper size but in
SVG layers. Although it may appear a
jumble, now each of the elements can be
moved about freely and precisely. If the plot
in InkScapeTM appears small, hit “5” to
automatically fit the plot to screen width and
height.
LAYERS: The SVG elements (plot frames and
graphics) in InkScapeTM are treated as sets of
layers, which can be selected individually, in
groups or even linked together. Select a layer
by double-clicking on it in the graphic
window. By double-clicking again and again
on an element, different layers within that
element are selected. Double-click on any
blank space in the graphics window to get
back to the root layer. The layer indicator appears at the bottom left of the screen.
ZOOM: Select the magnifying glass icon on the left side of the screen to go into zoom
mode and simply draw a box over any portion of the graphics window to zoom into
that area. To get back to the whole page view, hit “5” on the keyboard. Advanced zoom
preferences can be explored in the Preferences panel (File>Preferences or Shift+Ctrl+P)
which allow for things like zooming with the scroll wheel.
MOVING OBJECTS: To move an object, it
must be selected. Since InkScapeTM works in
SVG, there are often multiple layers to each
object. A singular element may be selected
when trying to move an entire object, resulting
in fragmentation. When this occurs, simply hit
Ctrl+Z to undo the move, then double-click on the object until it is selected in its
entirety. After a little practice, this becomes second nature. And sometimes particular
layers of a list or grid will need individual nudging, so it’s a valuable tool. One hint is to
keep an eye on the layer name at the bottom and get accustomed to how the layers are
labeled.
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RESIZING: When an object is selected, arrows will appear at its corners and sides.
These are “handles” which can be clicked on and dragged to resize the object. One
major issue with resizing an object is the aspect ratio. (Ctrl+Z to undo unwanted
resizings). InkScapeTM has two methods of retaining aspect ratio when resizing an
object. 1) Hold down SHIFT while dragging a corner
handle of an object, or
2) Click the “Lock” icon at the top while the object is
selected. This will permanently lock the aspect ratio for
that selected object. Be sure that the entire object is
selected and not just one layer in it.
GROUPING: Two or more objects can be “grouped” or
locked in an orientation and moved as one object. This is
useful for when getting graphs placed on top of each
other and not wanting to re-place the graphs when
moving them around the plot. To group objects, they
must all be first selected at once. To select multiple
objects, select one then HOLD SHIFT while selecting
another. Or draw a box over all the objects to be selected
with the black arrow selector tool and they will be
simultaneously selected. Then as a final step, click the “Group” icon at the top of the
page to marry all the objects together. Any group will be moved and resized as if it
were one object.
SENDING LAYERS TOP AND BOTTOM: Since all
objects are layers, they are stacked from front to back, or
“top” to “bottom.” Layers that are closer to the top are
displayed when overlapping any layers that have a
lower status or designation. In laying out a complex
plot, there will be objects that overlap each other and usually the smaller elements will
need to be on top so that they are not covered by the larger ones. To control the layer
status of an object, just select it, then go to the four icons at the top of the screen. They
will either 1) Lower selection to bottom, 2) Lower selection down one level, 3) Lower
selection up one level, or 4) Lower selection to top.
ADDING TEXT AND NUMBERS: InkScapeTM allows for
the adding of comments, as well as the editing of text
fields within lists that have been added from HawkEye’s
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Plot Designer. The first step is to set up the font and size settings. Do this by clicking on
the Text and Font panel box at the top of the page or hit Shft+Ctrl+T. Click “Set as
default” in the panel to make those settings permanent.
Then select the Text Tool on the bottom of the left side (or hit F8). As
with all specialized tools in InkScapeTM, the cursor will change to
indicate which mode the user is in. Here the cursor is a crosshair with
the letter “A.” Use the Text cursor to draw a box on the graphics
window. This will create a text box in which text can be entered.
PASTING TEXT: Once this text box is drawn, simple text can also be pasted into the
box from other programs. But note, InkScapeTM will only display simple text and none
of the more complex formats. Any changes to font, size and color must be done after
pasting into the textbox.
Color of the text can easily by changed by 1) selecting the text box itself, then 2) clicking
on a color along the color palette bar that stretches along the bottom of the screen.
Editing the text field within a list is as simple as
clicking on that field and typing in or deleting
whatever data is there. But remember that InkScapeTM
is not integrated with the project database
information itself, so whatever data changes are made
in InkScapeTM are neither saved to the project nor
verified by HawkEyeTM in any way.
ALIGN TOOLS: To make sure that any or all objects
are aligned correctly, select any or all objects and click
one of the alignment options found on the right-hand
side of the screen. If the options are not displayed,
then hit Shift+Ctrl+A for them to appear.

PRINTING: The recommended way to print the final plot is to first SAVE AS A PDF
(File>Save As, then select “Portable Document File” as filetype). After saving the file as
such, open it with Adobe Reader, which is free and should be installed on any
computer, and select print options from there.
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b. Tips and Tricks
1. Setup Tips
As with HawkEyeTM, spending a little time to explore InkScapeTM will pay back in
spades. In the case of InkScapeTM, the better one is with its interface, the more advanced
and professional-looking a plot will have the potential to be. There are many great
tutorials
online
for
InkScapeTM.
A
basic
starter
is
found
at
TM
http://InkScape .org/doc/basic/tutorial-basic.html. There are certain preferences and
tricks in InkScapeTM which grease the wheels navigation and of enhancing plot-design.
Here are a few setup tricks:
SCROLL ZOOM: Zooming in and out with a scroll wheel is convenient and can save a
lot of time with large plots. Since HawkEyeTM users should be using a hyperscroll
mousewheel, the zooming can become a convenient second-nature activity. But the
option needs to be turned on.
All preferences are found under
File>Preferences (Shift+Ctrl+P), and
each of them is divided into categories
on the left column in the preferences
panel. To turn on the Scrollwheel
Zoom feature, click on “Scrolling” in
the Preferences window. Then check
“Mouse wheel zooms by default.”
Another useful option to turn on here
is LEFT MOUSE BUTTON PANNING.
Just check the box labeled “Left mouse
button pans when Space is pressed.”
This option will do just that.
FIT TO PAGE: Set InkScapeTM to always fit
to page when opening by going to
File>Preferences (or Shift+Ctrl+P), then in the
Preferences scroll down the left column to
“Windows” and check the “Zoom when
window is resized” box. Also remember, hit the number “5” on
the keyboard to autofit everything to the screen in its entirety.
You may also click on the “Fit to Page” icon at the top of the
screen.
2. Drop Shadows
258
HawkEye

TM

User’s Manual

Copyright © 2015 by Performance Drilling Technology

Adding graphical flourishes to plot objects is the whole point of InkScapeTM in
HawkEyeTM. One essential such embellishment is the drop shadow, which gives a frame
a sense of depth.
To add shadow to a frame, first select the frame by clicking on the
Rectangle Selector, then with the plus-rectangle cursor, click on the frame.

Once the frame is selected, go to Filters>Shadows and
Glows>Drop Shadows. This opens the Drop Shadow
dialogue in which the shadow can be highly customized. But
the default drop shadow is a fairly decent as it is. Click
“Apply” and the drop shadow will appear “behind” the
frame. It is actually part of the layer and will move/resize
with it. To edit this effect, just select the frame and go back to
the Drop Shadow dialogue.

Drop shadows will add a sense of depth to any frame, enhancing the plot with a
3D feel. Many other effects are found under the “Filters” menu in Inkscape.
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3. Arrow Pointers
Complex parametric curves (Bezier curves) can be dropped onto a plot in InkScapeTM as
arrows to simulate the organic look of handwritten marker notation. This effect is useful
for callouts and has the advantage over actual marker notations because the arrow and
comments are both cleanly defined and editable before printing.
To make such an arrow pointer, first select the Bezier Drawing Tool on the left side of
the screen. Once selected, click on the screen once (1) with the tool to set the first point,
then click a second time (2) to place the Bezier pivot point. Finally click a third time (3)
after bending the hypothetical curve to create the end point. The straight line will
disappear and only the curve will remain.

Once the curve is created, its style can be edited in the Fill,
Stroke Paint and Stroke Style panels on the top right corner of
the screen. This panel is available for many objects in
InkScapeTM and provides a wide array of customization options.
Select the color under the Stroke paint tab.
To make the curve an arrow pointer, it is simply a matter of
selecting a “Start Marker” and “End Marker” under the Stroke
style tab. The choices are many under these drop-down menus
and just by changing the endings a curve can transform into
many different objects.
EDIT THE CURVE: Click on the “Edit Path Nodes” icon just below the black arrow
icon on the top left of the screen, or hit F2 to go into “Edit Path Nodes” mode in order
reactivate the draw nodes of the curve. Now by dragging the nodes around, the arrow
is re-drawn on the fly, but will retain its start and end markers. This is necessary for
precision placement on a plot.
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ADD TEXT: To add a text box, click on the “Text” icon on the bottom left, or hit F8 to
go into Text Mode. Then draw a box onto the graphics window and type in any desired
comments. This box can be placed at the end of the pointer to create a callout.

SAVE THE ARROW POINTER: Select the entire arrow, then go File>Save As and save
the arrow as a .SVG file. This will save the arrow as an importable object that can later
be added to other plots.
To IMPORT the arrow, just go File>Import… (Ctrl+I), then select the file from wherever
it was saved. Editing the direction of the arrow in new plots simply requires hitting the
F2 button to activate the Edit Nodes mode and then dragging those nodes around until
it is shaped just right.
10.
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VII.

THE WELL PLANNING MODE

TWO MODES: There are two overall modes in
HawkEye. The Field Mode is default and available
in both versions. It is used for directional drillers
who are not creating much in the way of complex
proposals or well plans. Whereas the Well
Planning Mode, available only in the Well
Planning Version, is used to created complex well
plans.
To get into the Well Planning Mode, you need
the Well Planning Version of HawkEye.

TWO DIFFERENCES BETWEEN THE TWO VERSIONS
1. PRINTING PLOTS: The difference between the Field Version and Well Planning
Version of HawkEyeTM with plotting is that only in the Well Planning Version will
the larger wall plot sizes be available for printing and exporting. Only the smaller
paper sizes are available in the Field version since it is assumed that users of the
Field Version will not need a plot printout larger than A3.
Exclusive Well Planning Version print sizes include: A4, A2, 11x17, ISO A0-2, ISO
B1, B1-B4(JIS), ARCH A-E1, Folio [8.5x13in], 22x36in, 24x48in, 24x60in, 24x72in,
24x84in, 24x96in, 24x108in, 36x42in, 36x60in, 36x72in, 36x84in, 36x96in, 36x108in and
PostScript Custom.
2. EDITING PROJECTIONS: The principle difference to keep in mind between the
Field Version and Well Planning Version of HawkEyeTM is that, although they both
have the same arsenal of projections which can be appended end to end, only in the
Well Planning Version can a projection be edited at any segment and have the
whole plan recalculate.
In other words, in the Field Version, only the last appended projection can be edited,
so that in order to edit a part further up the curve, the user must delete all appended
parts of the curve made subsequent to that higher up part before editing it. In Well
Planning, the proposal is “poseable,” a model with hundreds of points of
articulation.
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7. Well Planning Control Panel
OPENING THE WELL PLANNING MODE: The Well Planning Mode is activated by
clicking on the compass-and-protractor icon on the far right end of the “Home” tab.
TM
(This Icon does not appear in the Field Version of HawkEye .)

The Control Panel that appears just below the projection icons contains a number of
powerful tools, most of them centered around profiles that contain sets of projections.
When this subpanel is activated this is what is referred to as being in the “Well Planning
Mode” as opposed to being in the Field Mode. In the “Well Planning Mode,” the curve
you are working with is a temporary curve that is not committed to the current
Proposal Curve until “Apply To Proposal.”
In order to commit this curve as the proposal curve it is necessary to click the “Apply to
Proposal” button. The ‘temporary’ curve that constitutes the projection segments is
saved to the database so that should you desire to make changes at a later time you can
return to the Well Planning Mode and alter what you want. Once you click the “Clear”
button, however, this segmented curve is erased permanently.

ADD A PROJECTION: The “Add to Plan” button is tied to the “Projection” drop-down
menu, allows for individual projections to be appended to the end of the current plan.
Select from MD, TVD, Nudge (stilled called Quija here), Slant, Aligned or Horizontal,
and the respective panel for that projection will appear below in the list of active
projections.
DEFAULT PROFILES: The special controls of the Well Planning version allow the user
to load well profiles, as well as save new ones. The default profiles under the “Profile”
dropdown menu are the most common type of profiles and are designed so that all the
user need do is load the profile and fill in the white background grid cells, perhaps
select a target if it isn’t already selected, and have a solution.
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The “Profile Name” drop-down menu contains several default profiles to choose from,
and will also contain any saved user-created profiles. The default profiles are:








Simple 2D S-well (w/special profiler tool)
Simple 2D Slant (w/special profiler tool)
Find KOP S-well
Find KOP Slant
Default Slant
Default Aligned
Default Horizontal

Once a profile is selected from the drop-down menu, click “Load Profile” to the right of
the menu.
If a “targeted” projection (Slant, Aligned, BOT and Horizontal) is selected, then
HawkEyeTM needs a First Target. Designate a target as First Target by right-clicking on
one in the Data Tree and select “Set as the First Target,” or by selecting it from the
dropdown list in the “Home” tab. Then click “Load Profile” again.
WELL PLANNING LIST PANEL: Normally in the Field
Mode the window at the bottom of the main screen lists
curve data (surveys, critical points, comments, etc.). But
in the Well Planning Mode, the Well Planning list tab
appears, allowing the display of each projection of a
curve in a list. For each projection type, there are a
number of columns of information in which the WHITE
cells can be edited independently of other parameters.
The parameters for each projection in the well planning list are:






Projection (type)
Target
MD
CL
Inc Deg







Azm Deg
EVD
NS
EW
Easting







Northing
TVD
DLS
TFA† Deg
Comment

TFA stands for Tool Face Angle and is the same as TFO
MAKE CHANGES: When a profile is loaded, it will have with it default values for KOP
and DLS as well as other parameters. Any of these projections can be changed or
nudged by finding the parameter in the Well Plan List Panel at the bottom of the screen,
clicking on the field in question, and changing the number right there in the field.
†
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NOTE: Only cells in white can be changed. Changes to the projection are usually
instantaneous, but are not automatically applied to the proposal. (For aligned
projections, you must click “CALCULATE” after each change). After changes are made
here, but before they are applied, they are still in the status of a projection.
APPLY TO PROPOSAL: When it is decided that any changes made to a proposal are
acceptable, click “Apply to Proposal” to integrate changes to the current proposal curve.

After a profile is loaded, click on any projection in the List Panel at the bottom
and its respective control panel will appear. Parameters in white may be changed
in the special panel or in the List Panel. Click “Apply to Proposal” to lock in
changes.

In the example above, a change in KOP is made higher up the curve, resulting in the
green projection deviating from the proposal in blue. By clicking “Apply to Proposal,”
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the changes made will become the new proposal and override the old one. In this
fashion the Well Planner controls allow for quick fine-tuning of proposals.

ADD NEW PROPOSAL: Clicking this button
on the far right of the Well Planning Panel will
launch the “Add New Curve” dialogue. It will
create either a Proposal or Survey curve under
the current slot/wellhead, and that curve can be
assigned to any jobs from the database. The
“Job” button here will launch the Jobs dialogue
in which job information can be added and
edited.
Any new Proposal Curve added from the Well Planning panel will automatically
become the Current Proposal Curve, and projections, if applied, will be added to this
particular curve.
SAVE AS NEW PROFILE: Click the “Save As New
Profile” button to save the current projection set, as
displayed in the 3D and List Panel at the bottom of the
screen, as a profile that can later be conveniently
invoked as a whole. Any new profiles are saved to the
current database, and they become available in the “Profile Name” drop-down menu.
(This process is described in further detail in the subsection “Build a Custom Template”
below.)
TIE TYPE and CURVE: A Tie In can be added with this toolset, either from the Well
Head or a Well Path. (This process is described in further detail in the subsection “Tie
Ins” below.)
KOP: This turns on the search for KOP flag for either the Aligned well, or the Slant
well. Be aware that this can be a time consuming process, particularly with an Aligned
well since there is a great deal of iteration that the computer does in order to find a
solution.
Field Mode View: This closes the Well Planning control panel and brings
TM
HawkEye back into the default Field Mode.
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a. Simple 2D S-Well Profiler
Within the Well Planning Control Panel, selecting the
“Simple 2D S-Well” from the “Profile Type” pulldown
menu will invoke the dedicated profiler for this well
type.

The “Simple 2D SWell Profiler”:
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FIRST TARGET: Since S-wells are “targeted projections,” a first target must usually be
set. If a first target has not been set yet, find the target to be set either in the Data Tree,
3D space, right-click on it and select “Set as First Target.”
Or set it from the Target Selector pulldown labeled “First Target” under the “Home”
tab.
HOW TO USE 1ST TARGET: The top left option
in the Profiler allows the user to either ignore
First Target (for when creating an open plan) or
treat it as the PBHL (Proposed Bottom Hole Location). When “Don’t Use” is selected,
the profiler will create a target where the projection ends and call it “PBHL” by
default.
S-CURVE PROPERTIES SOLVER: Throughout this colorful list of parameters, the
important rule of thumb to keep in mind is that the fields in red cannot be changed,
whereas the fields in white can be changed. These fields change depending on which
solve mode is selected.

In the Solver, different fields are editable depending on which solve mode is
selected (from the 6 radio buttons on right). Red fields are uneditable while
white fields are editable. Click “Calculate” to register parameter changes.

The Solver has 10 different parameters which shape the S-Well. The properties are:


KOP- The depth at which the first build in the S-Well begins.
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Start Inc- The starting inclination. It is always set to ‘0’ and can’t be changed for
this type of plan.
Build Rate- The degree of turn per 100 ft along the first turn.
Hold Angle- Angle in degrees of the tangent / hold section.
Tangent- Length of the tangent / hold section between the upper and lower
curves. If this is set to 0 and the radio button to the right is set, then the
program will solve for a kick off point.
Drop Rate- Drop rate in degrees per 100ft or degrees per 30 meters. Note that
this does not have to drop, it can also build if it is a horizontal well.
Entry Angle- Degree at which the second turn ends. 0 degrees will make the
curve going straight down at the end of the second turn.
Extension- This is the distance of straight extension BEFORE the target and at the
end of the drop of the second curve.
V. Section- This is the closure distance or vertical section distance of the target
point at the end of the proposal This can be a locked parameter with the
“Locked” checkbox of the Well Properties just below the Solver. When this is
locked it is in essence defining the target point, as opposed to an open solution in
which the target pt would be defined by the solution.
Delta TVD- Difference between the KOP and the Target TVD.

As changes and solutions are made, they are displayed in the vertical section view
immediately to the right of the Solver, all color coded to the background color of the
various solver parameters.
In addition, critical points data is displayed in spreadsheet format in the list panel at the
bottom of the profiler. This allows the user to see details of the curve that are not always
apparent in either the in-profiler VS View or Solver fields.

WELL PROPERTIES: The “Target TVD” and “Well Direction” fields under this
heading will only be activated if no target is used. To NOT use a target, just select
“Don’t Use” at the top left of the profiler where it says “How to Use 1st Target.” The
“Locked” checkbox will lock these parameters into place even other parameters are
changed.
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CREATE TARGET PLANE: Check this box in the Profiler to turn on a target plane in
the 3D space. When the profile you make is sent to the 3D space, it will generate a target
plane along the first straight tangent section. This target plane will remain even if the
profile is cleared away.
CREATE WAY POINT TARGET: Check this box to
automatically generate a target (default name: “Way Point”) at
the beginning of the first turn in the S-Well. This target will
remain even if the profile is cleared away. Example at right.

SEND TO 3D SPACE: This button acts as an “APPLY” button,
porting all of the S-Well changes made in the Profiler into the
3D space. This option will be a prompt when clicking “OK” just
in case the user forgets. When an S-Well is sent into the 3D
space from the Well Planning Profiler, a Nudge projection is
inserted for the first half of the first build.
This feature provides a sort of hinge, allowing the user to nudge the Quija (Nudge)
portion of the s-well and redirecting the entire curve left or right while retaining all
features below the first turn. To tweak the Quija (Nudge) component or any other part
of the well, return to the Well Planner Mode, then click on the desired projection in the
List Panel at the bottom of the screen.

When the Quija (Nudge) row is clicked, its special control panel appears for editing. If
the Tool Face, for example, is changed in this Quija (Nudge) section, then the entire
curve will be redirected yet maintain its build characteristics. You can edit any
parameters directly in the List Panel which have a white background.
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1. S-Well Defined Without Targets
The first three steps to creating an S-Well without targets is to:
1) Select “Don’t Use” at the top left of the Profiler, then
2) Check “Extension” to solve for extension.

3) Uncheck the “Lock” checkbox at the bottom in Well
Properties in order to allow for the editing of the V. Section
field. It may also be a good idea to click the Erase icon to clear
all the fields.

From there, in the Solver, enter a KOP, Build Rate, Tangent, V.Section (Vertical Section)
and Delta TVD. After the last two parameters are entered, the Profiler will solve for a
Target TVD. The final step is to enter a desired Well Direction at the bottom.
Create the target points by checking “Create Target Plane”
and “Create Way Point Target” at the bottom under the graph.
Then click “OK” and make sure to “Send to 3D Space” when
prompted.
The curve will appear in the 3D space going through two
targets and along a target plane. Just as with the targeted SWell made from the Profiler, this S-Well contains a Nudge
projection near the top that allows for powerful nudging
options which preserve the S-Well’s characteristics. Any of the
projection components of the well can be accessed and edited
by clicking on the projection in the List Panel at the bottom of the screen.
Once the curve is nudged and adjusted, click “Apply to Proposal” in the Well Planning
Control Panel and it will make this curve a proposal curve.
TM

Click the “Field” Mode to get back to the main HawkEye module and the S-Well will
be displayed as a proposal curve along with the targets generated and listed.
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b. Simple 2D Slant Profiler
Within the Well Planning Control Panel, selecting
the “Simple 2D Slant” from the “Profile Type” dropdown menu will invoke the dedicated Profiler for
these well types. The parameter set for both slant
wells and horizontal wells are identical since both
consist of a single turn.

You will open up the “Simple 2D Slant / Horizontal Profiler:
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FIRST TARGET: Since Both Slant and Horizontal projections are “targeted
projections,” a first target must usually be set. If a first target has not been set yet, find
the target to be set either in the Data Tree, 3D space, right-click on it and select “Set as
First Target.”
Or set it from the “First Target” dropdown under the “Home” tab at the top of the
screen.
HOW TO USE 1ST TARGET: Choose from the top
left box in the Profiler how to build the profile
around the target.
 Don’t Use- This option allows the user to make the Profiler determine where a
target should be after providing certain parameters. When “Don’t Use” is
selected, the profiler will create a target where the projection ends and call it
“PBHL” by default.
 As Landing- This means set the target to the landing point which is another way
of saying: “Solve for the minimum build rate that is required to achieve the
desired inclination at the landing point. The KOP will be determined as a
function of that.”
 As PBHL- Treating the target as a Proposed Bottom Hole Location is the default
method of target utilization, with the target acting as the end point designation
for the curve.
CURVE PROPERTIES SOLVER: As with the S-Well Properties Solver (found in the SWell Profiler), the rule of thumb is that the fields in red cannot be changed, whereas the
fields in white can be changed. These fields change depending on which solve mode is
selected. Select for a solve mode by clicking on one of the three radio buttons on the
right.
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In this Solver, different fields are editable depending on which solve mode is
selected (three radio buttons on right). Red fields are uneditable while white
fields are editable. Click “Calculate” to register parameter changes.
The Solver for Slant/Horizontal wells has 8 different parameters which define the well.
The properties are:











KOP- The depth at which the first turn in the S-Well begins, usually after the
initial straightaway from the surface.
Build Rate- The degree of turn per 100 ft along the first turn.
Start Inc- This is the initial inclination, which is always zero for this type of plane
End Inc- The landing inclination
Landing Disp- Displacement in feet or meters to the landing point, illustrated by
the Dark Green upper line in the diagram
Delta TVD- The change in True vertical depth on the curve. The Red Line
illustrates this distance.
Delta MD- The change in measured depth from the beginning of the curve to the
end of the curve. The Blue Line represents where this distance is calculated.
Dip Angle- The dip angle is calculated as 90-Landing Inc. So a curve that has a
landing angle of 88 degrees would have a 2 degree dip. The Maroon Line
represents where this angle is calculated, relative to an imaginary horizontal line.
Above Dip- The Above dip distance is represented by the Black Line on the left.
This is the distance above the formation at the beginning of the kick off.

WELL PROPERTIES: Unlike the S-Well Profiler, the “Well
Properties” fields are uneditable regardless of which solve
mode is selected. These fields merely indicate the figures
shown. These parameters indicate several crucial bits of
information:
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Landing TVD- The Target TVD
Well Direction- The azimuth direction in which the well is being planned.
Extension- The extension is the amount of tangent Measured Depth before
reaching the Landing TVD, aka. the Target.

CREATE TARGET PLANE: Check this box in the Profiler to turn on a target plane in
the 3D space. Target Planes in the 3D space are a very useful visual tool. They can
easily be created within the 3D space by selecting a tangent section on a curve that the
right-clicking for the context menu and then selecting ‘Create Target Plane’. But, if you
know you want to have a target plane then it is even easier to have one automatically
created
CREATE WAY POINT TARGET:
Common practice in directional
drilling is to have the point at the
end of the build section identified as
a target. This is more commonly
referred to as a waypoint. Selecting
this option will have the program
automatically create a waypoint
target at the end of the first turn in the curve. The target will be named “Way Point”
with its TVD by default.
SEND TO 3D SPACE: This button acts as an “APPLY” button, porting all of the
Slant/Horizontal well changes made in the Profiler into the 3D space. This option will
be a prompt when clicking “OK” just in case the user forgets.
COMES WITH A NUDGE INSTALLED: Just like the S-Well, when a Slant/Horizontal
well is sent into the 3D space from the Well Planning Profiler, it is equipped with a
Nudge projection at the first turn.
This feature acts as a sort of hinge, allowing the user to nudge the Nudge portion of the
well and redirecting the entire curve elsewhere while retaining all features below the
first turn. To tweak the Nudge component or any other part of the well, return to the
Well Planner Mode, then click on the desired projection in the List Panel at the bottom
of the screen.
When the Nudge row is clicked, its special control panel appears for editing. If the Tool
Face, for example, is changed in this Nudge section, then the entire curve will be
redirected yet maintain its build characteristics.
275
HawkEye

TM

User’s Manual

Copyright © 2015 by Performance Drilling Technology

c. Find KOP Slant
The “Find KOP Slant” is the first of the profiles to not have a dedicated profiler tool. It
is styled like all the remaining profiles in that it gives you a series of projections with
which you can tweak, add to or take projections out of. This profile will look for the
optimal KOP given the parameters that you enter into your slant projection panel.
LOAD PROFILE: This profile does not have a
dedicated profiler tool pop up when you select it.
Remember to click “Load Profile” after selecting this
and all profiles below this one.

SET FIRST TARGET: Since the Slant projection is a targeted projection, a First Target
must be set. If a first target has not been set yet, find the target to be set either in the
Data Tree, 3D space, right-click on it and select “Set as First Target.”
Or set it from the “First Target” dropdown under the “Home” tab at the top of the
screen.

CHANGE INCLINATION FROM THE LIST PANEL: If the resulting proposal curve is
not exactly what is needed, any of the projections composing the curve can be edited.
The fields in white can be edited directly in the List Panel. To change other parameters
of a given projection, click on the name of the projection and its own control panel will
appear.
Below is the projection series created by the “Find KOP S-Well,” with “Target1” set as
the First Target. The inclination of the first slant can be changed to affect the KOP:
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Changes are updated instantaneously to the 2D and
3D space. To the right is a typical “Find KOP Slant”
profile, with the parameters from the previous List
Panel screenshot.
Here, the KOP is seen in the List Panel as 2038.6
feet. The build is at 30 degrees inclination and 45
degrees azimuth.

APPLY TO PROPOSAL: Remember that any list of
projections that you create in the Well Planning
Mode will not appear in the Field Mode and
become a part of your Proposal Curve until you
click “Apply to Proposal.”
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d. Find KOP Aligned
The “Find KOP Aligned” is a standard style Well Planning profile in that it gives you a
series of projections with which you can tweak, add or take projections out of. This
profile will look for the optimal KOP given the parameters that you enter into your
aligned projection panel.

LOAD PROFILE: This profile does not have a
dedicated profiler tool pop up when you select
it. Remember to click “Load Profile” after
selecting this and all profiles below this one.

SET FIRST AND SECOND TARGET: Since the Aligned projection is a targeted
projection, a First Target must be set. Additionally, it is the only projection which uses
the Second Target. If a first and second target has not been set yet, find the target to be
set either in the Data Tree, 3D space, right-click on it and select “Set as First Target.”
Or set it from the “First Target” and “Second Target” dropdown under the “Home” tab
at the top of the screen.
EXTEND TO NEXT TARGET: With the Aligned projection,
if you want to hit two targets you will need to open up the
Aligned Projection control panel by clicking on the aligned
projection in the List Panel below.
Once the control panel is open, check the “Use Vector to
Second Target” and “Extend to Next Target” boxes. This
will ensure that the projection is calculated to pass through
the First Target and end at the Second Target.
NOTE: With the Aligned projections, always remember to
hit the “Calculate” button, either in the small control panel
or the Well Planning Control Panel on the far right.

CHANGE INCLINATION FROM THE LIST PANEL: If the resulting proposal curve is
not exactly what is needed, any of the projections composing the curve can be edited.
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Below is the projection series created by the “Find KOP Aligned,” with “Target1” set as
the First Target and “Target2” set as Second Target:

The fields in white in the List Panel can be edited directly. To change other parameters
of a given projection, click on the name of the projection and its own control panel will
appear. In the example above, since the “Find KOP” box is checked under our “Find
KOP Aligned” profile, we can directly change the Inclination on the first aligned
projection. This will cause the KOP to be recalculated.
MUST CLICK “CALCULATE”: For profiles
containing aligned projections such as this
one, changes are updated to the 2D and 3D
space after clicking “Calculate.”
To the right is the vertical section view of a
typical “Find KOP Aligned” profile, with the
parameters from the List Panel above. Here,
the KOP is seen in the List Panel as 1731.84
feet. The DLS values are at 6 and 4, according
to the Aligned Projection control panel. The
curve hits Target1 and extends in a straight
tangent for 1417.74 feet to hit Target2.

APPLY TO PROPOSAL: Remember that any
list of projections that you create in the Well
Planning Mode will not appear in the Field
Mode and become a part of your Proposal Curve until you click “Apply to Proposal.”
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e. Default Slant
The Default Slant profile is similar to the Find KOP Slant profile except that it is not
solving for a KOP given a user-provided inclination. Instead, a KOP must be provided,
as well as DLS and Hold Angle numbers for the slant projection portions.
LOAD PROFILE: This profile does not have a
dedicated profiler tool pop up when you select it.
Remember to click “Load Profile” after selecting
this and all profiles below this one.

SET FIRST TARGET: Since the Slant projection is a targeted projection, a First Target
must be set. If a first target has not been set yet, find the target to be set either in the
Data Tree, 3D space, right-click on it and select “Set as First Target.”
Or set it from the “First Target” dropdown under the “Home” tab at the top of the
screen.

CHANGE KOP FROM THE LIST PANEL: If the resulting proposal curve is not exactly
what is needed, any of the projections composing the curve can be edited. The fields in
white can be edited directly in the List Panel. To change other parameters of a given
projection, click on the name of the projection and its own control panel will appear.
Below is the projection series created by the “Default Slant,” with “Target1” set as the
First Target. The KOP can be changed:

Changes are updated instantaneously to the 2D and 3D
space. To the right is a typical “Default Slant” profile,
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with the parameters from the previous List Panel screenshot.
Here, the KOP was defined in the List Panel as 3000 feet. The build is at 27.01 degrees
inclination and 79.30 degrees azimuth. The DLS for this curve is 5 degrees per hundred
feet, and that could be reduced by decreasing the user-defined KOP.
APPLY TO PROPOSAL: Remember that any list of projections that you create in the
Well Planning Mode will not appear in the Field Mode and become a part of your
Proposal Curve until you click “Apply to Proposal.”
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f. Default Aligned
The “Default Aligned” is a standard style Well Planning profile in that it gives you a
series of projections with which you can tweak, add to or take projections out of. This
profile will allow you to change your KOP as well as your inclination and azimuth
upon reaching the first target.

LOAD PROFILE: This profile does not have a
dedicated profiler tool pop up when you select it.
Remember to click “Load Profile” after selecting
this and all profiles below this one.

SET FIRST AND SECOND TARGET: Since the Aligned projection is a targeted
projection, a First Target must be set. Additionally, it is the only projection which uses
the Second Target. If a first and second target has not been set yet, find the target to be
set either in the Data Tree, 3D space, right-click on it and select “Set as First Target.”
Or set it from the “First Target” and “Second Target” dropdown under the “Home” tab
at the top of the screen.

CHANGE KOP AND INC/AZM AT FIRST TARGET: If the resulting proposal curve is
not exactly what is needed, any of the projections composing the curve can be edited.
Below is the projection series created by the “Default Aligned,” with “Target1” set as
the First Target:

The fields in white, here the KOP and Inc/Azm at First Target, can be edited directly. To
change other parameters of a given projection, click on the name of the projection and
its own control panel will appear.
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MUST CLICK “CALCULATE”: For profiles
containing aligned projections such as this one,
changes are updated to the 2D and 3D space
after clicking “Calculate.”
To the right is the vertical section view of a
“Default Aligned” profile, with the parameters
from the List Panel above. Here, the KOP was
set in the List Panel at 781.64 feet. The curve
hits Target1 at 0 degrees inclination and
azimuth, or in other words straight down from
the top.

EXTEND TO NEXT TARGET: With the Aligned
projection, if you want to hit two targets you will need to
open up the Aligned Projection control panel by clicking on
the aligned projection in the List Panel below.
Once the control panel is open, check the “Use Vector to
Second Target” and “Extend to Next Target” boxes. This
will ensure that the projection is calculated to pass through
the First Target and end at the Second Target.
NOTE: With the Aligned projections, always remember to
hit the “Calculate” button, either in the small control panel
or the Well Planning Control Panel on the far right.
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When extending to the next target, the program will recalculate the aligned projection
to automatically hit Second Target from the First Target. In the example below, once the
projection was told to use vector to second target, it calculated that it needed to hit First
Target at 90 degrees inclination and 45 degrees azimuth:

APPLY TO PROPOSAL: Remember that any list of projections that you create in the
Well Planning Mode will not appear in the Field Mode and become a part of your
Proposal Curve until you click “Apply to Proposal.”
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g. Default Horizontal
The “Default Horizontal” profile contains the horizontal projection, which is a targeted
projection but will not use First or Second Target. Instead, just like when making a
horizontal projection in the Field Mode, you must define a target plane from within the
control panel.
LOAD PROFILE: This profile does not have a
dedicated profiler tool pop up when you select it.
Remember to click “Load Profile” after selecting
this and all profiles below this one.

DEFINE YOUR TARGET PLANE: Just as in the Field Mode,
the Horizontal Projection can only be calculated upon
defining the target plane which it is supposed to hit. So when
the “Default Horizontal” profile is loaded, you must click on
the “Horizontal” projection in the List Panel below and enter
some parameters into the control panel that pops up.
Here, we have defined a plane that sits at 5000 feet RKBTVD,
with no dip in any direction, and we want the curve to strike
the plane at a 90 degree angle (flat), at a direction of 45
degrees, with no extension. The program calculates that this
will require a low 1.91 DLS.
MAKE TARGET PLANE: By clicking the “Make Target Plane,” this projection will
automatically generate a target plane in the 3D space that will be associated with your
current platform/pad. Generating the target plane may help to visualize how and where
the curve strikes the plane.
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MAKE CHANGES IN THE LIST PANEL: As is the case with all data in the Well
Planning Mode’s List Panel, white fields are editable. Taking a look at the List Panel
below. Here, we can change the KOP, strike azimuth and total depth of the plane itself:

As can be seen in the vertical section view to the
right, the Horizontal projection profile can be
used to make a smooth “landing” with a low DLS.

APPLY TO PROPOSAL: Remember that any list of projections that you create in the
Well Planning Mode will not appear in the Field Mode and become a part of your
Proposal Curve until you click “Apply to Proposal.”
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h. Tie-Ins
Adding tie-ins in the Well Planning Mode is conceptually the same as doing it in the
Field Mode. The advantage here is that it can be nudged and modified by any
parameter at any point, which is the general advantage of working in the Well Planning
Mode.
TIE TYPE: To create a tie-in from the Well Planning Control Panel, DON’T select a
profile. Instead, first select the type of tie-in to be created from the “Tie Type” dropdown menu. The choices are Well Head or Well Path. In the following example, the tiein will be off of the well path.
TIE CURVE: When “WellPath” is selected as the tie-in type, the “Tie Curve” dropdown menu is activated and a curve from which to tie in can be selected. Keep in mind
that you cannot launch a tie-in from the current curve that you are on: it must be from
either the survey curve or another proposal.

Once a tie-in base curve is selected, by default, the tie-in will start at the END of the
selected tie-in base curve. This entry appears in the List Panel as “Tie in.” Change where
the tie-in starts by changing the MD in the List Panel.

ADD PROJECTION: The next step is to select a projection type to use as the tie-in
curve from the “Add Projection” drop-down menu. When any projection is selected, its
special control panel appears inside of the 3D window, where it always normally
appears.
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In this example, a horizontal projection is used as the tie-in off
of horizontal proposal. When a horizontal projection is made, a
target plane must be defined and this is done in the Horizontal
Projection panel. It is defined by its RKBTVD, Max Dip and
Max Dip Direction. In this case, the target plane is contacted
2500 feet below the surface location, its maximum dip angle is 3
degrees and its direction is 78 degrees.
For the tie in, the strike inclination is defined as 93 degrees, and
the strike azimuth is 258 degrees, which is exactly 180 degrees
opposite the proposal’s azimuth. The tie-in is also given an
extension of 3000 feet and the DLS is automatically calculated
at 14.61 in order to accommodate these parameters.
ADD: The next step is to click the “Add” button. This will create the curve and it will
appear both in the 3D space as a translucent projection as well as the next projection
entry in the Well Planning List Panel (just below “Tie in). (See 9.1.8 video for reference)

The new tie-in is also reflected in the 2D and 3D space as a translucent projection.

By changing the “MD” value of the Tie-in in the List Panel, the actual tie-in point can be
manipulated. Notice that when the tie-in’s MD (tie-in point) is changed from 2050 to
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2100, it starts lower off of the base curve and ultimately adopts a more severe dogleg
severity to attain its assigned strike inclination.

To get the exact desired dogleg severity, the user can keep changing the MD until the
right DLS value is generated. Such “what-if” games can be played in the Well Planning
version for all sorts of parameters in order to create an optimal curve.
When the tie-in curve has been articulated to user spec, click “Apply to Proposal” and it
becomes part of a multilateral proposal curve. Click the Field Mode icon
to the main HawkEyeTM interface and see the proposal curve.

to get back
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3. Build a Custom Well Planning Template
Once the Well Planning Control Panel has become familiar, creating customized profiles
is straightforward. The principle tools are the “Add” button and the List Panel. Custom
profiles can also be based on existing default profiles. Any sequence of projections that
is currently displayed in the List Panel can be saved as a new user-created profile,
making this aspect of the Well Planning Mode a potent time saving device.
ADD FIRST PROJECTION: When creating a profile from scratch, first click the “Clear”
button in the Well Planning panel. Then add a projection at the top of the curve by
selecting the type in the “Add Projection” drop-down menu. The special control panel
for any of the projections appear where they normally do, just inside the 3D window.
Edit the main parameters in this panel.

Then click the “Add” button. The projection as defined will appear in the List Panel
below as well as the 3D space above. All parameters can be further edited in the List
Panel by clicking on the projection row, or in the special control panel.
ADD ANOTHER PROJECTION: The next step in building a profile is to stack on a
second projection. A common and useful second projection for ample customization
room down the road is a Nudge projection since it acts as a flexible control point for any
template. Select “Nudge” from the “Add Projection” drop-down menu and click
“Add.” This will place a Nudge projection just after the first one.

ADD TARGETED PROJECTIONS: Add targeted projections in the same manner as
targetless, but keep in mind that a target will need to be set as First Target when adding
the former. Set a target as First Target by right-clicking on it in the 3D window and
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selecting “Set as the First Target.” When loading the profile for later projects, the
targeted sections of the profile will adjust to whichever current First Target is set.
MAKE FINAL CHANGES: Any tweaks to the projections can be made in the List Panel
before saving by clicking on the parameter in question.

Changes are reflected instantly in the 3D window above the List Panel.
SAVE AS NEW PROFILE: Once a list of projections has been compiled, they may all be
saved as a template for future use.

Name the new profile when prompted, and it will be
available in the “Profile Name” drop-down menu
along with all the default profiles.

APPLY TO PROPOSAL: Anything created and displayed in the Well Planning Mode
must be actively pushed over into the Work Space in order for it to become part of a
proposal curve. To do that, just click “Apply to Proposal.” Then click the “Work Space”
view button (hardhat) to return to the main HawkEyeTM screen.
CHANGING THE TEMPLATE: Anytime a template needs to be altered, first get back
to the Well Planning panel and load the profile. Then make the desired changes in the
List Panel and individual control panels for any of the curves. Finally save as new
profile again, naming it the same or something different.
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VIII.

Torque and Drag
The Torque and Drag Program
The Softdrill NL Torque and Drag module is a program offered with
an additional charge for those ordering the Field Version of
HawkEye™, or simply included in the Well Planning Version.

Performance Drilling Technology has enlisted Softdrill NL to embed its torque and drag
program within HawkEye™ as an optional component module. T&D is an important
component of many drilling operations and the ability to create useful T&D analysis
quickly and accurately is important.
To this end, HawkEye™ passes survey information to the torque and drag program
which provides the interface for setting up the calculation parameters for torque and
drag, and also provides the reports and graphs. The following pages explain how to
operate the Torque and Drag program.

1. Overview
Softdrill NL Torque & Drag can be used for a variety of engineering applications:
 Optimizing well path design and prediction of operational scenarios
 Drillstring design and prediction of expected tension and torque values

exerted on drillstring elements
 Analysis of normal forces (predicting casing wear)
 Analyzing drilling problems (string “hang up”)
 Prediction of hook loads while tripping in or out of the hole and early

detection of cuttings build up by comparing actual hook loads
(“diverge/converge” method).
Each of these applications of the software will be introduced and described in this
document.
NOTE: This manual has been written for the stand-alone version of Torque & Drag,
which allows multiple calculation models to be opened simultaneously (multiple
document interface). The Torque & Drag version embedded in Performance Drilling
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Technology’s HawkEye™ consists of a single document interface, but functionality of
the software is similar to the stand-alone version. Please refer to section “Hawkeye™
Embedded Version” later in this chapter for further details.

a. Units of measurement
Common to all Softdrill NL applications, the Torque & Drag program has full
flexibility with regards to the units of measurement used for input and output. All
numeric data is stored in a consistent set of units (imperial) when it is saved in a file or
stored in a database. This is schematically depicted in the figure below.

Conversion of units of measurement

The conversion mechanism is fully transparent to the user and allows the program(s) to
function fully independently of the selected units. The advantage of this is two-fold:
every user can work in his preferred units while working with the program and change
to the required units just prior to printing the report(s) to be presented.
To access of variety of functions related to the selected units of
measurements, click the “Conversions” button at the top of the
main screen. This opens the dialog window as displayed below
in the next figure:
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This dialog window presents the user with several options related to units of
measurement:
 The conversion families (or: groups of units) are sorted in the most logical

manner in the context of an engineering application. However, you may choose
to sort this list by Conversion Family by clicking on the column header
(continued clicking will toggle between ascending and descending sort order).
 For each conversion family, you may select your preferred unit from the drop-

down box in the Selected Unit column.
 The button [Set default file location] allows the user to define a folder

(directory) where all conversion files will be saved. Typically this is My
Documents\Softdrill NL data for the current user, but it may be changed to any
folder. This folder’s path is saved to the registry and becomes the default
location when storing your settings. (This can still be overridden because the
user is asked for a storage location prior to opening or saving a settings file).
Note that it is probably not a good idea to set a network location as the default.
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Specifically with a laptop computer, you may not be connected to the network
and problems will occur when attempting to retrieve you default settings.
 If you check the checkbox labeled ‘Make current settings my default settings’,

the currently selected settings will become the default (on startup) of all
Softdrill NL applications installed on your computer.
 Click “OK” to keep your selected settings or “Cancel” to undo all changes and

keep things as they were.

b. The Torque & Drag Toolbar

The following shortcut buttons are available on the top toolbar in the main window:

Open
Open existing (saved) calculation model. Alternatively you can use this to open an
existing model, input the required changes and save it under a new name using [File] –
[Save As…] from the main menu. This is particularly useful in situations where several
cases for similar situations must be calculated (e.g. only minor changes to BHA, various
bit depths, different mud weights, etc.). Please note that specifically for this purpose
the Case No. and Description input fields were added to allow easy distinction between
several different cases.

Save
Save changes to currently opened calculation model.

Save as template…
Saves the current configuration of entered parameters as a special .tdt file that can be
later loaded from the “Open” option.

Calculate
Calculate currently opened calculation model. This takes you to the resulting graph
screen on completion of the calculation. The same function is executed when the [F9]
key is pressed.
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Print
Print Torque & Drag report complete with selected graphs. This function prints to a
preview window first, allowing the user to review the report prior to printing the actual
hardcopy.
When you print the report from the preview window (click on printer icon), the print
dialog opens where you can select and adjust the printer you want to use to print the
report. Optionally you can print to a PDF file directly by checking the ‘Print to file’
checkbox and selecting ‘PDF’ from the combo-box.

Conversions
Edit conversion settings (units of measurement) as described above.

2. Input screens
a.
General data
The main screen of the currently selected model window gives you access to the
following general input data:

Most data input in this section is self-explanatory but the following may require some
additional explanation:
 Case no.- Allows distinction between models for the same BHA on the same

well (use in conjunction with ‘Description’ field).
 Step length- The torque and drag is calculated cumulatively for various depths

along the drillstring (from the bit upwards). These depths are calculated using
the specified step length. Typically this value is set to 100 feet (or 30 meters).
Different step lengths will yield different results but will also impact calculation
time.
 Safety factor- This factor is used to adjust the tension and torsional yield curves

for the operational scenario graph. The absolute yield values are divided by the
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safety factor to calculate the yield curve values on the graph. For example, a
safety factor of 1.25 results in a graph value being plotted at 1 / 1.25 = 0.80 = 80%
of the absolute value
 M.O.P.- The margin of overpull applied in the calculation of the model.
 Stiff string- By default the model is calculated as ‘Soft string’ whereby

additional forces, resulting from bending the drillstring elements, are not taken
into account. Selecting this option will alter the calculation model where these
additional forces will be taken into account. See the ‘Calculation theory’ section
further in this document for further explanation.
 Helical buckling- Allows the user to select the applied method for calculation

of the helical buckling force. The available options are ‘Chen & Cheatham’ and
‘Wu & Juvkam-Wold’, where ‘Chen & Cheatham’ is considered the most
reliable and the default value.
 Calculation mode- Available options are: Scenario (also known as ‘single depth

analysis’), Trip Log (surface hook load vs. bit depth) and Friction Factor (backcalculates friction factor from known surface loads; used for post run analysis
and in-field optimization of models).
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b.

Drilling parameters

This grid allows input of various (drilling) parameters for each operational mode. The
operational modes are defined as shown in the left-most column. Cells for nonapplicable values are grayed out and disabled.
Bit torque and BHA torque define the starting values for calculating torque values along
the drillstring. These values are increased as a result of an increasing weight (and
bending force in the case of stiff string models) along the drillstring. BHA Drag serves
as a start value for calculation of tension along the drillstring.
Other data is considered to be self-explanatory.

c.

Hole sections

When selected, the hole size column will display an ellipsis button ( ). If the Section
Type column is defined as Casing or Liner, the clicking the button displays a casing
catalog from which the user can choose the applicable specifications.
The friction factor is a crucial parameter in the torque & drag calculation that allows
modeling of a variety of surface-to-surface interactions resulting in drag and torsional
friction. The actual value of the friction factor used in a particular situation is a
combination of several factors, including:
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 Material and condition of cased hole sections and formation type in open hole

sections
 Drilling fluid type and composition
 Tool joint material and condition
 Additional borehole tortuosity not correctly reflected by the survey data (i.e.

‘micro doglegs’).
At a specific point in time, the borehole tortuosity, drillstring composition, drillstring
characteristics and mud type will be constant, but several sections of cased and open
hole may exist. In most cases it will therefore be necessary to specify multiple friction
factors.
Add, Insert and Delete hole sections on this grid with the little buttons found at the
bottom of the window:

d.

Drillstring

Type. Specify element type. Currently three values are valid: Drill Collar, HWDP and
Drill Pipe.
Description. Self-explanatory, but selecting this column (As shown in figure 6 above)
will reveal a button that – when clicked - allows the user to select the element from a
catalog.
Actual weight is nominal pipe weight corrected for tool joints and used in actual
calculation.
Tension limit, torsion limit and make-up torque are used for calculating the various
yield curves in the result graphs (taking safety factor and margin of overpull into
consideration).
e.

Survey data
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Survey (or wellplan) data is pulled from the current curve in HawkEye or can be
imported from a text file (with the “Import surveys” button on the top right of the main
screen).
Surveys can also be manually input. For wellplans, only critical points (KOP, end of
build, start of drop, etc.) have to be entered since intermediate points will be
interpolated as required.
If the first section of a wellplan is vertical down to the kick off point (KOP), the
resultant torque and drag values will be zero due to the absence of any inclination
(theoretical absence of wall contact). To model a real-time situation it is recommended
to adjust the inclination in the KOP to 1.00° (for example). Optionally, intermediate
stations with low inclination and random direction can be entered to simulate borehole
tortuosity in this section.
Click the “Import surveys” button at the top right of the screen to open the dialogue:
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Click the “…” button to select a *.txt or *.csv (Excel comma separated) text file. The
‘Value separator’ radio buttons specify which token to use a field separator when
reading data.
Under ‘Import settings’ you can specify how many lines should be ignored before
reading data (skip comment lines), what measurement units were used for measured
depth values (feet or meters) and which columns contain measured depth, inclination
and direction data. Specific attention should be given to the definition of the units used
for the depth column to ensure correct conversion upon import of the data.
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3. How to Use this Torque and Drag module
Data required to calculate torque and drag:
A. Surveys
B. Drillpipe
C. heavyweight drillpipe
D. drill collars
E. Casing

Here’s how all that information is entered:
1. Select or design a well (drillstring) in the main HawkEye program. You’ll need
the surveys from this well.
2. Enter casing for the string in the main HawkEye program.
3. Open the Torque and Drag module. Enter the basic information at the top:

4. Click “Save” at the top and name this torque and drag profile in a folder you will
remember.
5. Click on “Hole Sections” to confirm the casing information that you entered:

6. Click on “Survey Data” to confirm the survey information that was pulled from
your current curve before launching the T&D module.
If it’s not the curve that you want, save your T&D profile, then close the module.
In HawkEye, right-click on the curve you want in the Data Tree and select “Set
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As Current Work/Proposal Curve.” Or switch Proposal/Work Mode with the
P/W button at the top left of the main screen.
7. In the T&D module, click “Drillstring.” Here you will add the drillpipe and drill
collars. Click on the Plus-Arrow button highlighted below to add items to the
table:

In this step, make sure to have drillpipe, HWDP and drill collars (DC) with
weight values included. These are essential to the calculations.
8. Go ahead and save again after putting in all that data. You can even “Save as
Template.”
9. Click “Calculate” at the top of the module. Your reports will be generated. To
tweak the results, visit the “Drilling Parameters” section:
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